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1 Introduction

Account Ability Tax Form Preparation Software prepares Information Returns (1098, 1099, 3921, 3922,
5498, W2G) and Annual Wage Reports (W2, W2C) electronically, on laser, inkjet and generic dot matrix
printers. The Client (Filer) Management Module maintains an unlimited number of clients¹ in distinct
annual databases that can be rolled forward from year-to-year without any loss of prior year integrity. This
module is complete with all of the tools required for adding, editing, deleting, importing and exporting client
information.

Recipient² information can be typed into windows that resemble actual tax forms or imported from Microsoft
Excel®, IRS Pub. 1220 compliant files, SSA EFW2 compliant files and delimited text files. The Import
Mapping Utility, which is included for free with Account Ability, facilitates the job of converting delimited text
files to a format compatible with current year schema. There is no limit to the number of recipients one can
enter into Account Ability.

In an effort to decrease backup withholding and penalty notices, Account Ability includes Bulk Taxpayer
Identification (TIN) Matching pursuant to IRS Pub. 2108a. TIN Matching is part of a suite of internet based
pre-filing e-services that allow authorized payers the opportunity to match 1099 payee information against IRS
records prior to filing information returns. An authorized payer is one who has filed information returns with
the IRS in at least one of the two past tax years. Bulk TIN Matching will allow up to 100,000 payee TIN/Name
combinations to be matched via a text file submission.

Account Ability's wealth of online help, frequently asked questions, tips, hints, and ease of use make for a
user-friendly environment. When all else fails, IDMS offers free unlimited technical support  to all licensed
users of Account Ability.

Its reasonable price, together with its powerful importing, exporting, and reporting capabilities, makes Account
Ability a complete, cost effective, end of year tax reporting tool that no tax professional should be without.

¹ A client (filer) can be a Payer (1099-MISC, 1099-DIV, 1099-INT, 1099-OID, 1099-PATR, 1099-B, 1099-G,
1099-Q, 1099-R, 1099-LTC, W2G), a Lender (1099-A, 1098, 1098-E), a Creditor (1099-C), a Donee (1098-C),
a Filer (1097-BTC, 1099-K, 1099-S, 1098-T), a Trustee (5498, 5498-SA, 5498-ESA, 1099-SA), a Corporation
(1099-CAP, 3922), a Transferor (3921), a Provider (1099-H), or, an Employer (W2, W2C). To avoid this
ambiguity, Account Ability regards all filers as clients and uses the terms client and filer synonymously.

² Account Ability regards those who receive the returns prepared by a filer as recipients (e.g. contractors,
debtors, employees, borrowers, students, winners, beneficiaries, participants, donors, shareholders, etc.).

Microsoft Excel® is a registered trademark of Microsoft Corporation
Account Ability® is a registered trademark of Integrated Data Management Systems, Inc. (IDMS)

2 Installation

Account Ability is a network ready application. That is, it is designed to run either single user or on a network
where its database can be shared among multiple users. Although there is no limit to the number of users who
can access Account Ability, the maximum number of users who can access Account Ability's database
simultaneously (concurrently) is limited by concurrent user licensing. By default, Account Ability is licensed for
one concurrent user. Additional concurrent user licenses can be purchased at any time.

 Notes

· Prior to installing Account Ability be sure to remove the PROOF OF LICENSE label from the licensing
envelope containing your CD. This is a peel and stick label designed to be affixed to the rear cover of the
jacket containing the software.

· The serial number printed on your PROOF OF LICENSE label will be required when starting Account Ability
for the first time, installing additional concurrent user licenses, or requesting technical support.

Which type of installation should you choose?

Single User Installation  - Choose a single user installation if only one user will have access to Account
Ability's database. In a single user installation Account Ability's server license, AA2012.exe, is generally
installed on the user's computer. Installation to a network drive is also acceptable.

95
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Network Installation  - Choose a network installation if more than one user will have access to Account
Ability's database. In a network installation Account Ability's server license, AA2012.exe, is generally installed
on a network server and a concurrent user license is installed on each user's computer. You can also choose to
install Account Ability locally (stand-alone on each user's computer) as long as each user has permission to
access Account Ability's shared database.

 Related Topics

· Concurrent User License

2.1 Single User

Insert the Account Ability CD into the system's CD ROM or DVD drive. If the installation program fails to start
after a few moments, run the setup.exe program located in the root directory of the CD.

Once the InstallShield Wizard begins,

· Click Next to display, and accept, the License Agreement.
· Click Next to display, and complete, the Customer Information window.
· Click Next to select a Destination Folder (e.g. C:\Account Ability). Although the destination folder can

reside either on the user's computer or a network server, the installation program automatically installs a
server license, AA2012.exe, to a 2012 sub-folder within the destination folder! So, do not specify a
reporting year.

After a successful installation Account Ability is ready for use.

 Notes

· Installation should be performed by a system administrator or someone with administrative rights.
· You can launch Account Ability by clicking the shortcut (American flag) on the desktop.
· You can also launch Account Ability from the Window's Start button by selecting 2012 Tax Form

Preparation from the Account Ability program's group.

After launching Account Ability a server license icon  should be displayed in the Licensing Panel of The
Status Bar .

2.2 Network

A file server, or server, is a computer that provides workstations on a network with controlled access to shared
resources (e.g. printers, communications, databases, etc.). Servers that are used simultaneously as a
workstation are termed non-dedicated; those which are not are termed dedicated.

In a network installation Account Ability's server license, AA2012.exe, is installed on either a dedicated or
non-dedicated server and a concurrent user license is installed on each user's computer. One can also choose
to install Account Ability locally (stand-alone on each user's computer) as long as each user has privileged
access to Account Ability's shared database.

 Notes

· Installation should be performed by a system administrator or someone with administrative rights.
· It is up to your network administrator to plan the installation and create group privileges.
· All users of Account Ability must have administrative privileges to the installation folder.

Dedicated Server Installation
Installation to a dedicated server can be done either from the server or from a workstation.

Insert the Account Ability CD into your system's CD ROM or DVD drive. If the installation program fails to start
after a few moments, run the setup.exe program located in the root directory of the CD.

Once the InstallShield Wizard begins,

2
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· Click Next to display, and accept, the License Agreement.
· Click Next to display, and complete, the Customer Information window.
· Click Next to select a Destination Folder. The installation program automatically installs a server license,

AA2012.exe, to a 2012 sub-folder within the destination folder! So, do not specify a reporting year.
· Create the 2012 Database - Launch Account Ability either by clicking the shortcut (American flag) on the

desktop or by selecting 2012 Tax Form Preparation from the Account Ability program's group. This will
create the database, AA2012.abs, provided it doesn't already exist, in the folder <Destination Folder>
\2012\2012DATA\.

· Install a Concurrent User License  on each user's computer (see the next section ).

Non-Dedicated Server Installation
Installation to a non-dedicated server should be done from the server.

Insert the Account Ability CD into the server's CD ROM or DVD drive. If the installation program fails to start
after a few moments, run the setup.exe program located in the root directory of the CD.

Once the InstallShield Wizard begins,

· Click Next to display, and accept, the License Agreement.
· Click Next to display, and complete, the Customer Information window.
· Click Next to select a Destination Folder. The installation program automatically installs a server license,

AA2012.exe, to a 2012 sub-folder within the destination folder! So, do not specify a reporting year.
· Create the 2012 Database - Launch Account Ability either by clicking the shortcut (American flag) on the

desktop or by selecting 2012 Tax Form Preparation from the Account Ability program's group. This will
create the database, AA2012.abs, provided it doesn't already exist, in the folder <Destination Folder>
\2012\2012DATA\.

· Install a Concurrent User License  on each user's computer (see the next section ). It is not necessary
to install a concurrent user license on the server since a server license already includes one.

Stand-Alone Installation
A stand-alone network installation is identical to that of a single user installation with one exception — Account
Ability's database must be created, moved to a shared location and finally reallocated on each user's
workstation.

Insert the Account Ability CD into the user's CD ROM or DVD drive. If the installation program fails to start
after a few moments, run the setup.exe program located in the root directory of the CD.

Once the InstallShield Wizard begins,

· Click Next to display, and accept, the License Agreement.
· Click Next to display, and complete, the Customer Information window.
· Click Next to select a Destination Folder. The installation program automatically installs a server license,

AA2012.exe, to a 2012 sub-folder within the destination folder! So, do not specify a reporting year.
· Create a Local 2012 Database - Launch Account Ability either by clicking the shortcut (American flag) on

the desktop or by selecting 2012 Tax Form Preparation from the Account Ability program's group. This
will create the database, AA2012.abs, provided it doesn't already exist, in the folder <Destination
Folder>\2012\2012DATA\.

· Exit Account Ability.
· If you haven't already done so, copy and paste the database from <Destination Folder>\2012

\2012DATA\ to a shared server location.
· Reallocate the database - Refer to the section Database Reallocation .

2.3 Concurrent User License

Account Ability is a network ready application. That is, it is designed to run either single user or on a network
where its database can be shared among multiple users. Although there is no limit to the number of users who
can access Account Ability, the maximum number of users who can access Account Ability's database
simultaneously (concurrently) is limited by concurrent user licensing. By default, Account Ability is licensed for
one concurrent user. Additional concurrent user licenses can be purchased at any time at www.idmsinc.com/
Order.php

 Notes

3 3

3 3
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· If Account Ability's server license, AA2012.exe, is installed on either a dedicated or non-dedicated server
then a concurrent user license must be installed on each user's computer.

· If Account Ability's server license was installed from a user's computer then a concurrent user license was
automatically installed on the user's computer.

· Installation should be performed by someone with administrative rights to the user's computer.

Installation Instructions

· From the user's computer, browse to Account Ability's installation folder on the server.
· Open the Client folder located within the 2012 folder (e.g. ...\2012\Client).
· Run the setup.exe program to launch the Account Ability 2012 Concurrent User Setup.
· Click Next.
· Click Install.
· Launch the application upon completion. You can also launch the application from the Window's Start button

by selecting 2012 Concurrent User Setup from the Account Ability program's group.
· Enter your 2012 serial number.
· Click the Explore button ( ) and browse to Account Ability's installation folder on your server.
· Double-click the server license, AA2012.exe
· A shortcut (American flag) to Account Ability will be created on the user's desktop.

Double-click the shortcut to launch Account Ability. A concurrent user license icon  should be displayed in
the Licensing Panel of The Status Bar .

3 The User Interface

An application's user interface is the means by which users interact with the application. Generally, it is
comprised of menus, icons, tool tips, keyboard shortcuts, tool bars and online help.

Account Ability's user interface consists of the following components:

· The Desktop  - The Desktop is easily recognized by its patriotic background. Recipient information is
displayed on the Desktop in windows that resemble actual tax forms. These user friendly windows are the
constituents of Account Ability's recipient interface and provide all of the functionality required for
maintaining each filer's database of information returns and annual wage reports.

· The Main Menu  - The Main menu consists of two ancillary menus - The Generic menu and the Recipient
menu. Although the Generic menu is always visible, the Recipient menu, which merges with the Generic
menu, is only visible while working on recipient returns.

· The Status Bar  - A status bar is generally used to report information about the current state of an
application. For example, the status bar in an Explorer window shows how many files a folder contains and
how much disk space they take up. In addition to showing the state of the application the Account Ability
status bar shows the state of the active client.

· The Recipient Toolbar  - The panel of buttons bordering the right-hand side of the desktop comprise the
recipient toolbar. The recipient toolbar contains shortcuts to many of the selections appearing on the
recipient menu as well as procedures for navigating among recipient returns.

· Contextual Help  - Contextual Help provides you with immediate assistance without having to leave the
context in which you are working. It provides information about a particular object and its context. It
answers questions such as "What is this?", "Why would I use it?" and "How do I use it?"

These components have been designed to provide a user-friendly experience, allowing the user to interact with
the software in a natural and intuitive way.

3.1 The Desktop

The Account Ability Desktop is easily recognized by its patriotic background. Recipient information is displayed
on the Desktop in windows that resemble actual tax forms. These user friendly windows are the constituents
of Account Ability's recipient interface and provide all of the functionality required for maintaining each filer's
database of Information Returns and Annual Wage Reports.

The Desktop contains three essential components,

· The Main Menu

12
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· The Status Bar
· The Recipient Toolbar

 Note

· The Desktop  selection on the Preferences  menu includes the option to replace the patriotic
background with a standard gradient background.

3.2 The Main Menu

Account Ability's Main menu, shown below,

consists of two ancillary menus:

The Recipient menu,

and,

The Generic menu. 

Although the Generic menu is always visible, the Recipient menu is only visible when working on Information
Returns or Annual Wage Reports. Generic menu items are discussed below. Recipient menu items are
discussed in the topic Working with Tax Forms.

Generic Menu Items

 Module Menu

 Transmitter/Submitter Information
Electronic filers of Information Returns and Annual Wage Reports must complete the Transmitter and
Submitter pages of the Transmitter/Submitter Information dialog, respectively. Transmitters requiring a
Transmitter Control Code and Submitters requiring a User Id can apply directly from this dialog.

 Client (Filer) Management
The Client (Filer) Management module manages all of your clients in distinct annual databases that can be
rolled forward from year-to-year without any loss of prior year integrity. This module contains all of the tools
necessary for adding, editing, deleting, importing, and copying client information.

 Import Mapping Utility (F2)
Opens The Import Mapping Utility (IMU) for 2012. IMU can map any delimited text file or Excel® spreadsheet
to a text file that Account Ability can import. The F2 key on your keyboard is a shortcut to this selection.

 FileCabinet™ Control Panel
Opens The Account Ability FileCabinet™ Control Panel. Account Ability's FileCabinet™ System creates
eStatement PDFs, posts them to a secure website, notifies the recipient via email and manages electronic
consent pursuant to IRS regulations. For more information on the Account Ability FileCabinet™ System visit
our website, www.idmsinc.com, or see the section on The FileCabinet System .

 Notes
Opens the Global Notes Dialog. Global notes are not specific to any one client and can be shared among users
in a network environment. The Global note record can be a rather useful tool for keeping track of specific tasks
to be done either by you or others on your network.

 Copy a Transmittal's Path u
Account Ability's electronic reporting interface prepares information returns, annual wage reports, and TIN
matching requests in specially formatted transmittal files. In particular, IRSTAX transmittals contain
information returns formatted pursuant to IRS Publication 1220, W2REPORT transmittals contain annual wage

12
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reports formatted pursuant to SSA EFW2 or SSA EFW2C specifications, and BULKTIN.TXT transmittals
contain TIN matching requests formatted pursuant to IRS Publication 2108A.

Unless otherwise specified, transmittals IRSTAX, W2REPORT (W-2), W2REPORT (W-2c), and BULKTIN.TXT are
written to predefined folders IRS, SSA_W2, SSA_W2C, and BULK_TIN, respectively, within Account Ability's
installation folder. To facilitate locating a transmittal for uploading, this selection allows you to copy the path of
the desired transmittal to the Windows Clipboard.

Path to Transmittal Files

When prompted by IRS or SSA for the file to upload, click the Browse button and paste the desired path into
the File name field of the "Choose File to Upload" dialog. Click Open to display and select the transmittal to
be uploaded.

 Notes

· If a selection appears disabled, a transmittal file does not exist.
· Account Ability automatically copies a transmittal's path to the Windows Clipboard at the start of each

electronic reporting session.
· Although Account Ability automatically copies a transmittal's path to the Windows Clipboard at the start of

each electronic reporting session, one can inadvertently overwrite this path by copying and pasting other
information during the reporting session. If this should happen, select the path again without closing the
reporting session.

 View/Print a Transmittal's Filers u
If an IRSTAX or W2REPORT transmittal file already exists, you can use this selection to view, or print, the filers
recorded in the transmittal.

 Notes

· Does not apply to BULKTIN.TXT transmittals.
· If a selection appears disabled, a transmittal file does not exist.

 Tip

· This selection only works with transmittal files named IRSTAX or W2REPORT. In order to view, or print, filers
in a transmittal that was previously submitted and renamed, copy it to a temporary folder and rename it to
its original name (IRSTAX or W2REPORT) prior to opening it with this selection.

 IRS FIRE System
Connects to the IRS FIRE System for filing Original, Correction and Replacement files. Electronic filers of
Information Returns use The IRS FIRE System to upload and monitor the status of their electronic
transmissions.

 IRS FIRE - TEST File Processing
Connects to the IRS FIRE System for TEST file processing. This system is designed to support electronic filing
tests for Information Returns only. The tax year 2012 time frame for testing electronically filed Information
Returns is November 1, 2012 through February 15, 2013.

 Rename an IRSTAX File
The electronic filing option automatically appends each file of Information Returns you create to a file named
IRSTAX. By default, IRSTAX resides in the IRS folder located within your installation folder. A single IRSTAX
file can contain any combination of Information Returns for any number of clients. It is this IRSTAX file that
ultimately gets transmitted to The IRS FIRE System. The IRS renames each file of Originals, Corrections, and
Replacements it receives to ORIG.TCCNO.xxxx, CORR.TCCNO.xxxx, and REPL.TCCNO.xxxx, respectively,
where xxxx is a numeric counter ranging between 0001 and 9999. In an effort to synchronize the files you
transmit with those received by IRS, always use this selection to rename your IRSTAX file to the name
supplied by The IRS FIRE System. Renaming each IRSTAX file you transmit also minimizes the likelihood of

http://fire.irs.gov/
http://fire.test.irs.gov/
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duplicate filings.

 Important

· If you use Account Ability's EFILE Service, you will receive an email confirmation from IDMS. This email will
contain the name assigned by IRS. Upon receipt of this confirmation, use this selection to immediately
rename your IRSTAX file.

 Prepare IRS Transmittal 4804
Although transmittal 4804 is no longer required of electronic filers, this selection can be used to view your
IRSTAX file, if necessary. The option to print deprecated transmittal 4804 is also included for those who desire
to use it for their own internal records.

 SSA AccuWage 2012 Utility (F3)
Opens or installs the AccuWage Utility for 2012. This software is provided for free by the Social Security
Administration (SSA) for the sole purpose of checking W2 (Wage and Tax Statement) reports for correctness
before sending them to SSA BSO. The F3 key on your keyboard is a shortcut to this selection.

 Note

· Account Ability copies the path to your W2REPORT file to the Windows Clipboard prior to loading the
AccuWage utility. When prompted for the File Name to be tested, you can paste (Shift Insert or Ctrl+V)
the path to your W2REPORT file and click the Open button to easily locate your transmittal file.

 SSA AccuW2C 2012 Utility (F4)
Opens or installs the AccuW2C Utility for 2012. This software is provided for free by the Social Security
Administration (SSA) for the sole purpose of checking W2C (W2 Corrections) reports for correctness before
sending them to SSA BSO. The F4 key on your keyboard is a shortcut to this selection.

 Note

· Account Ability copies the path to your W2REPORT file to the Windows Clipboard prior to loading the
AccuW2C utility. When prompted for the File Name to be tested, you can paste (Shift Insert or Ctrl+V)
the path to your W2REPORT file and click the Open button to easily locate your transmittal file.

 SSA Business Services Online
Connects to the Social Security Administration (SSA) Business Services Online (BSO) website. Electronic filers
of Annual Wage Reports use the SSA BSO website to upload and monitor the status of their electronic
transmissions.

 Rename a W2REPORT (W2) File
The electronic filing option automatically appends each file of W2s you create to a file named W2REPORT. By
default, W2REPORT resides in the SSA_W2 folder located within your installation folder. A single W2REPORT
file can contain W2s for any number of clients. It is this W2REPORT file that ultimately gets transmitted to The
Social Security Administration's Business Services Online (BSO). SSA assigns a wage file identifier (WFID) to
each file it receives and renames the file accordingly. In an effort to synchronize the files you transmit with
those received by SSA, always use this selection to rename your W2REPORT file to the name supplied by SSA
BSO. Renaming each W2REPORT file you transmit also minimizes the likelihood of duplicate filings.

 Important

· If you use Account Ability's EFILE Service, you will receive an email confirmation from IDMS. This email will
contain the name assigned by SSA. Upon receipt of this confirmation, use this selection to immediately
rename your W2REPORT file.

 Rename a W2REPORT (W2C) File
The electronic filing option automatically appends each file of W2Cs you create to a file named W2REPORT. By
default, W2REPORT resides in the SSA_W2C folder located within your installation folder. A single W2REPORT
file can contain W2Cs for any number of clients. It is this W2REPORT file that ultimately gets transmitted to
The Social Security Administration's Business Services Online (BSO). SSA assigns a wage file identifier (WFID)
to each file it receives and renames the file accordingly. In an effort to synchronize the files you transmit with
those received by SSA, always use this selection to rename your W2REPORT file to the name supplied by SSA
BSO. Renaming each W2REPORT file you transmit also minimizes the likelihood of duplicate filings.

 Important

http://www.socialsecurity.gov/bso/bsowelcome.htm
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· If you use Account Ability's EFILE Service, you will receive an email confirmation from IDMS. This email will
contain the name assigned by SSA. Upon receipt of this confirmation, use this selection to immediately
rename your W2REPORT file.

 TIN Matching u
The Internal Revenue Service’s Taxpayer Identification Number (TIN) Matching Program was established for
payers of Form 1099 income subject to the backup withholding provisions of section 3406(a)(1)(A) and (B) of
the Internal Revenue Code. Prior to filing an information return, a Program participant may check the TIN
furnished by the payee against the name/TIN combination contained in the Internal Revenue Service database
maintained for the Program.

The IRS Office of Electronic Tax Administration offers two TIN Matching options:

Interactive TIN Matching - This process accepts up to 25 input name/TIN combination requests online.
Results are returned to the user in real time.

Bulk TIN Matching - This process accepts electronic transmittal files containing up to 100,000 name/TIN
combinations for matching. Results are generally returned to you within 48 hours in a BULKTIN Response File.

In order to use a TIN Matching option, one must first register with IRS e-Services. Once registered, you will be
able to create and submit transmittal files, as well as process BULKTIN Response Files, using Account Ability's
TIN Matching Menu,

TIN Matching Menu

· IRS e-Services Login/Registration connects you to IRS e-Services website.
· Create a BULKTIN Transmittal scans Account Ability's entire database for recipients to be tested and

writes the results to a BULKTIN transmittal file formatted pursuant to IRS Pub. 2108A. This transmittal file is
then uploaded to IRS e-Services for processing or submitted to IDMS (see Outsourcing Services below).

· Rename a BULKTIN Transmittal. IRS assigns a unique transaction number to each BULKTIN transmittal
file submitted for processing. Use this selection to rename your transmittal to this transaction number.

· Open an IRS BULKTIN Response File. Response files are either downloaded from IRS e-Services or
emailed to you from IDMS (see Outsourcing Services below). Once you have received your response file,
use this selection to launch the BULKTIN Response Processing  module.

 Outsourcing Services u
IDMS offers a suite of optional outsourcing services for users of Account Ability. Outsourcing services include
electronic filing (IRS and SSA), TIN Matching, and Print and Mail. With each of these services, transmittal files
created by Account Ability are transmitted directly to IDMS for processing from the Outsourcing Services
Menu,

Outsourcing Services Menu

 Notes

· To order IDMS's Print and Mail Service, see the Print and Mail link at www.idmsinc.com.
· To order IDMS's EFILE or TIN Matching Service, see the Order link at www.idmsinc.com.
· Users of Account Ability are not required to purchase an outsourcing service in order to use that feature. In
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http://www.irs.gov/taxpros/article/0,,id=109646,00.html
http://www.irs.gov/taxpros/article/0,,id=109646,00.html
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http://www.idmsinc.com/PrintMail.php
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other words, Account Ability includes electronic filing, TIN Matching, and plain paper filing at no extra
charge.

 Re-allocate u
Use this selection to specify a new location for AccuWage, AccuW2C, The Import Mapping Utility, or Account
Ability's 2012 database. 

 Instructions for moving the 2012 database can be found online on our Tips Knowledge Base. Once the
database has been moved, use this selection to inform Account Ability of the new location.

 Prepare Laser
Queues the IDMS Laser Fonts for downloading. These fonts are required when drawing Information Returns
and Annual Wage Reports on blank paper using the PCL printer configuration. This menu item is disabled for
GDI and Dot Matrix configurations. For more information, see Automatic download of IDMS laser fonts on
Printer Preferences . 

 Explore
Launches Windows Explorer.

 Logged Users
Displays all users currently working in Account Ability. Also provides the ability to verify each user's session.

 Backup/Restore
Opens the Account Ability Backup and Restore Utility. This selection is disabled if there are any tax forms
open on your workstation.

 Preferences Menu

 Desktop
Displays the Desktop  page of the Preferences menu. Desktop preferences enable you to configure user
interaction with Account Ability as well as the appearance of hints.

 Focus Colors
Displays the Focus Colors  page of the Preferences menu. Focus colors can possibly assist those with
visual impairments to identify the control receiving keyboard input.

 Printers
Displays the Printers  page of the Preferences menu. Account Ability delivers print jobs to your system's
printer in the form of journal records. How these journal records are created depends upon the configuration
you specify.

 Laser, GDI Offsets
Displays the Laser, GDI Offsets  page of the Preferences menu. If you use preprinted forms with Account
Ability there is a chance you may experience printer alignment problems (e.g. Data prints too high, too low,
too far to the right, or, too far to the left). Alignment problems, when they exist, can be corrected by
specifying an offset to the row and/or column print positions.

 US Postal Services
Use the US Postal Services  dialog to configure Intelligent Mail® Barcode and First-Class Indicia
information.

 Check for Updates at Startup
Use this selection if you would like Account Ability to check for updates at program startup. If a service pack
exists, a message will be displayed instructing you on how to download and install the update.

 Create Shortcut
Use the Create Shortcut selection to easily create shortcuts to Account Ability on the Desktop, Start Menu,
Programs Menu, Common Start Menu, or Common Programs Menu.

 Delete Shortcut
Use the Delete Shortcut selection to easily delete shortcuts to Account Ability from the Desktop, Start Menu,
Programs Menu, Common Start Menu, or Common Programs Menu.

 Forms Menu
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The Forms menu contains a list of all supported tax forms for reporting year 2012. Until a client has been
selected for processing, this menu item appears disabled. Once enabled, however, you can open as many as
five tax forms simultaneously for the selected client.

 Window Menu

Open tax forms for the selected client are listed at the bottom of the Window menu item. When more than
one tax form is open, use the Cascade and Stack selections to rearrange the forms.

 Help Menu

 Help Topics
Opens this help document.

 User Manuals & IRS Instructions
Here you will find user manuals for The Import Mapping Utility, Tax Form Preparation Software, IRS
General Instructions and The IRS FIRE System. All manuals are in portable document format (PDF), so,
you will need to have the Adobe Acrobat Reader installed on your PC.

 E-Mail Technical Support
This is the best way to email support issues to Account Ability's technical support department since your
Account Ability serial (license) number is automatically embedded within the subject of the email. Technical
support is free and unlimited to all licensed users of Account Ability.

 Frequently Asked Questions
Searches Account Ability's FAQ knowledge base for the keyword(s) you specify.

 Help Desk Support
With this level of support a technician connects directly to your PC via a 128-bit secured internet connection
that you initiate. The connection requires a system generated session ID and Password that you provide to the
technician. Once connected, the technician will work with you interactively in order to solve the problem at
hand. At the end of the session, the secured connection is destroyed and cannot be reinstated without a new
session ID and Password.

 Account Ability Forms Division
Connects to the Account Ability Forms Division. IDMS carries a complete line of continuous, laser, and pressure
seal tax forms and companion envelopes. The Order Forms panel located on the status bar performs the
same function.

 Account Ability Home Page
Connects to our home page (www.idmsinc.com).

 OEM Printer & Copier Supplies
Connects to the Account Ability OEM Printer & Copier Supplies web page. IDMS carries a complete line of
original equipment manufacturer (OEM) printer and copier supplies.

 IRS FIRE System
Opens a brief overview of The IRS FIRE System. 

 SSA Business Services Online
Opens a brief overview of The Social Security Administration's Business Services Online (BSO).

 Print Form 4419 - Application for TCC
Opens the Transmitter Information dialog for the printing of Form 4419, Application for Filing Information
Returns Electronically. File Form 4419 to request authorization to file Information Returns electronically. If
your application is approved, a five character alpha-numeric Transmitter Control Code will be assigned to your
organization.

 Print Form 8809 - Extension of Time to File Electronically
Opens a PDF document that you can complete and print as needed.

 Print Form W-7 - Application for IRS Individual Taxpayer Identification (ITIN)
Opens a PDF document that you can complete and print as needed.

 Print Form W-9 - Request for Taxpayer Identification

http://www.adobe.com/products/acrobat/readstep2.html
http://www.idmsinc.com/ListFaqs.php
http://www.accountabilitytaxforms.com
http://www.idmsinc.com
http://www.idmsinc.com/ListItems.php
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Opens a PDF document that you can complete and print as needed.

 Print Form W-9S - Request for Student's Taxpayer Identification
Opens a PDF document that you can complete and print as needed.

 Print Form W-7 - Application for IRS Individual Taxpayer Identification (ITIN)
Opens a PDF document that you can complete and print as needed.

 Print Form SS-4 - Application for Employer Identification
Opens a PDF document that you can complete and print as needed.

 United States Postal Service
Connects to the United States Postal Service (USPS) website for the sole purpose of looking up USPS ZIP+4
and Delivery Points. Once an address has been submitted, the properly coded ZIP+4 address is displayed.
Clicking on the Mailing Industry Information link displays additional information, including the Delivery Point.
Account Ability automatically barcodes properly coded ZIP+4+Delivery Point addresses when printing on
Pressure Seal Forms. 

 CFSP/FIPS Codes
Displays a list of states and their respective Combined Federal/State Filing Program (CFSP) and Federal
Information Processing Standards (FIPS) codes. IRS established the Combined Federal/State Filing Program to
simplify Information Returns filing for the taxpayer. IRS/IRB will forward this information to participating
states free of charge for approved filers. Separate reporting to those states is not necessary. The following
information returns may be filed under this program: 1099-DIV, 1099-G, 1099-INT, 1099-K, 1099-MISC,
1099-OID, 1099-PATR, 1099-R, 5498.

 Note

· For detailed information on the Combined Federal/State Filing program, refer to IRS Publication 1220 or
contact IRS/IRB customer service at 1-866-455-7438, Monday through Friday, 8:30AM to 4:30PM EST.

 Country Codes
Displays a list of currently recorded country codes. 

 Sample ASCII Import Files
Displays a list of sample text files that Account Ability can import. These files are included as a reference for
those users interested in building an interface between Account Ability and their host application.

 Tip of the Day
Opens the Tip of the Day dialog. By default, the Tip of the Day dialog is automatically displayed each time
you start Account Ability, unless otherwise specified.

 Upgrade Licensing
If you upgrade your licensing, use this selection to enter your new serial (license) number.

 About Account Ability (Check for Updates)
Displays Account Ability's version, serial number, and licensing information. Click the Check for updates link
to see if a service pack is available. If so, you will be prompted to download it,

Click Yes to display the Download Service Pack dialog,
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Service Packs are automatically downloaded to the server. If the computer doing the download is the server,
an installation shortcut is created on the desktop. Otherwise, installation instructions will be displayed.

 Notes

· The Check for updates link is not displayed on demonstration systems.
· Account Ability automatically checks for updates at startup unless otherwise specified from the Preferences

 menu.
· Service Packs are also posted to the Download page of Account Ability's website.

 About Account Ability's Database (2012)
Displays information about the currently installed database. 

 Locate Prior Year Data (2011)
If you used Account Ability last year, the 2011 database should be detected automatically. If not, you can
always use this selection to specify the location to be used.

3.3 The Status Bar

The status bar, shown below, is displayed at the bottom of the Desktop

The status bar consist of 10 panels,

 System Date Panel
Displays the system date in the format MM/DD/YYYY. 

 Active Client Panel
Until a client has been selected for processing, this panel displays a NO CLIENT message. Otherwise, the
selected Client ID is displayed. In the illustration above, client IDMS has been selected for processing.

 CAPS Lock Status Panel
Displays the status of your keyboard's Caps Lock key.

 NUM Lock Status Panel
Displays the status of your keyboard's Num Lock key.

 TIN Status Panel
Displays the status of the selected recipient's taxpayer identification number (TIN). 

 - TIN is ready to be tested against IRS records.

 - TIN matches IRS records.

 - TIN does not match IRS records.

 - TIN Matching is not available for the specified form.

 Notes

· If a TIN is in the ready to be tested state it is automatically added to the next BULKTIN transmittal file you
create. See the topic on Bulk TIN Response Processing.
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· Updating a recipient's TIN or name automatically changes the state to ready to be tested.
· If a TIN does not match IRS records, a W-9 should be issued to the recipient. The Bulk TIN Response

Processing  module includes the option to print W-9s.

 Licensing Panel
Displays the type of licensing installed on this computer. 

 - indicates that a server license is installed.

 - indicates that a concurrent user license is installed.

Account Ability uses this information when downloading service packs.

 Note

· See About Account Ability in the Help Menu section of the Main Menu  topic.

 IRS Instructions Panel
Account Ability includes official IRS instructions for supported Information Returns and Annual Wage Reports.
To display instructions for the tax form on which you are working, click the instructions icon, , or depress Alt
+ F1 on your keyboard.

 Note

· The instructions icon is visible if, and only if, a tax form is open on the Desktop.

 Order Forms
Click this panel for assistance locating tax forms and envelopes online.

 Total Returns Panel
This panel displays the total number of returns recorded for the form on which you are currently working. In
the illustration above, there are 7426 returns recorded.

 Note

· The total returns panel is visible if, and only if, a tax form is open on the Desktop.

 Logged User Panel
In the illustration above, RON is logged on. Click this panel to display all users currently working in Account
Ability.

3.4 The Recipient Toolbar

The panel of buttons bordering the right-hand side of the desktop  comprise the recipient toolbar. The
recipient toolbar contains shortcuts to many of the selections appearing on the Recipient Menu  as well as
procedures for navigating among recipient returns.

Although most of the buttons appearing on the recipient toolbar are specific to recipient returns, there are
some that are not. In particular,

 Shortcut to Client (Filer) Management
This button is always available and is equivalent to the Client (Filer) Management selection on the Module
menu.

 Shortcut to the Forms menu 
This button, as well as the Forms menu, remains disabled until a client has been selected. Selecting a client

is discussed in the topic Working with Tax Forms.

 Closes the active form or exits Account Ability
If a tax form is open, this button can be used to close it. Otherwise, this button will exit the application.

 Opens the Windows Calculator
This button is always available and will launch the Windows calculator.
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The remaining buttons are specific to recipient returns. Consequently, they remain disabled until a tax form
has been opened.

 Add (Insert) a New Recipient

If Automatic Insert Mode is set,  appears instead of  (see Desktop Preferences ).

 Locate a Recipient
This button opens the Locate Dialog , which can be used to rapidly locate recipient records.

Delete a Recipient

If Confirm All Deletions is turned off,  appears as  (see Desktop Preferences ).

 Total all Returns
This will total all non-void returns and display the totals in each box of the active tax form.

    
Moves to the First, Previous, Next, and Last recipient, respectively. Navigation is based upon the selected
ordering (see Sorting Returns ).

 Control Report
Preview or print a control report.

 Print Returns
Opens the appropriate Print Options  dialog.

 Electronic Reporting (eFile)
Opens the Electronic Reporting Options  dialog.

 Save Changes
Saves new records or changes to existing records.

 Cancel Changes
Cancels new records or changes to existing records.

 Due Dates and Filer Instructions
This button displays instructions to the filer as well as filing due dates for the selected tax form.

3.5 Contextual Help

Contextual Help provides you with immediate assistance without having to leave the context in which you are
working. It provides information about a particular object and its context. It answers questions such as "What
is this?", "Why would I use it?" and "How do I use it?" 

Account Ability implements contextual help in a variety of ways,

· Context-sensitive Help 
· Hints
· Online Help
· Dialog Help

Context-sensitive Help
This method of contextual help provides information about particular objects. It provides answers to questions
such as "What is this?" and "Why would I use it?". To request context-sensitive help for a specific object,
depress the F1 key while focused on the object.

 Note

· Objects that are self-explanatory do not have context-sensitive help associated with them.

Hints
Hints are informative messages that are displayed after resting the mouse on an object for a few seconds.
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You can customize the appearance of hints using the Desktop  selection on the Preferences menu.

HTML Help 
The Help Topics selection on the Help menu includes an in depth interactive HTML user manual. HTML help is
also available in PDF (portable document format). See the User Manuals & IRS Instructions selection on
the Help menu.

Dialog Help
A dialog is a child window that must be closed before you can continue to operate a specific application. Most
dialogs created by Account Ability contain a help button, 

which, when clicked, displays a help topic specific to the dialog.

4 Setup

The first time you start Account Ability various local parameters are created. Local parameter values, which
are stored in the registry, are specific to each user.

Examples of local parameters include

· Should the Enter key act as the Tab key when terminating input?
· Which printers should be used by default?
· Should zeros be suppressed when printing?
· Should a backup reminder be displayed when exiting the program?
· Do you want to change the appearance of tool tips and hints?
· Should Account Ability check for updates automatically?

In addition to local parameters, Account Ability includes US Postal Service parameters. US Postal Service
parameters, which are stored in the database , control the printing of a First-Class mail indicia and/or
Intelligent Mail® Barcode on the address portion of pressure seal forms. The Preferences  menu contains
selections for changing the values of local and US Postal Service parameters.

EFILE
If you plan to electronically file ("EFILE") Information Returns and/or Annual Wage Reports you must complete
the Transmitter  and/or Submitter  pages of the Transmitter/Submitter Information dialog.
Electronic filers of Information Returns ("Transmitters") must have a valid Transmitter Control Code. Electronic
filers of Annual Wage Reports ("Submitters") must have a valid User Identification Number. For more
information see the section on EFILE Setup .

Database
Account Ability's database, AA2012.abs, is a robust, high-speed, embedded single-file database with SQL
support. The data access layer is compiled right into the server license (AA2012.exe), thus eliminating the
need for special configuration libraries or a database server.

Account Ability automatically creates a new database , AA2012.abs, in folder

<installation folder>\2012DATA

when the application is first launched. Although this folder will suffice for single user installations, network
installations may require moving AA2012.abs to a shared folder accessible by all users. The section on 
Database Setup  explains the procedure for moving and reallocating the database.
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4.1 Preferences

 Preferences Menu
 
Use the Preferences menu to configure user interaction with Account Ability. In addition to configuring
Account Ability's desktop and printers, there are selections for configuring US Postal Services as well as
creating and deleting shortcuts to Account Ability. 

 
Preferences Menu

· Use the Desktop  dialog to configure the Account Ability desktop. 
· Use the Focus Colors  dialog to configure the Background and Foreground colors of the control receiving

input.
· Use the Printers  dialog to configure the printers to be used with Account Ability.
· Use the Laser, GDI Offsets  dialog to correct alignment problems when printing on preprinted forms.
· Use the US Postal Services  dialog to configure Intelligent Mail® Barcode and First-Class Indicia

information.
· Use the Check for Updates at Startup selection if you would like Account Ability to automatically check for

updates at program startup (not available on demonstration systems).
· Use the Create Shortcut selection to easily create shortcuts to Account Ability
· Use the Delete Shortcut selection to easily delete shortcuts to Account Ability

4.1.1 Desktop

 Preferences Menu  Desktop

Desktop Preferences are divided into two groups, General and Hints. Hints are informative messages that
appear when you position the mouse over a specific object for a specified period of time (Show Time Delay). If
enabled, Account Ability displays the object's hint in either a rectangular or balloon shaped window for a
specified period of time (Hide Time Delay). The Hints group lets you customize the appearance of hints.
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Desktop Preferences

General Desktop Preferences

Enter Key = Tab Key (default)
Traditionally, the ENTER key was used to terminate input. Windows, as you are probably aware, uses the TAB
key. Select this preference to have the ENTER key terminate input as well.

Duplicate Taxpayer ID Alert
Account Ability allows you to enter multiple returns with the same taxpayer id (SSN, EIN). Select this
preference if you would like to be warned of a duplicate prior to posting. Warnings are not active when
importing, rolling forward prior year returns, or posting the CORRECTING transaction of a two transaction
correction of Information Returns.

Auto Select Text (default)
When Windows shifts focus to an input field, all of the existing text in the field is generally selected
(highlighted). Some users find this annoying since the first character typed usually erases the entire field. This
preference lets you decide if text should be automatically selected.

Confirm All Deletions (default)
Select this preference if you want Account Ability to confirm each deletion of Information Returns and Annual
Wage Reports.

Capitalize Words (default)
Select this preference to have Account Ability capitalize the first letter of each word when entering names,
addresses, cities, etc.

Repeat City, State, and ZIP Code
Select this preference to have Account Ability default to the last recipient's City, State, and ZIP code (Province,
postal code, country, for foreign addresses) when entering new recipients. In the case of 1098 cooperatives,
the last payer's complete street address will be repeated.

Suppress Zeros When Printing (default)
Account Ability prints all numeric fields, even zeros, when printing W2s, 1098s, 1099s, etc. Select this
preference if you prefer to leave such fields blank. Note that zeros always print on corrected returns.

Automatic Return
Account Ability can automatically exit certain fields when the number of characters entered reaches the
maximum the field can hold. For example, typing 11221 in a 5 character Zip Code field, etc. Select this
preference to activate this automatic return feature.

Implied Dollars and Cents
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Select this preference to have Account Ability automatically add a decimal to all currency fields. For example,
545 would convert to $5.45, 12300 would convert to $123.00. Currency fields containing a decimal point are
not affected.

Automatic Insert Mode (default)
If selected, Account Ability remains in insert mode when adding new returns. That is, after each new return is
recorded, the form will clear and you will be ready to enter the next return.

Background Image (default)
If selected, Account Ability displays a patriotic background. Otherwise, a standard gradient background is
displayed. This option requires at least 16-bit color.

Remind Me to Backup on Exit (default)
Select this preference if you would like to be reminded to backup your current year's database prior to exiting 
Account Ability.

 Note

· A backup reminder will not be displayed if other users are working in Account Ability.
· A backup reminder will not be displayed if a backup was successfully completed during the current session.

 Hints Group

Shape and Position
Hints appear in either a rectangular or balloon shaped window. Select a shape from the drop down Shape box.
Balloon shaped hints can be drawn in one of five positions: lower left balloon, lower right balloon, upper left
balloon, upper right balloon, round balloon. Select a position by clicking on the respective icon. Note that the
position does not apply to rectangular hint windows.

Time Delays
The Show Time Delay specifies the number of seconds Account Ability will wait before displaying a hint. The
Hide Time Delay specifies the number of seconds Account Ability will wait before hiding a hint, provided the
mouse has not moved. A Show Time Delay of 1 second and a Hide Time Delay of 30 seconds is
recommended during the learning phase.

Foreground Attributes
Use the Font button to configure the hint window's font and text color.

Background (BG) Color
Select the hint window's background color from a drop down list of system colors.

Testing Preferences
To test the preferences you have selected, position the mouse on the word TEST and wait for the number of
seconds indicated (Show Time Delay). If enabled, a hint reflecting your choice of shape, position, font, and
color will appear for the number of seconds specified in the Hide Time Delay.

Enable/Disable Hints
Once completely familiar with Account Ability, you'll probably consider disabling hints. It is suggested,
however, that you leave hints enabled and consider increasing the Show Time Delay instead.

4.1.2 Focus Colors

 Preferences Menu  Focus Colors
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Focus Color Preferences

 Note

· To select colors using your keyboard, tab to the Focus Color Grid using the Tab key. Once in the grid, use
the arrow keys to move to a desired color and depress either F (Foreground) or B (Background).

4.1.3 Printer Configurations

Simply put, applications always request service from the Graphical Device Interface (GDI), and possibly the
Device Independent Bitmap (DIB) Engine, of the Windows operating system in order to prepare a print job for
delivery to a Printer Driver ("driver"). Think of the GDI as a hard working individual an application employs to
talk to a printer. A Windows' application doesn't directly access a printer like DOS did. Instead, it uses the
Windows services. This allows for centralized scheduling and control of print jobs, a necessary requirement of
a multitasking environment. Think of the DIB engine as another individual whose job is to manipulate graphics.
The driver, which is generally supplied by the printer's manufacturer, works with the GDI and DIB engine to
produce printer-specific output in the form of journal records. Journal records are then forwarded to the Print
Processor, which prepares them for print spooling. Eventually, your completed print job is routed to the
desired printer.
 
A major advantage of the Windows GDI interface is that of device independence. This is why IDMS suggests
using it. Account Ability includes a database of carefully designed Enhanced Metafiles (EMF) that can be drawn
on any printer configured for the Windows GDI. The PCL and Dot Matrix interfaces do not use these
metafiles!

 Note

· Regardless of the printer configuration you choose, have your system administrator check your printer's
properties in order to ensure that (a) Print jobs are spooled so printing finishes faster, and (b) Printing
begins after the last page has been spooled. To access these properties, right-click your printer in the
Windows' Printers folder and select Properties from the context menu. Earlier versions of Windows (95,
98) display these properties by clicking the Spool Settings button on the Details page. Later versions of
Windows place this button on either the Configuration page or Advanced page.

PCL Configuration
PCL is short for Printer Control Language, an instruction set generally used by Hewlett Packard (HP) laser
printers. If you are using an HP laser printer or one which is truly PCL compatible, then you can, if desired, use
the PCL configuration. Your PCL printer must be capable of retaining soft fonts (fonts which get downloaded to
your printer).

When the PCL configuration is used, Account Ability does not rely upon the Windows GDI to create the journal
records mentioned above. Instead, Account Ability generates a set of PCL records and sends them directly to
the printer for processing. PCL records contain all of the instructions necessary for drawing and/or filling in tax
forms on your laser printer. Clearly, this is a device dependent configuration.
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Automatic Download of IDMS Laser Fonts
PCL printers, in general, do not come from the factory capable of drawing tax forms on blank paper. It is
therefore necessary to download a custom set of laser fonts designed specifically for this purpose (IDMS laser
fonts). IDMS laser fonts enable a special set of PCL instructions to be converted to a tax form by a true PCL
printer. Since these fonts remain resident in your printer's memory until power off, Account Ability downloads
these fonts only once per session (a session ends when you exit Account Ability).
 
Some printers will print a blank page with an arrowhead (è) appearing in the upper left hand corner every
time IDMS laser fonts are downloaded. If you are experiencing this problem and your printer is not turned off
between sessions, you may want to inform Account Ability not to download these fonts automatically. You will
then be prompted to confirm the download prior to the start of each job.

 Note

· If you need to download IDMS laser fonts more than once per session, see the Prepare Laser selection on
the Module menu. The Prepare Laser selection forces Account Ability to download IDMS laser fonts more
than once per session.

Why use the PCL configuration?
The PCL configuration provides extremely fast processing of print jobs since the entire graphical interface is
basically circumvented. Moreover, spooled output is much smaller with PCL than with the GDI since Account
Ability, not Windows, controls PCL journal records.
 

Dot Matrix Configuration
If you plan to use continuous forms on a generic dot matrix printer, you must select the Dot Matrix
configuration. When the Dot Matrix configuration is used, Account Ability does not rely upon the Windows GDI
to create the journal records mentioned in the overview above. Instead, Account Ability generates a set of text
records and sends them directly to the printer for processing. Text records contain all of the instructions
necessary for filling in preprinted tax forms on generic dot matrix printers configured for a Vertical Motion
Index (VMI) of 6 lines per inch, and a Horizontal Motion Index (HMI) of 10 characters per inch.
 

W2 Dot Matrix Preferences (1-Wide, 2-Wide)
Some states require both employer and employee state and local returns, resulting in a 6-part or 8-part form.
Even without carbon interleaves, many printers cannot penetrate that many parts. Wide carriage printers
generally use a 2-wide form to overcome this problem. The 2-wide form contains employer copies on one side
of the page and employee copies on the other. You must indicate whether a 1-wide or 2-wide form will be
used.
 

W2 Dot Matrix Preferences (Offset)
When printing 2-wide W2 forms, some dot matrix printers cannot tab past column 132 making it impossible to
accurately report Local information. If this happens, try to physically shift your forms to the left a few
columns. Then, indicate the number of columns (0-3) by which you have shifted your forms in the Offset field.
Each column will result in an additional character for the locality.

Windows GDI Configuration
Unless you are using a generic dot matrix printer, IDMS recommends using the Windows GDI configuration.
When the Windows GDI configuration is used, Account Ability relies upon the Windows GDI to create the
journal records mentioned in the overview above. If you plan to prepare SSA approved W2, W2C, W3, W3C
returns on blank paper then you must use a laser printer configured for the Windows GDI interface. The
Windows GDI configuration is also required for printing on pressure seal forms.
 

Adjust Output When Clipped
Printers generally print within a printer-dependent rectangle referred to as a clipping rectangle. If an
application attempts to print outside of a printer's clipping rectangle, output will get chopped off (or clipped).
Account Ability contains a rather sophisticated set of proprietary scaling algorithms designed to avoid clipping
when drawing tax forms on blank paper. When printing on preprinted forms, however, a printer's clipping
rectangle may not be large enough to encompass all of the preprinted boxes on the form, thus making clipping
unavoidable. This is common among inkjet printers. If you experience clipping, select this preference in order
to have Account Ability force all data within the clipping rectangle.

Vertical Registration
Registration refers to the relative print positions of images that are printed at different times. For example,
when you process preprinted forms, the registration is good if the text aligns correctly with the preprinted
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image. Text that extends beyond preprinted box edges and text that overlaps other preprinted text are
examples of poor registration.

If, when printing on preprinted forms, the text of the first form on a page prints fine but that of subsequent
forms on the same page prints higher, your printer may require an adjustment to its Vertical Registration. If
this is the case, use the Vertical Registration Control to increase the vertical registration (1-75) and try
printing again.

 Notes

· Registration will vary from printer to printer. So, if you change printers, always set the Vertical Registration
to zero to see if an adjustment is necessary.

· Vertical Registration is used only by the GDI Printer configuration.
· If the text of the first form on the page prints too high or too low, set the Vertical Registration to zero and

try adjusting the Laser, GDI Offsets instead.
 

Print A Clipping Rectangle Button
Prints a clipping rectangle (as defined above) for the printer you specify. This will give you a clear view of
where clipping will occur. Inkjet users are encouraged to print a clipping rectangle at least once.

4.1.4 Printers

 Preferences Menu  Printers

Account Ability delivers print jobs to your system's printer in the form of journal records. How these journal
records are created depends upon the configuration you specify in the Configure for group of the Printer
Preferences dialog. If you haven't already done so, click on the Configuration Help?  link for an overview
of these configurations prior to completing this dialog.

Printer Preferences

Configure for
Indicate the configuration to be used.

 Notes

· Pressure seal forms require the GDI configuration.
· Inkjet printers must use the GDI configuration.
· SSA approved Copy A W2 and W3 returns require the GDI configuration.
· Continuous forms require the Dot Matrix configuration and a generic dot matrix printer configured for a

Vertical Motion Index (VMI) of 6 lines/inch and a Horizontal Motion Index (HMI) of 10 characters/inch.
· Preprinted 4-UP W2 forms require the PCL configuration.

19
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W2 Dot Matrix
Account Ability supports both 1-Wide and 2-Wide continuous W2 forms. When printing 2-Wide W2 forms,
some dot matrix printers cannot tab past column 132, making it impossible to accurately report Local
information. If you experience this problem, try physically shifting your forms to the left a few columns. Next,
indicate the number of columns (0-3) by which you have shifted your forms in the Offset field. Each column
will result in an additional character for the locality.

Printers to be used
General reports (Client Master, Activity Report, Control Reports, Register Listings) print on the specified 
Reports printer. Information Returns and Annual Wage Reports print on the specified Forms printer.

Adjust output when clipped
Every printer has a well defined region within which printing can occur. This region, also referred to as a 
clipping rectangle, varies from printer to printer. Attempts to print outside of a printer's clipping rectangle
generally results in a loss of printed output (this is known as clipping). When printing on preprinted forms,
there is a good possibility that clipping will occur, especially on inkjet printers. If you select this preference, 
Account Ability forces all printed output into the clipping rectangle. If a clipping adjustment is necessary, a clip
adjustment message will be displayed in red on the status bar.

 Note

· Use the Print a Clipping Rectangle button if you want to see your printer's clipping rectangle.

Vertical Registration
Registration refers to the relative print positions of images that are printed at different times. For example,
when you process preprinted forms, the registration is good if the text aligns correctly with the preprinted
image. Text that extends beyond preprinted box edges and text that overlaps other preprinted text are
examples of poor registration.

If, when printing on preprinted forms, the text of the first form on a page prints fine but that of subsequent
forms on the same page prints higher, your printer may require an adjustment to its Vertical Registration. If
this is the case, use the Vertical Registration control to increase the vertical registration (1-75) and try
printing again.

 Notes

· Registration will vary from printer to printer. So, if you change printers, always set the Vertical
Registration to zero to see if an adjustment is necessary.

· Vertical Registration is used only by the GDI Printer configuration.
· If the text of the first form on the page prints too high or too low, set the Vertical Registration to zero

and try adjusting the Laser, GDI Offsets instead. 

Start each batch as a new job
When printing tax forms using the GDI configuration, Account Ability spools an entire print job to disk before
actually printing it. Since each spooled page is approximately 300KB, the size of the spool file can grow rather
large when there are many pages to print.

If disk space is limited, you may want to consider breaking the spool file into batches. Then, as Windows is
processing one batch, Account Ability can be spooling the next. As each batch is completed, the spool file
associated with that batch is automatically deleted thus freeing up the needed disk space on a first-in-first-out
basis.

Use the Batch Size control to specify the number of pages (1-100) per batch. Account Ability will pause
between batches for a specified number of seconds (Time Delay) in order to allow Windows ample time to
process the batch. A Time Delay Control, shown below, is displayed during the printing process.

The minimum time delay is 10 seconds; the maximum is 60 seconds. During a timeout period, an animated
printer, shown below, will be displayed.



Setup 23

© 2012 IDMS, All rights reserved.

Automatic release of laser forms
Indicates if Account Ability should release the last printed page of a PCL job. In general, you should leave this
option selected. If you are using an older Hewlett Packard LaserJet Series II laser printer then remove this
option (you will have to release the last page using the printer's form feed button).

Automatic download of IDMS laser fonts
In order to draw tax forms on blank paper using the PCL configuration, a special set of laser fonts (IDMS Laser
Fonts) must first be downloaded to your PCL printer. Once these fonts have been successfully downloaded,
many, but not all, PCL printers eject a page with an arrowhead (è) in the upper left hand corner. Since IDMS
Laser Fonts generally remain resident in printer memory until the power has been turned off, it need not be
necessary to download them with each session. This preference enables you to intervene by confirming each
download.

 Note

· Although rare, some applications may erase the IDMS Laser Fonts from your PCL printer's memory. If this
should happen, either use the selection Prepare Laser on the Module menu to queue the fonts for
downloading once again or exit and restart Account Ability.

Forms button
For current forms pricing on the web, click the Forms button displayed in the lower right-hand corner of the
Printer Preferences dialog.

 Note

· Regardless of the printer configuration you choose, have your system administrator check your printer's
properties in order to ensure that (a) Print jobs are spooled so printing finishes faster, and (b) Printing
begins after the last page has been spooled. To access these properties, right-click your printer in the
Windows' Printers folder and select Properties from the context menu. Earlier versions of Windows (95,
98) display these properties by clicking the Spool Settings button on the Details page. Later versions of
Windows place this button on either the Configuration page or Advanced page.

4.1.5 Laser, GDI Offsets

 Preferences Menu  Laser, GDI Offsets

If you use preprinted forms with Account Ability there is a chance you may experience printer alignment
problems (e.g. Data prints too high, too low, too far to the right, or, too far to the left). Alignment problems,
when they exist, can be corrected by specifying an offset to the row and/or column print positions. Use the
Laser, GDI Offsets dialog to enter these offsets.

Laser, GDI Offsets
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Supported Forms (Preprinted)
This is a list of all preprinted forms whose print positions can be adjusted using offsets.

Configuration
Indicates the configuration (PCL, GDI) to which the specified offsets apply.

Row Offset
Row offsets are entered in row units. Positive values result in a downward shift; Negative values result in an
upward shift.

Column Offset
Column offsets are entered in column units. Positive values result in a shift to the right; Negative values result
in a shift to the left.

 Notes

· Row and column offsets only apply to preprinted forms.
· Row and column offsets only apply to the PCL and GDI configurations. They will not work with the Dot

Matrix configuration. 
· You should never experience an alignment problem when drawing forms on blank paper.
· Hardware specific alignment problems (e.g. paper jams, misfeeds, etc.) cannot be corrected using offsets.

4.1.6 US Postal Services

 Preferences Menu  US Postal Services

US Postal Services are divided into two groups, Intelligent Mail® Barcode and First-Class Indicia.

United States Postal Services

Intelligent Mail® Barcode
The Intelligent Mail barcode (IMB) is a new 65-bar Postal Service™ barcode used to sort and track letters
and flats. It allows mailers to use a single barcode to participate in multiple Postal Service programs, expands
their ability to track individual mailpieces, and provides greater mailstream visibility. In order to use the
Intelligent Mail barcode, a Mailer Identifier, Service Type Identifier, and Barcode Identifier will be required.

Mailer Identifier (Mailer ID): The Mailer ID should be obtained from the local Business Mail Entry Unit
(BMEU) or Mailpiece Design Analyst (MDA). Mail owners and mail preparers will be assigned a 6-digit or 9-digit
Mailer Identifier based on criteria established by the Postal Service. All 6-digit Mailer Identifiers will begin with 
‘0’ through ‘8’; all 9-digit Mailer Identifiers will begin with ‘9’.

 Notes

· BMEUs can be located at http://www.usps.com/nationalpremieraccounts/findlocators.htm
· MDAs can be contacted via the http://www.usps.com/replymail/mailpiece.htm online tool. 
· Current or new Confirm subscribers should contact Confirm Customer Assistance at 800-238-3150, visit

https://mailtracking.usps.com, or refer to Publication 197 for details on converting their existing Subscriber

http://www.usps.com/nationalpremieraccounts/findlocators.htm
http://www.usps.com/replymail/mailpiece.htm
https://mailtracking.usps.com


Setup 25

© 2012 IDMS, All rights reserved.

ID or for obtaining a new Mailer Identifier. Current or new ACS subscribers should contact the ACS
department at the NCSC at 877-640-0724 for assistance on converting their previously-assigned ACS
seven-character participant code or for obtaining new Mailer Identifier. 

Service Type Identifier (Service Type ID): The Service Type ID defines the mail class and any services
requested. Although a First-Class Service ID of 700 is suggested, you should consult with your Mailpiece
Design Analyst.

Barcode Identifier (Barcode ID): The Barcode ID defines the presort makeup in conjunction with an
Optional Endorsement Line. The Barcode ID generally should be left as “00”. For more information, consult
with your Mailpiece Design Analyst.

 Notes

· To learn more about the Intelligent Mail barcode, visit the Rapid Information Bulletin Board System (RIBBS)
at http://ribbs.usps.gov/index.cfm.

· The Service Type ID and Barcode ID are disabled since Account Ability uses IMB Basic Option. The Basic
Option still allows you to apply for discounted First-Class Mail by pre-sorting your mail by ZIP Code.

First-Class Indicia
If you plan to use Pressure Seal Forms and have a First-Class Mail indicia, Account Ability can be easily
configured to print your indicia on the address portion of each pressure seal form. Simply enter your indicia
line by line in the appropriate fields and check the Print on Pressure Seal Forms checkbox. If your indicia
contains less than 5 lines of text, leave the remaining line(s) blank.

 Try printing one or two returns in order to review the appearance of your indicia.

4.2 EFILE Setup

The regulations under section 6011(e)(2)(A) of the Internal Revenue Code provide that any person, including a
corporation, partnership, individual, estate, and trust, who is required to file 250 or more Information Returns
must file such returns electronically. Employers with 250 or more Annual Wage Reports to submit are also
required to file electronically.

Electronic filers of Information Returns ("Transmitters") must have a valid Transmitter Control Code (TCC). If
you require a TCC, Account Ability can help you obtain one by preparing Form 4419. Transmitters must
complete the Transmitter  page of the Transmitter/Submitter Information dialog.

Electronic filers of Annual Wage Reports ("Submitters") must have a valid User Identification Number. If you
require a User Id, Account Ability can help you obtain one by connecting you to the SSA Business Services
Online (BSO) website where you can register. Submitters must complete the Submitter  page of the
Transmitter/Submitter Information dialog.

Account Ability includes an Integrated Browser  ("Browser") which, by default, is used in place of your
computer's web browser when connecting to the IRS FIRE System and/or SSA BSO. The Browser's Fill-in
button eliminates the need to remember User Ids, Passwords, PINs, etc. by transferring information directly
from the database to the web page. The Integrated Browser  page of the Transmitter/Submitter
Information dialog should be used to configure, or disable, the Browser.

 Notes 

· If you are required to file electronically and fail to do so, the Internal Revenue Service may impose a
penalty.

· If you are not required to file electronically, but choose to do so, do not submit the same returns on paper.
· A TCC cannot be used to file Annual Wage Reports.
· A User Id cannot be used to file Information Returns.

4.2.1 Transmitter Information

 Module Menu  Transmitter/Submitter Information...

Transmitters of Information Returns must complete the Transmitter (IRS) page of the
Transmitter/Submitter Information dialog. Account Ability uses this information to create the Transmitter
("T") record for Information Returns reported electronically. Specifications are pursuant to IRS Pub. 1220 for
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reporting year 2012.

Transmitter (IRS) Information

Name, street address, city, state, and ZIP code
This group identifies the owner of the Transmitter Control Code (TCC). If you already have a TCC, enter the
name and address of the transmitter currently registered with the IRS. Otherwise, Account Ability can apply
for a TCC by completing Form 4419 with the information you enter (see Applying for a Transmitter Control
Code below).

Company associated with problem media or electronic files
Any correspondence relating to problem media or electronic files will be sent to the company contained within
this group. If the company associated with problem media is the same as the organization that owns the TCC,
use the Copy name and address above button. This button only appears when the cursor is in this group.

Contact name, 10-digit telephone with extension, and e-mail
This group contains the name, telephone number, and e-mail address of the person to be contacted if IRS/IRB
encounters problems with an electronic transmission.

· Name | Telephone: The dividing bar displayed in this field separates the contact name from the telephone
number. The contact name is entered to the left of the dividing bar, the telephone number is entered to the
right. When entering the telephone number, omit hyphens and follow the number with an optional
extension. For example, the telephone number 631-249-7744, ext. 12345, would be entered as
631249774412345.

· E-mail: Enter the contact's e-mail address.

Taxpayer Identification Number (TIN)
Enter the Employer Identification Number (EIN) of the organization transmitting the electronic files. Social
Security Numbers are not permitted. The TIN is reported in the T-Record of each file of Information Returns
submitted electronically. 

Transmitter Control Code (TCC)
Enter the Transmitter's TCC, if available. If a TCC has never been assigned, leave this field blank and apply for
a Transmitter Control Code (see below). If you are not sure if a TCC has been previously assigned, contact IRS
Technical Assistance before applying for another.
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 Applying for a Transmitter Control Code (TCC)
If you don't already have a TCC, complete all of the above information and click on the printer icon displayed
to the right of the TCC field. Account Ability will use this information to complete Form 4419.

 Notes 

· Use the Roll Forward button to roll forward 2011 transmitter information.
· The Roll Forward button will be disabled once this dialog is complete.
· A TCC cannot be used to file Annual Wage Reports.

4.2.2 Submitter Information

 Module Menu  Transmitter/Submitter Information...

Submitters of Annual Wage Reports must complete the Submitter (SSA) page of the
Transmitter/Submitter Information dialog. Account Ability uses this information to create the submitter
("RA", "RCA") records for Annual Wage Reports reported electronically. Specifications are pursuant to SSA
Office of System Requirements EFW2 and EFW2C for reporting year 2012.

Submitter (SSA) Information

User Identification Number (User Id)
Enter the User Id assigned to the Submitter by the Social Security Administration (SSA). If you don't already
have a User Id, see the section Applying for a User Identification Number, below.

Employer Identification Number (EIN)
Enter the Submitter's EIN.

Person associated with problem media or electronic files
Any correspondence relating to problem media or electronic files will be sent to the person specified within this
group. This information is reported to SSA in the submitter record of each transmission.

Submitter's name, street address, city, state, and ZIP code
This group identifies the owner of the EIN entered above.
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Preparer code
Select a preparer code in order to identify the preparer of the file.

Preferred method of notification
Select the best method of notification by SSA in the event of a problem. If you select Internet E-Mail, be sure
to enter your email address in the Person associated with problem media or electronic files group.

 Applying for a User Identification Number (User Id)
If you need a User Id, you can register for one online by clicking the Apply button. This will take you to the
Business Services Online Welcome Page. Once on this page, select the Registration link. Optionally, you can
register by calling 800-772-6270, Monday through Friday, 7:00 a.m. to 7:00 p.m. EST.

 Notes 

· Use the Roll Forward button to roll forward 2011 submitter information.
· The Roll Forward button will be disabled once this dialog is complete.
· A User Id cannot be used to file Information Returns.

4.2.3 Integrated Browser

 Module Menu  Transmitter/Submitter Information...

Account Ability's Integrated Browser ("Browser") is used in place of your computer's web browser when
connecting to the IRS FIRE System and/or SSA BSO. The Browser's Fill-in button eliminates the need to
remember User Ids, Passwords, PINs, etc. Just click the Fill-in button and data is transferred from Account
Ability's database to the web page.

Account Ability's Integrated Browser

· Fill-in: When prompted for a User Id, Password, PIN, TCC, etc., click the Fill-in button. The Browser will
attempt to fill in the web page by transferring data directly from Account Ability's database.

· Next: Moves forward one page.
· Prev: Moves back one page.
· Refresh: Refreshes the current page.

http://www.socialsecurity.gov/bso/bsowelcome.htm
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· Close: Closes the Browser.
· Help: Displays this help.
· Printer Button: Prints the web page.

· Copy Button: The path to your most recent transmittal file is displayed after the copy button ( ). Use this
button if you want to copy the path to the clipboard. You can then paste the path when browsing for your
transmittal.

 Note 

· The Next, Prev and Refresh buttons are disabled when connecting to SSA BSO.

Configuring the Integrated Browser

 Module Menu  Transmitter/Submitter Information...

Integrated Browser Setup

 IRS FIRE Login Information
This group contains the User Id, Password, and Personal Identification Number (PIN) used to logon and submit
transmittal files to the IRS FIRE System.

· User Id: Must match the User Id used to logon to the IRS FIRE System.
· Password: Must match the Password used to logon to the IRS FIRE System.
· PIN: Must match the PIN used to submit transmittals on the IRS FIRE System.
· IRS TEST Checkbox: If you plan to submit TEST files to IRS FIRE, you will need to create a separate

account with the IRS FIRE TEST File Processing system (see IRS FIRE - TEST File Processing on the
Module menu). Check the IRS TEST checkbox prior to entering the User Id, Password and PIN to be used
when testing with IRS FIRE.

 Note

· The Browser automatically detects changes to your Password and/or PIN. When the Browser closes, changes
are written to Account Ability's database and the message "Changes have been successfully recorded" is
displayed.

 SSA BSO Login Information
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This group contains the Password used to logon to the SSA BSO.

· User Id: This is the User Id entered on the Submitter (SSA) page.
· Password: Must match the Password used to logon to the SSA BSO.

 Note

· The Browser automatically detects a change to your Password. When the Browser closes, the change is
written to Account Ability's database and the message "Changes have been successfully recorded" is
displayed.

 Browser to be Used (Disabling the Integrated Browser)
This group specifies the browser to be used when connecting to the IRS FIRE System or SSA BSO. Although
Account Ability's Integrated Browser is suggested, you should select your computer's default browser only if
you experience connection problems.

 Fill-in Security
The purpose of the Fill-in button is to transfer security information directly from the database to the web
page. If you set a Fill-in Security password, it will be requested of each user who clicks the Fill-in button at
the start of each session.

 Notes 

· The Integrated Browser is not used with IRS e-Services for Bulk TIN Matching.
· IRS FIRE and SSA BSO require that you change passwords periodically. The Integrated Browser will attempt

to update the database with each password and/or PIN change.

4.3 Database Setup

Account Ability's database, AA2012.abs, is a robust, high-speed, embedded single-file database with SQL
support. The data access layer is compiled directly into the server license (AA2012.exe), thus eliminating the
need for special configuration libraries or a database server.

When Account Ability is first launched, AA2012.abs is automatically created in folder

<installation folder>\2012DATA (this is the default location)

If a prior year database, AA2011.abs, is found, transmitter, submitter and US Postal Service information are
automatically rolled forward.

Although the default location will suffice for single user installations, you can move it to a new location on your
network with a simple copy, paste and reallocate.

 Related Topics

· Moving the Database
· Database Reallocation
· Prior Year Database

 Notes

· A new database is created each reporting year (e.g. 2010data.abs for 2010, 2011data.abs for 2011,
2012data.abs for 2012, and so on).

· You can roll forward any part of the prior year database at your option.
· For the exact location of the current year database select About Account Ability's Database (2012) on

the Help menu.
· If you need to locate the prior year database select Locate Prior Year Database (2011) on the Help

menu.
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4.3.1 Moving the Database

Account Ability's database, AA2012.abs, can be moved to a new location on your network with a simple copy,
paste and reallocate. Moving the database from its existing location ("SOURCE") to a new location
("DESTINATION") should be performed by a network administrator ("ADMIN").

· Advise all users to exit Account Ability.
· Have ADMIN start Account Ability.
· From the Module menu, select Logged Users to ensure that ADMIN is the only active user. If other

Logged Users are listed click the Verify button to verify their connections to the database. Repeat these
steps until ADMIN is the only logged user.

· Select About Account Ability's Database (2012) on the Help menu. Jot down the folder in which the
database currently resides. This is the SOURCE folder.

· Exit Account Ability.
· Browse to the SOURCE folder and click once on AA2012.abs
· Select Copy from the Edit menu.
· Browse to the DESTINATION folder.
· Select Paste from the Edit menu.
· Start Account Ability.
· From the Module menu select Re-allocate  Account Ability's 2012 Database.
· Browse to the DESTINATION folder and double-click AA2012.abs
· Exit and restart Account Ability.
· Select About Account Ability's Database (2012) on the Help menu to confirm the new DESTINATION.

The final step in moving the database is to inform each user's workstation of the new DESTINATION. This is
discussed in the next section, Database Reallocation .

 Notes

· All users must have administrative privileges to the DESTINATION location.
· Since the database was copied (not cut) the SOURCE location will still contain a copy of AA2012.abs

4.3.2 Database Reallocation

 Module Menu  Re-allocate  Account Ability's 2012 Database

As discussed previously, Account Ability's database, AA2012.abs, can be moved to a new location
("DESTINATION") on your network with a simple copy and paste. Moving the database, however, does not
automatically inform Account Ability of the DESTINATION. Consequently, it will be necessary to reallocate the
database on each user's workstation.

· Have each user start Account Ability.
· From the Module menu select Re-allocate  Account Ability's 2012 Database.
· Browse to the DESTINATION folder and double-click AA2012.abs
· Exit and restart Account Ability.

Account Ability will now look to the DESTINATION folder for its database. To confirm this, have each user
select About Account Ability's Database (2012) on the Help menu.

4.3.3 Prior Year Database

 Help  Locate Prior Year Database (2011)

The Client (Filer) Management module maintains your clients in distinct annual databases that can be rolled
forward from year-to-year without any loss of prior year integrity. If you used Account Ability in 2011, you will
probably want to roll forward the 2011 client register (see Client (Filer) Management ).

If a prior year database, AA2011.abs, is not found, an exception is raised
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If this should happen, use the selection

Locate Prior Year Database (2011)

on the Help menu to search alternate locations for AA2011.abs

 Notes

· An alternative way to locate prior year data is to exit the 2012 version of Account Ability, run the 2011
version and select About Account Ability's Database (2011) on the Help menu.

· Instructions for rolling forward the client register  can be found in the section Importing & Exporting
Clients.

5 Client (Filer) Management

 Module Menu  Client (Filer) Management

The Client (Filer) Management module is accessed from the Module menu or the Recipient Toolbar . This
module includes all of the tools required for adding , editing , deleting , copying , rolling forward

, importing  and exporting  client information.

Client (Filer) Management

What is a Client?
Depending upon the type of returns to be filed, a filer can be a Payer (1099-MISC, 1099-DIV, 1099-INT,
1099-OID, 1099-PATR, 1099-B, 1099-G, 1099-Q, 1099-R, 1099-LTC, W2G), a Lender (1099-A, 1098,
1098-E), a Creditor (1099-C), a Filer (1097-BTC, 1099-K, 1099-S, 1098-T), a Trustee (5498, 5498-SA,
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5498-ESA, 1099-SA), a Corporation (1099-CAP, 3922), a Transferor (3921), a Provider (1099-H), a Donee
(1098-C), or, an Employer (W2, W2C). To avoid this ambiguity, Account Ability regards all filers as clients and
uses the terms client and filer synonymously.

Clients are listed in the order specified by the highlighted column of the client grid (Client ID above). To
change the ordering, click on a column heading or use the context menu. The current ordering is referred to as
the selected index.

The explorer bar, displayed to the left of the client grid, is divided into three sections - Client Tasks, Reports,
and Import/Export. Client tasks can also be accessed from the Client Management Context Menu. The number
shown in parentheses in the Client Task Bar represents the number of clients currently recorded. 

The Incremental Search Panel, displayed below the client grid, facilitates the task of locating clients by
incrementally searching the selected index with each character entered. The client indicator  points to the
closest match. The Select (Release) buttons open (close) the selected client's database of Information
Returns and Annual Wage Reports.

 Related Topics

· Client Maintenance Tasks

 Notes

· Clients are maintained in distinct annual databases that can be rolled forward from year-to-year without any
loss of prior year integrity. If the current year database, 2012DATA, does not exist, it is automatically
created.

· If no clients are recorded, an information dialog instructing you on how to Roll Forward your prior year
database, 2011DATA, is displayed. Rolling forward is optional (it does not happen automatically).

· If you did not use Account Ability in 2011, or, do not desire to roll forward 2011 information, disregard the 
Roll Forward Information dialog.

· A Client ID displayed in green (e.g. CLIENTID) indicates a correction client.
· A Client ID displayed with a strike (e.g. CLIENTID) indicates an inactive client.
· To hide inactive clients, select Active Clients Only from the Client Management Context Menu.
· A reporting year displayed in yellow (e.g. 2009) indicates a prior year reporting client.

5.1 Client Master Record

5.1.1 General Page

Account Ability uses the information entered in the Filer's Name, Address, and Identification groups when
printing Information Returns and Annual Wage Reports.
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Client Master - General Page

Filer's Name Group
Name line 1 is required; Name line 2 is optional. If you need to specify a Transfer (or Paying) Agent, use name
line 2 and check the Transfer Agent indicator.

Filer's Name Control
The Filer's Name Control can be obtained only from the mail label on the Package 1099 that is mailed to most
payers each December. Package 1099 contains Form 7018–C, Order Blank for Forms, and the mail label on
the package contains a four (4) character name control. If a Package 1099 has not been received, you can
determine your name control using the following simple rules or you can leave the field blank. For a business,
use the first four significant characters of the business name. Disregard the word "the" when it is the first word
of the name, unless there are only two words in the name. A dash (-) and an ampersand (&) are the only
acceptable special characters.

Filer's Address Group
Address line 1 must contain a delivery address (number, street, or Post Office Box). Address line 2 can contain
an optional location address (room number, suite, or attention to). For domestic addresses, enter a City,
State, Zip code, and optional Zip code extension.

 Notes

· For foreign addresses, check the Foreign Address indicator and enter a City, Province or State, Postal
Code, and Country code.

· If the Transfer Agent indicator is checked, the address you enter should be that of the transfer (or paying)
agent.

Identification Group
Indicate your client's taxpayer identification number (TIN), optional routing and transit number (RTN), and
optional office code. Make sure that the TIN Type field contains the correct TIN qualifier (EIN=Employer
Identification Number, SSN=Social Security Number, or N/A=Not Available).

 Note

· Account Ability does not accept dashes when entering taxpayer identification numbers. Instead, a TIN Type
qualifier (SSN, EIN, N/A) is used. TINs are, however, printed with dashes.

The following mutually exclusive indicators are specific to Form 1099-K:

· PSE Indicator - If checked, the filer is a Payment Settlement Entity
· EPF Indicator - If checked, the filer is an Electronic Payment Facilitator
· TPP Indicator - If checked, the filer is a Third Party Payer

For more information, see the IRS Instructions for Form 1099-K.

Indicators Group

Combined Fed/State Filer
Electronic filers participating in the Combined Federal/State Filing Program (CFSP) should check this indicator.
If checked, Account Ability automatically includes CFSP reporting information for recipients residing in
participating states. IRS/IRB forwards this information to participating states free of charge for approved filers,
thus eliminating the need for separate state reporting.

 Notes

· The following information returns may be filed under this program: 1099-DIV, 1099-G, 1099-INT, 1099-K,
1099-MISC, 1099-OID, 1099-PATR, 1099-R, 5498.

· For detailed information on the Combined Federal/State Filing Program, refer to IRS Publication 1220 or
contact IRS/IRBcustomer service at 1-866-455-7438, Monday through Friday, 8:30AM to 4:30PM EST.

· You will also find information regarding CFSP on our FAQ web page.

Corrected Returns Only
 Indicates a Correction Client, one that is used strictly for the purpose of correcting Information Returns.

http://www.idmsinc.com/ListFaqs.php?FilterText=Combined Fed/State Filing
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Final Return
 Indicates that this is the last year for filing Information Returns.

Terminating Business
 Indicates that this filer has terminated business during the 2012 calendar year.

Filer Is Not Active
 Indicates that this filer will not be active for the 2012 reporting year, but may be active in the future.

 Note

· This field appears disabled if the client has been selected on your station (the Client ID is displayed in the
Active Client Panel of the status bar ).

5.1.2 Corporate Page

Filers operating under different names, possibly in different locations, using the same taxpayer identification
number (TIN), should use the Corporate page to identify the entity associated with the TIN.

Client Master - Corporate Page

Name Group
Specify the name of the entity associated with the TIN. Name line 1 is required; Name line 2 is optional. If you
need to specify a Transfer (or Paying) Agent, use name line 2 and check the Transfer Agent indicator.

 Note

· If the Transfer Agent indicator is checked, the address you enter should be that of the transfer (or paying)
agent.

Address Group
Specify the address of the entity associated with the TIN. Address line 1 must contain a delivery address
(number, street, or Post Office Box). Address line 2 can contain an optional location address (room number,
suite, or attention to). For domestic addresses, enter a City, State, Zip code, and optional Zip code extension.

 Notes

· For foreign addresses, check the Foreign Address indicator and enter a City, Province or State, Postal
Code, and Country code.

· If the Report to IRS indicator is checked, the information entered on this page is reported in lieu of the
information entered on the General  page when filing electronically.

12
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5.1.3 Contacts Page

Account Ability uses information entered on the Contacts page when printing Information Returns and
summary transmittals 1096 and W3.

Client Master - Contacts Page

Information Returns Group

Contact
Enter the name of the contact to be printed on transmittal 1096.

Phone
Enter the telephone number to be printed on Information Returns W2G, 1097-BTC, 1098, 1098-C, 1098-E,
1098-T, 1099-A, 1099-B, 1099-C, 1099-CAP, 1099-DIV, 1099-G, 1099-H, 1099-INT, 1099-K, 1099-LTC,
1099-MISC, 1099-OID, 1099-PATR, 1099-Q, and 1099-S.

 Notes

· Filers of Form 1098-T must use the telephone number for the information contact at the institution, not the
institution's general telephone number.

· Filers of Form 1099-C should ensure that the Creditor's telephone number is a central number for all
canceled debts at which a person may be reached who will insure the debtor is connected with the correct
department.

Print contact after telephone
The telephone number prints on Information Returns and Form 1096. The contact name, however, prints only
on Form 1096. When this option is selected ( ) the telephone and contact name will be printed as
XXX-XXX-XXXX/CONTACT (e.g. 631-249-7744/John Smith).

Always print telephone number
If checked, the filer's telephone number prints on all Information Returns. Otherwise, pursuant to IRS
instructions, it only prints on forms W2G, 1097-BTC, 1098, 1098-C, 1098-E, 1098-T, 1099-A, 1099-B, 1099-C,
1099-CAP, 1099-DIV, 1099-G, 1099-H, 1099-INT, 1099-K, 1099-LTC, 1099-MISC, 1099-OID, 1099-PATR,
1099-Q, and 1099-S.

W3 Contact Information Group

Contact
Enter the name of the contact to be printed on transmittal W3.

Phone
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Enter the telephone number to be printed on transmittal W3.

Payment Settlement Entity Information Group

If the filer is an Electronic Payment Facilitator (EPF) or Third Party Payer (TPP) of merchant card and third
party network payments, enter a default Payment Settlement Entity (PSE) name and telephone number. The
default PSE is automatically assigned to each payee's account, unless overridden.

Phone
Enter the PSE's telephone number, if different from the filer's phone. Otherwise, leave this field blank.

Name
Enter the PSE's name, if different from the filer's name. Otherwise, leave this field blank.

 Notes

· Payment Settlement Entity information is specific to filer's of Form 1099-K.
· For more information, see IRS Instructions for Form 1099-K.

E-Mail & Fax Information Group

E-Mail
Enter the email address to be printed on transmittals 1096 and W3.

Fax
Enter the fax number to be printed on transmittals 1096 and W3.

5.1.4 State ID Page

Account Ability uses the state identification numbers entered on this page when preparing state specific
Information Returns and Annual Wage Reports.

Client Master - State ID Page

Add a New State ID

· Select the state to be added from the State drop down list.
· Enter the filer's state id in the State ID Number box. 
· Check the Tax box if wages are taxable in the selected state.
· Click the Save button.
· If a master password  has been set, you will be prompted to enter it prior to making any changes.44
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 Note

· Account Ability uses the Tax box to determine if Federal wages should be copied to State wages on Form
W2. If wages are taxable in the selected state, wages are copied to the State wages box. Otherwise, they
are not.

Edit a State ID

· Double-click the state to be edited in the grid to the left.
· Enter changes to the state id number in the State ID Number box.
· Check the Tax box if wages are taxable in the selected state.
· Click the Save button.
· If a master password  has been set, you will be prompted to enter it prior to making any changes.

Delete a State ID

· Click once on the state to be deleted in the grid to the left.
· Click the Delete button.
· If a master password  has been set, you will be prompted to enter it prior to making any changes.

5.1.5 W-2 Setup Page

Filers planning to prepare Annual Wage Reports should ensure the accuracy of the information entered on the
W2 Setup page.

Client Master - W2 Setup Page

Kind of Payer
Indicates the kind of payer to report on form W3 and when reporting electronically.

 Special Instructions for Military Employers
These instructions only apply to reporting earnings of the uniformed personnel of the armed forces. They do
not apply to contractors of the US Defense Department or civilian workers of the Department of Defense.

· Report Reserve forces Active Duty Training (ACDUTA and AD mobilization) as Military Wages.
· Report Reserve training that is not Active Duty Training (UTAs) as Regular Wages. Include WWWW in the

filer's establishment number field (EST #).

Kind of Employer

44

44
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Indicates the kind of employer to report on form W3 and when reporting electronically.

· Federal govt. - Check this box if you are a Federal government entity or instrumentality.
· State/Local - Check this box if you are a state or local government or instrumentality that is not a

tax-exempt section 501c organization.
· State/Local (501c) - Check this box if you are a dual status state or local government or instrumentality

that is also a tax-exempt section 501c organization.
· 501c non-govt. - Check this box if you are a non-governmental tax-exempt section 501c organization.
· None apply - Check this box if none of the above apply to you.

Tax Jurisdiction
If applicable, indicate the appropriate tax jurisdiction. This information is reported to SSA when filing Annual
Wage Reports or electronically.

Agent Information Group

· Form 2678 Procedure Agent: (1) An employer that wants to use an agent prepares a Form 2678,
Employer Appointment of Agent, and submits the form to an agent. (2) The agent submits to IRS the
Form(s) 2678 received from the employer along with a written request for authority to act as an agent for
the employer. (3) IRS gives a written approval. Be sure to enter the Employer's EIN for which you are an
Agent in the Agent for EIN field.

· Common Pay Master: A corporation that pays an employee who works for two or more related
corporations at the same time.

· 3504 Agent: A state or local government agency authorized to serve as a section 3504 agent for disabled
individuals and other welfare recipients who employ home-care service providers to assist them in their
homes.

 Note

· Agents and Common Pay Masters must enter their Agent EIN in the Agent EIN field.

Third-Party Sick Pay Information Group

· Filer is a third-party sick pay payer - If this filer is a payer of third-party sick pay, check this box.
· Income tax withheld -Complete this box only if you are the employer and have employees who had

income tax withheld on third-party payments of sick pay. Show the total income tax withheld by third-party
payers on payments to all your employees.

Additional Employer Information

· Compute FICA - Check this box to enable the Compute FICA feature, which can compute Social Security
Wages, Social Security Tax, Medicare Wages, and Medicare Tax based upon the Gross Wages, Social
Security Tips, and Deferred Compensation you enter on each employee's Form W2.

· Assign employee "Control" numbers - Check this box to enable automatic assignment of employee
Control numbers on Form W2 (see the Tools menu of Form W2).

· Suppress printing employee full name - Box e of form W2 contains specific fields for an employee's first
name, middle initial, last name and suffix. Since these fields have fixed widths, the results may appear
unappealing when placed in a double-window envelope. If desired, a more pleasant format can be printed
directly above the employee's address in box f. If this box is checked, the employee's full name is not
printed in box f of form W2. Otherwise, the full name is printed above the street address.

· Filer's establishment number (Est #) - Use this box to identify different establishments for this
employer. If desired, a separate form W3 may be filed, with Forms W2, for each establishment even if they
all have the same EIN.

· Other EIN used this year - Indicates an EIN used on Form 941, 943, or CT-1 this year that is different
than the EIN to be reported on Form W3. When entering an EIN use 9 digits (no hyphens).

5.1.6 1098 Setup Page

Recipients from payer's in a cooperative can request that Account Ability compute each payer's share of the
total amortization, mortgage interest, real estate taxes, and capital reserve fund entered on the 1098 Setup
page.
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Client Master - 1098 Setup Page

1098 Cooperative Information Group
Enter the Total Shares, Amortization, Mortgage Interest, Real Estate Taxes, and Capital Reserve Fund for
reporting year 2012. If requested, Account Ability will use this information to apportion each payer's share of
these respective amounts.

 Note

· See the Apportion selection on the File menu of Form 1098.

1098 Print Options Group

Suppress printing apartment number
If checked, the Apartment number field on Form 1098 is not printed. Otherwise, the Apartment number is
included on the payer's second address line.

Print apartment ownership information
If checked, ownership information for each cooperative apartment is printed in the Description area of Form
1098 in the format APT# MMDDYY-MMDDYY XXXXXXX, where XXXXXXX = Shares (e.g. 112A 010107 TO
123107 4533.4).

5.2 Client Maintenance

5.2.1 Adding Clients

 Client Tasks  New

To add a new client,

· Select Client (Filer) Management from the Module menu.
· Select New from the Client Task Bar.

The New Filer dialog will be displayed.

Enter the Client ID: This is a unique alphanumeric identifier you assign to each client.

Enter the Reporting Year: This is the reporting year to be used when filing electronically. Prior year returns
are displayed with a yellow background; current year returns with a white, as illustrated below.
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 Notes

· You must use the 2012 version of Account Ability to report prior year returns electronically.
· Prior year returns must be printed using the 2011 version of Account Ability.
· Shortcut Key = Ins
 
Complete each of the following pages of the Client Master Record,

· General
· Corporate
· Contacts
· State ID
· W2 Setup
· 1098 Setup

Click OK to record the client.

5.2.2 Editing Clients

 Client Tasks  Edit

To edit an existing client,

· Select Client (Filer) Management from the Module menu.
· Locate the client to be edited.
· Select Edit from the Client Task Bar or context menu.

The Edit Filer dialog will be displayed and ready for editing.

Click OK to save your changes.

 Notes

· If a master password  has been set, you will be prompted to enter it prior to making any changes.
· Since the Client ID is a primary key, you cannot change its value from the Edit Filer dialog.
· There is a procedure posted on the Tips Knowledge Base that explains how to change a Client ID, if

necessary.
· When using the context menu, you must right-click directly on the client to be edited.
· Shortcut Key = CTRL+E

5.2.3 Deleting Clients

 Client Tasks  Delete

To delete an existing client,

· Select Client (Filer) Management from the Module menu.
· Locate the client to be deleted.
· Select Delete from the Client Task Bar or context menu.

If the client is not active on any workstation, including yours, and if a master password  has not been set,
Account Ability will prompt you to confirm the deletion.

 Notes

33

35

36

37

38

39

44

44

http://www.idmsinc.com/ListTips.php?FilterText=How to change a Client ID


Tax Form Preparation for 201242

© 2012 IDMS, All rights reserved.

· If the client is active, a list of active users will be displayed. Have each user release the client by clicking
the Release button, then, try deleting again.

· If a master password  has been set, you will be prompted to enter it.

· When a master password  has been set, the delete icon  is displayed as  on the Client Task Bar.
· When using the context menu, you must right-click directly on the client to be deleted.
· Shortcut Key = CTRL+DEL

 Warnings

· When you delete a client, all Information Returns and Annual Wage Reports specific to that client are also
deleted.

· The process of deleting a client is irreversible.

 Related Topics

Setting a "Master" Password

5.2.4 Copying Clients

 Client Tasks  Copy

There are occasions when you will want to copy a client's master record.

· If you want to correct a client's Information Returns
· If you want to change a Client ID
· If you want to roll-up a client's file of existing returns

just to name a few.

To copy an existing client,

· Select Client (Filer) Management from the Module menu.
· Locate the source client to be copied.
· Select Copy from the Client Task Bar or context menu.

Account Ability will first ask if you are creating a correction client, 

A correction client is one that is used strictly for the purpose of correcting Information Returns. The Copy
Filer dialog will then be displayed. All of the source client's information, with the exception of the Client ID, is
copied. Correction clients will have the Corrected Returns Only indicator checked.

· Enter the Client ID: It is suggested, but not mandatory, that you enter a Client ID closely resembling that
of the source client.

· Click OK to save your changes.

 Notes

· When using the context menu, you must right-click directly on the source client.
· Only the source client's master is copied. Information Returns and Annual Wage Reports are not copied.
· All of the source client's passwords are copied, including the master password .
· Shortcut Key = CTRL+C

 Related Topics
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Correcting Information Returns
Clearing Form Specific Passwords

5.2.5 Active Forms List

 Client Tasks  Active Forms

A client's Active Forms List displays the number of returns processed for the 2011 and 2012 reporting years.

To display a client's Active Forms List,

· Select Client (Filer) Management from the Module menu.
· Locate the client whose Active Forms List you want to display.
· Select Active Forms from the Client Task Bar or context menu.

 Notes

· When using the context menu, you must right-click directly on the client whose Active Forms List you
want to display.

· You can open a tax form from the Active Forms List provided the client is currently selected on your
station.

· If you double-click on a client, the Active Forms List is available from the menu of available forms.
· Shortcut key = CTRL+A

5.2.6 Client Notes

 Client Tasks  Notes

In addition to the global notes record, Account Ability maintains a distinct note record for each of your clients.
The client note record can be a rather useful tool for keeping track of client specific tasks to be done either by
you or others on your network.

To access a client's note record, 

· Select Client (Filer) Management from the Module menu.
· Locate the client whose notes you want to access.
· Select Notes from the Client Task Bar or context menu.

The client's note dialog will be displayed.

 Notes

· When using the context menu, you must right-click directly on the client whose notes you want to access.

· To access a client's note record while adding or editing client information, click the note icon ( ) displayed
under the Help button of the New Filer or Edit Filer dialog.

· When notes exist, See Notes will be displayed instead of Notes on the Client Task Bar.
· Shortcut Key = CTRL+N

5.2.7 Active Users

 Client Tasks  Active Users

To display a list of users actively working on a specific client,

· Select Client (Filer) Management from the Module menu.
· Locate the client of interest.
· Select Active Users from the Client Task Bar or context menu.

All users actively working on the client will be displayed in a comma-separated list.

 Notes

· When using the context menu, you must right-click directly on the client of interest.
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· A No Activity! message is displayed if no users are actively working on the client.
· If you feel there is a discrepancy and need to verify the list of users, select Logged Users from the Module

menu. This will display a list of all users actively working in Account Ability. The Verify button, displayed at
the bottom of this list, can then be used to verify each user's session.

5.2.8 "Master" Password

A client's master password protects against

· Unauthorized deletion of client records, 
· Unauthorized editing of client records,
· Unauthorized unlocking of a client's forms, and
· Unauthorized removal of form specific passwords.

To set (or modify) a client's master password,

· Select Client (Filer) Management from the Module menu.
· Locate the client whose master password you want to set (or modify).
· Select Edit from the Client Task Bar or context menu.

When the Edit Filer dialog appears, click the security icon  located under the Help button. If a master
password already exists, you will first be prompted to enter it.

 Notes

· When using the context menu, you must right-click directly on the client whose master password you want
to set (or modify).

· Passwords are case sensitive.

· When a master password has been set, the delete icon  is displayed as  on the Client Task Bar.

 Related Topics

Setting Form Specific Passwords
Clearing Form Specific Passwords
Locking/Unlocking Forms

5.3 Importing & Exporting Clients

5.3.1 Rolling Forward Clients

 Client Import/Export  Roll Forward

The Client (Filer) Management module maintains your clients in distinct annual databases that can be rolled
forward from year-to-year without any loss of prior year integrity. If you used Account Ability in 2011, you will
probably want to roll forward the 2011 client register. 

To roll forward the client register,

· Select Client (Filer) Management from the Module menu.
· Select Roll Forward from the Client Import/Export Bar.

If the prior year database, AA2011.abs, is not found, the exception
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is raised. Otherwise, the Roll Forward Client Register dialog is displayed,

Roll Forward Client Register Dialog

Exclude filers who terminated business last year
If checked, clients who terminated business during the 2011 reporting year are not rolled forward.

Exclude filers who filed a final return last year
If checked, clients who filed final returns during the 2011 reporting year are not rolled forward.

Exclude filers with a tax reporting year prior to 2011
If checked, clients with a reporting year prior to 2011 are not rolled forward.

Exclude filers marked for corrected returns only
If checked, correction clients are not rolled forward.

Erase each filer's note register
If checked, each client's 2012 Note Register  is erased.

(SECURITY) Roll forward passwords used in 2011
If checked, passwords used in 2011 are rolled forward to 2012. 

 Notes

· An alternative way to locate prior year data is to exit the 2012 version of Account Ability, run the 2011
version, then restart the 2012 version.

· Only the client register is rolled forward. You will have the option to roll forward a client's Information
Returns and Annual Wage Reports as you work on them. This is discussed in the topic Working with Tax
Forms.

· If you receive the error Failed to Roll Client ID XXXX: Key Violation, this is an indication that a client
already exists with Client ID XXXX.

43
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5.3.2 Importing Text Files

 Client Import/Export  Import Text File

Account Ability can import Client information from a comma delimited ASCII Text File that conforms to a
pre-defined record layout (Schema).

To import a text file, 

· Select Client (Filer) Management from the Module menu.
· Select Import Text File from the Client Import/Export Bar.
· Locate the text file to be imported and click Open.

If your text file conforms with the client schema , a record count and confirmation dialog will be displayed
prior to importing. If your text file does not conform with this schema, the Import Mapping Utility on the
Module menu will facilitate creating a text file that does.

 Notes

· If you receive the error Failed to Import Client ID XXXX: Key Violation, this is an indication that a client
already exists with Client ID XXXX.

· The selection Sample ASCII Import Files on the Help menu contains a list of text files compatible with
Account Ability. The file Clients.txt contains sample client data conforming with the schema.

· For instructions on importing Information Returns and Annual Wage Reports, see Importing & Exporting
in the section on Working with Tax Forms.

5.3.3 Exporting the Client Register

 Client Import/Export  Export

The Export Options dialog exports client records to comma delimited text files compatible with Microsoft
Excel® and most mail merge applications. Only the fields you select are exported, in the order you specify.

To access the Export Options dialog,

· Select Client (Filer) Management from the Module menu.
· Select Export from the Client Import/Export Bar.

The Export Options dialog will be displayed,
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Export Options Dialog

The Available Fields List contains all fields that can be exported; The Selected Fields List contains all fields
that will be exported. Fields can be moved between lists either by double-clicking or by using the selection
icons, 

 Moves the selected field to available.

 Moves all selected fields to available.

 Moves the available field to selected.

 Moves all available fields to selected.

Selected fields can be ordered using the arrow icons,

 Moves the selected field up one spot.

 Moves the selected field down one spot.

After selecting and ordering the fields to be exported, click the Begin button. You will be prompted to select a
file name to contain the export.

 Notes

· If the Include descriptive header record indicator is checked, the first record of the resultant export file
will be a comma separated list of the selected field names.

· By default, the export file is saved in a sub-folder of Account Ability named EXPORT.
· Shortcut Key = CTRL+X

5.4 Client Reports

5.4.1 Activity Report

 Client Reports  Activity Report

The Activity Report lists each of your clients together with the total returns processed for the 2011 and 2012
reporting years. This is an extremely useful report for those users supporting many clients.

To preview the Activity Report with the option to print,

· Select Client (Filer) Management from the Module menu.
· Select Activity Report from the Client Reports Bar.

The Activity Report can be sorted by Client ID, Name, or Taxpayer ID. In order to specify a sort order,
click the desired column on the client title bar (shown below) or select the ordering from the context menu.

 Notes

· Depending upon the number of clients recorded, the Activity Report may take a couple of minutes to
prepare. If you must interrupt the report while it is being prepared, select Activity Report from the Client
Reports Bar again.

· As you exit the Activity Report you will have option to save the results to a comma separated text file.

5.4.2 Client Master List

 Client Reports  Client Master

The Client Master List contains all recorded clients and their demographics.

To preview the Client Master List with the option to print,

· Select Client (Filer) Management from the Module menu.
· Select Client Master from the Client Reports Bar.
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The Client Master List can be sorted by Client ID, Name, or Taxpayer ID. In order to specify a sort order,
click the desired column on the client title bar (shown below) or select the ordering from the context menu.

 Note

· The Client ID for inactive clients is printed in an italicized strikeout font (e.g. CLIENTID)

5.4.3 Recipient Master List

 Client Reports  Recipient Master

The Recipient Master List contains all recorded recipients of information returns.

To preview the Recipient Master List with the option to print,

· Select Client (Filer) Management from the Module menu.
· Select Recipient Master from the Client Reports Bar.

This will display the Recipient Master Report Options. There are 3 different report layouts (Simple,
Standard, Complete), 3 different sorting options (Recipient Name, Taxpayer ID, Zip Code) and the option to
truncate recipient TINs.

Recipient Master Report Options

6 Working with Tax Forms

6.1 Opening a Tax Form

Generally speaking, a tax form is a paper document used by a taxpayer when paying his or her taxes. A tax
return is a document giving the tax collector information about the taxpayer's liability. Tax returns are
sometimes referred to as returns. Account Ability regards a tax form as either the paper document, in the
general sense, or the user interface used to enter taxpayer liability.
 

 Selecting a Client

· Select Client (Filer) Management from the Module menu.
· Locate the client to be selected.
· Double-click the client, or
· Click the Select button, or
· Choose Select Client on the context menu.
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If successful, the selected Client ID is displayed in the Active Client Panel of the status bar  and you are
prompted for the tax form to open.

 The  Active Forms selection displayed at the top of the menu of available forms will display the
number of returns processed for the 2011 and 2012 reporting years.

 Notes

· Once a client has been selected, tax forms can be opened from the Forms menu.
· You can open at most 5 tax forms simultaneously for the selected client.
· When using the context menu, you must right-click directly on the client.

 Releasing a Client

· Close all open tax forms.
· Select Client (Filer) Management from the Module menu.
· Click the Release button.

If successful, NO CLIENT is displayed in the Active Client Panel of the status bar  and the Forms menu
is disabled.

 Notes

· Selecting a client automatically releases any previously selected client.
· Exiting Account Ability without releasing a client automatically selects the client the next time you start

Account Ability.

6.2 Setting Tab Stops

Tab stops are boxes at which the cursor stops when either the TAB or ENTER key is depressed. The
Designate Tab Stop dialog can minimize keystrokes by setting desired tab stops for any tax form.

To set/reset a tab stop, right-click directly on the caption of the box. If the box is not a required tab stop, the
Designate Tab Stop dialog will be displayed. For example, right-clicking directly on the caption of the
Account number box of Form 1099 displays the Designate Tab Stop dialog shown below,

Designate Tab Stop for Account number

Simply indicate whether or not the box should be a tab stop. Boxes which are tab stops display their captions
in red or black; boxes which are not tab stops display their captions in maroon or gray.

Testing Tab Stops
Depress the TAB or ENTER key repeatedly. The cursor will move around the form stopping only at the tab
stops you have designated.

 Notes

· The ENTER key functions as the TAB key if, and only if, Enter Key = Tab Key is set (see Desktop
Preferences ).

· Certain boxes, such as name, address, city, state, zip, etc., are required. Consequently, the Designate Tab
Stop dialog is not displayed for such boxes.
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· You can still enter data into a non designated tab stop by first clicking directly on the box.

6.3 The Recipient Menu

After opening a tax form, the Generic menu,

and the Recipient menu,

merge to form the Main menu,

The File menu contains selections for the following common tasks,

· Adding  recipient returns
· Locating  recipient returns
· Deleting  recipient returns
· Totaling  recipient returns
· Importing  recipient returns
· Exporting  recipient returns
· Electronic Reporting
· Printing  recipient returns
· Reporting

The Security menu contains selections for 

· Setting Passwords
· Clearing Passwords

The Order By contains form specific indexes for sorting  a file of returns.

The Tools menu contains a variety of form specific maintenance tools.

6.4 Common Tasks

6.4.1 Adding Returns

 File  New

To add (insert) a new return,

· Click  on the recipient toolbar, or
· Select New from the File menu, or
· Depress the Insert key, or
· Select a taxpayer from the Taxpayer Lookup Dialog (shown below).
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Taxpayer Lookup Dialog

Taxpayer Lookup Dialog
Account Ability maintains two distinct centralized lists of taxpayer demographics — one for information returns
and one for W2s. In order to access a list, double-click the recipient's id number field. These lists are
automatically updated with each new return that you add or existing return that you edit. Once a taxpayer has
been added to a list you can easily (i) select the taxpayer when adding future returns, (ii) delete the
taxpayer from the list, or (iii) update the taxpayer's WH (withholding) indicator — If a taxpayer's WH
indicator is checked, Account Ability will remind you to withhold state tax when entering Forms 1099-MISC or
W-2G for that taxpayer.

 Notes

· The centralized list of taxpayers is not automatically updated when importing returns.
· Deleting a taxpayer from the centralized list of taxpayers will not affect any existing returns for that

taxpayer.
· The WH indicator is specific to information returns only.

· Selecting a taxpayer while in browse mode ( ) automatically triggers insert mode.

Prior to entering insert mode, the tax form is initialized and the TIN Type set to its default. The insert icon, ,
displayed next to the year on the tax form informs you that Account Ability is now in the add (insert) mode. As
you complete each field, depress the TAB or ENTER key to move to the next designated tab stop .

 Notes

· The ENTER key functions as the TAB key if, and only if, Enter Key = Tab Key is set (see Desktop
Preferences ).

· Taxpayer id numbers are qualified by the TIN Type. Consequently, Account Ability does not accept dashes
when entering social security numbers (SSN) or employer identification numbers (EIN). 

· Account Ability accepts multiple returns with the same taxpayer id (SSN, EIN).

To save the return,

· Click  on the recipient toolbar, or
· Select Save from the File menu, or
· Depress the F8 key on your keyboard.

If there are no errors, the return is saved. If Automatic Insert Mode is set (see Desktop Preferences ),
Account Ability initializes the tax form and resumes the insert mode.

To cancel the return,

· Click  on the recipient toolbar, or
· Select Cancel from the File menu, or
· Depress either CTRL+F8 or the Esc key on your keyboard.

After canceling a return, Account Ability resumes the browse mode ( ).
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 Notes

· If Automatic Insert Mode is set, the insert icon appears as  on the recipient toolbar and the recipient
menu.

· If you require help on a specific field, depress the F1 key while in the field. If help is available, it will be
displayed in a popup help window specific to the field.

· If you need to enter a foreign address, check the Foreign address indicator.

6.4.2 Browsing Returns

When you are not editing or adding returns, you will most likely be in browse mode. Browse mode is indicated

by the browse icon ( ) appearing next to the reporting year on the tax form. While in browse mode, use
either the browse buttons on the recipient toolbar  or the browse keys on your keyboard to navigate among
recipient records. 

Browse Buttons

 moves to the first record in the record set

 moves to the previous record in the record set

 moves to the next record in the record set

 moves to the last record in the record set

Browse Keys

Home: moves to the first record in the record set
Page Up: moves to the previous record in the record set
Page Down: moves to the next record in the record set
End: moves to the last record in the record set

The recipient record that is currently displayed is referred to as the active recipient. If you need to change the

active recipient, just type your changes. The browse icon ( ) changes to an edit icon ( ), indicating edit

mode. To save your changes, select Save from the File menu, click  on the recipient toolbar, depress the
F8 key, or browse to another record. To cancel your changes, select Cancel from the File menu, click  on
the recipient toolbar, or depress either CTRL+F8 or Esc.

 Notes

· To begin browsing from a specific record, first Locate  the record then use either the browse buttons or
browse keys discussed above.

· To resume the browse mode from the insert ( ) mode or edit ( ) mode, either save or cancel your
changes.

6.4.3 Locating Returns

 File  Locate

The Locate Dialog automatically selects recipient returns by incrementally searching the index you specify for
the characters you type. To open the Locate Dialog,

· Click  on the recipient toolbar, or
· Select Locate from the File menu, or
· Depress the F5 key.

The Search By drop down box contains a list of indexes specific to the form on which you are working. The
Search Characters field is where you type the characters to be searched.
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The Locate Dialog

In the illustration above, Search Characters A13 match the first 3 characters of Search By index Account
for PAYER 2. Consequently, the return for PAYER 2 is automatically selected.

Regardless of how you close the dialog (OK, Cancel, Edit), the selected record is displayed on the selected
tax form. Closing the dialog using the Edit button, however, conveniently positions the cursor to the first
numeric field for editing.

Setting (Resetting) Indicators
In addition to locating returns, the Locate Dialog can be used to set (reset) any of the indicators (Void,
Efile, 1096, Print, etc.). Simply double-click directly on the indicator to be set (reset).

 Notes

· The Locate Dialog cannot be displayed while adding or editing returns.
· Use the ID # index to locate returns appearing in warning logs generated by the Verify selection on the

Tools menu.
· Indicators appearing in the Locate Dialog vary with the selected tax form.

6.4.4 Editing Returns

Account Ability includes an automatic edit mode that facilitates the job of editing recipient returns. Just browse

 to the return to be edited and type your changes. The browse icon ( ) changes to an edit icon ( ),
indicating edit mode.

To save your changes,

· Click  on the recipient toolbar, or
· Select Save from the File menu, or
· Depress the F8 key, or
· Browse to another record.

To cancel your changes, 

· Click  on the recipient toolbar, or
· Select Cancel from the File menu, or 
· Depress either CTRL+F8 or Esc

 Tip

· If you need to edit the same field for many returns, browse to the first return, make your changes and
depress the Page Down key. Account Ability saves your changes and moves to the next record, leaving the
cursor positioned in the field being edited.
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6.4.5 Sorting Returns

 File  Order By

A form's Order By menu can be used to arrange its returns in a specific order. The ordering you select is
referred to as the current ordering. Every time you change a form's current ordering, Account Ability
rearranges its returns in a relative record set.

The current ordering always applies when printing, browsing, preparing electronic transmittal files, generating
reports, etc. Shown below is the Order By menu for Form 1098. The check in front of Account indicates that
the current ordering is the payer's Account number.

1098 Order By Menu

Each return you enter is assigned a unique ID number (ID #). Select Natural Order to arrange your file by ID
#.

6.4.6 Deleting Returns

 File  Delete

· Locate  the return to be deleted.
· Click  on the recipient toolbar, or
· Select Delete from the File menu, or
· Depress CTRL+Del

If Confirm All Deletions is turned on (see Desktop Preferences ), Account Ability prompts you to confirm the
deletion. Otherwise, the return is deleted without confirmation.

 Notes

· If Confirm All Deletions is turned off, the delete icon appears as 
· In order to delete a return, you must be in browse mode.

 Tip

· If you need to delete many returns, turning off Confirm All Deletions expedites the task by suppressing the
confirmation dialog.

6.4.7 User Information

 File  User Information

The User Information dialog displays,

· The date, time, and user who created the return,
· The date, time, and user who last edited the return.

To display User Information,

· Select User Information from the File menu, or
· Depress CTRL+U
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6.4.8 Control Totals

 File  Totals

Control totals can be displayed at any time by

· Clicking  on the recipient toolbar, or
· Selecting Totals from the File menu, or
· Depressing the F9 key.

Account Ability displays the total forms tallied, a hash (or control) total of taxpayer identification numbers, and
the resulting totals for each box of the active tax form. 

 Notes

· You can only total a file while in browse mode.
· Returns marked VOID are not totaled.

6.5 Importing & Exporting

Account Ability is capable of importing Information Returns and Annual Wage Reports from

· ASCII Text Files
· IRS Transmittals
· SSA Transmittals
· A 2011 Database
· Another Client

For assistance with importing ASCII Text Files, refer to The Import Mapping Utility on the Module menu.

For assistance with exporting, see the section Exporting Returns .

6.5.1 Importing ASCII Text Files

American Standard Code for Information Interchange (ASCII) is a character-encoding scheme based on the
ordering of the English alphabet. ASCII codes represent text in computers, communications equipment, and
other devices that use text. Most modern character-encoding schemes, which support many more characters
than did the original, are based on ASCII. ASCII text files generally refer to plain text files that contain no
special formatting (e.g. bold, underscores, tabs, etc.). 

A delimited text file is an ASCII text file in which each line of text is a record, and the fields within each record
are separated by a known character referred to as the delimiter. Non-numeric fields, such as names,
addresses, cities, etc., are called string fields. String fields are generally enclosed within quotations (""),
especially when the delimiter is part of the field. Delimited text files are easily created by Microsoft Excel®,
Microsoft Access®, PeachTree® Accounting, SQL, and most database applications.

Example
"John Doe","2101 East 51st Street","New York","NY","10001","",10002.34,0

represents an acceptable record from a comma delimited text file whose schema is 
 
"Name"
"Street Address"
"City"
"State"
"Zip Code"
"Account Number"
Rents
Royalties

Since John Doe does not have an "Account Number", a null string ("") is inserted as a place holder for this
string field. The place holder for numeric fields is zero, as is illustrated for Royalties.

Account Ability can import Information Returns (1098, 1099, 3921, 3922, 5498, W2G), Annual Wage Reports
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(W2, W2C), and Client records from comma delimited text files that conform to a pre-defined record layout,
known as a schema. With the aid of The Import Mapping Utility, comma, tab, and pipe (|) delimited text
files are easily converted to text files that are compatible with this schema. The Import Mapping Utility can
be found on the Module menu.

 Related Topics

· Importing Client Text Files
· Importing Returns
· Current Year File Schema
· Import Capabilities

6.5.1.1 Selecting an Import File

 File  Import  ASCII Text File

Account Ability can import Information Returns and Annual Wage Reports from comma delimited ASCII Text
Files that conform to a pre-defined record layout ("Schema"). 

To import a text file, 

· Open the tax form to be used .
· From the File menu, select Import  ASCII Text File
· Locate the text file to import and click Open.

All schema contain a Client ID field which can be used as a filter when importing various client returns from a
single text file. A filtered text file is a text file that contains at least one record with a specified Client ID. If
Account Ability detects that your import file is filtered, the Filtering Option Dialog  is displayed.

 Notes

· When importing Information Returns, this selection is disabled for Correction Clients.
· Use the selection Sample ASCII Import Files on the Help menu to display a list of sample text files that

Account Ability can import. These files are included as a reference for those users interested in building an
interface between Account Ability and their host application.

· The Import Mapping Utility (see the Module menu) facilitates the job of mapping delimited text files to
text files that Account Ability can import.

 Related Topics

· Current Year File Schema
· Importing ASCII Text Files - An Overview

6.5.1.2 The Filtering Option Dialog

An import file that contains at least one record with a specified Client ID is said to be filtered. If Account
Ability detects that your import file is filtered, the Filtering Option Dialog is displayed.

The Filtering Option Dialog
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The Filtering Option Dialog shows the total number of records in the file as well as the total number of
filtered records. If filtering is enabled only the filtered records are imported. Otherwise, all records are
imported.

6.5.1.3 The Rollup Option Dialog

If you have several distinct text files or spreadsheets which, when combined, result in a single return for each 
recipient, you will find the Rollup option quite beneficial. As long as each record of each file contains a primary
key field, such as a taxpayer identification number, Account Ability can roll up these files over multiple import
sessions.

The Rollup Option Dialog

The Rollup Option dialog contains three options (see Note below),

· Append: Each record of your source file is appended to the end of file regardless of the existence of
another return with the same primary key.

· Rollup (or Append): The primary key field of each record is compared with those already on file. If a
match occurs, the existing record's currency information is accumulated (rolled up). Otherwise, the record is
appended to the end of file.

· Erase existing records: If checked, existing records are first erased ensuring that the current import
session begins with an empty table.

 When working with Form 1098-C, Contributions of Motor Vehicles, Boats, and Airplanes, the Rollup Options
read

1098-C Rollup Option Dialog

· Append ALL VINs: Each record of your source file is appended to the end of file regardless of the existence
of another return with the same VIN.

· Append UNIQUE VINs: The VIN of each record is compared with those already on file. If a match occurs,
the record is not imported. Otherwise, the record is appended to the end of the file.

 Related Topics

· Multiple Import Session Strategy

 Notes

· Information returns require the recipient's taxpayer identification number as the primary key when rolling
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up.
· W2 source records generally require the employee's social security number as the primary key when rolling

up. However, if the social security number is not available, additional searches are attempted first on the
employee Control number, then on the employee's first name, middle initial and last name. If all of these
attempts fail to produce a match, the record is automatically appended to the end of file.

· Form W2C does not support the rollup option.
· The option to Erase existing records raises the exception "Unable to erase existing records" if the form is

active on another workstation in a network environment or the current user does not have sufficient
permissions.

· Recipient email addresses can be rolled up. During a rollup session Account Ability will compare the
currently recorded email address with the value in your text file. If they are different, and the email address
in your text file is not null, it will replace the currently recorded email address.

6.5.1.4 Multiple Import Session Strategy

Although some applications, such as Intuit's QuickBooks®, are deficient in that they cannot export a
recipient's entire 1099 or W2 to a single file, they can export the information to distinct text files and
spreadsheets which, when rolled up over multiple import sessions, result in a single return for each recipient.
The following strategy is suggested when rolling up multiple import sessions.

1. Create a text file or spreadsheet that contains the name, address, and taxpayer identification number for
each recipient to be imported.

2. Using the text file created in step (1) as the source file in The Import Mapping Utility, create and
execute a mapping in order to produce a destination file that Account Ability can import.

3. Import the destination file created in step (2) using the Append option. This will result in a file of null
returns containing recipient names, addresses, and taxpayer identification numbers.

4. Create a text file that contains annual totals (or detailed transaction information) for each recipient
imported in step (3) above. Ensure that each record of this file contains a primary key field (such as the
taxpayer identification number) for the recipient.

5. Using the text file created in step (4) as the source file in The Import Mapping Utility, create and
execute a mapping in order to produce a destination file that Account Ability can import.

6. Import the destination file created in step (5) using the Rollup (or Append) option. Each existing
recipient's record will be updated accordingly.

Repeat steps (4), (5) and (6) as often as needed until all recipient returns are complete.

6.5.2 Importing IRS Transmittals

 File  Import  IRSTAX File

An IRS transmittal is a file of Information Returns that conforms with IRS Pub. 1220. Account Ability uses the
terms IRSTAX and IRS transmittal synonymously.

To import an IRS transmittal,

· Open the Information Return to be used
· From the File menu, select Import  IRSTAX File
· Locate the transmittal file to import and click Open.

Account Ability will search the transmittal for all returns associated with the selected client. If none are found,
an appropriate error message will be displayed. Otherwise, the IRSTAX Import Options dialog is displayed,
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IRSTAX Import Options

Total "A" Records
Indicates the number of times this client occurs within the selected transmittal file.

Total "B" Records
Indicates the total returns to be imported.

Include payment amount information
If checked, payment amount information will be imported with each recipient. Otherwise, only names,
addresses, and taxpayer identification numbers are imported. 

 Related Topics

· Importing SSA Transmittals

 Notes

· This selection is disabled for Correction Clients.
· Account Ability can import 2011 and 2012 IRS transmittals. 
· If you are sure your IRS transmittal contains returns for the selected client but Account Ability complains it

cannot find any, download and run the RL750 utility and try again.
· If you make a mistake and need to import again, use the Kill This File selection on the Tools menu to first

delete any existing returns.

6.5.3 Importing SSA Transmittals

 File  Import  W2REPORT (EFW2) File

An SSA transmittal is a file of Annual Wage Reports conforming with Social Security Administration
EFW2/EFW2C specifications. Account Ability uses the terms W2REPORT and SSA transmittal synonymously.

To import an SSA transmittal,

· Open Form W2
· From the File menu, select Import  W2REPORT (EFW2) File
· Locate the transmittal file to import and click Open.

Account Ability will search the transmittal for all employees associated with the selected client. If none are
found, an appropriate error message will be displayed. Otherwise, the W2REPORT Import Options dialog is
displayed,
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W2REPORT (EFW2) Import Options

Total "RE" Records
Indicates the number of times this client occurs within the selected transmittal file.

Total "RW" Records
Indicates the total employees to be imported.

Include wages and withholding
If checked, wages and withholding will be imported with each employee. Otherwise, only employee names,
addresses, social security numbers, etc. are imported. 

 Related Topics

· Importing IRS Transmittals

 Notes

· Account Ability does not import EFW2C transmittals (Form W2C).
· Account Ability can import 2011 and 2012 SSA transmittals. 
· If you are sure your SSA transmittal contains employees for the selected client but Account Ability complains

it cannot find any, download and run the RL512 utility and try again. If the problem persists, your
transmittal may have been prepared for a common paymaster or agent (see the Agent Information Group
on the W-2 Setup  page of the client's master record).

· If you make a mistake and need to import again, use the Kill This File selection on the Tools menu to first
delete any existing returns.

6.5.4 Roll Forward Prior Year

 File  Import  Roll Forward Prior Year

Account Ability maintains each of your client's Information Returns and Annual Wage Reports in distinct annual
databases that can be rolled forward from year-to-year without any loss of prior year integrity. 

To roll forward 2011 returns,

· Open the tax form to be used
· From the File menu, select Import  Roll Forward Prior Year

If you used Account Ability in 2011, and have not changed the selected client's Client ID, the 2011 returns will
be located. If the 2011 returns are not found, use the Active Forms List  to ensure the selected client had
returns in 2011.

The Roll Forward dialog, shown below, provides some useful options.
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Roll Forward Dialog for Form 1098

Exclude returns marked VOID
If checked, 2011 returns marked VOID are not rolled forward. Otherwise, VOID returns are rolled forward with
their VOID indicator cleared.

Initialize for a new calendar year
If checked, only recipient demographics (e.g. name, address, taxpayer identification, account number, etc.)
are rolled forward. All other information (e.g. currency fields, date fields, description fields, etc.) are initialized
for a new reporting year. If you used the 2011 version of Account Ability to begin entering 2012 returns, do
not check this option.

 Note

· If you do not check this option, the Correction and Printed indicators are also rolled forward.

1098 ONLY - Erase information in box 5
If checked, all of the information in box 5 for reporting year 2011 is erased and not rolled forward.

1098-T ONLY - Check if you have changed your reporting method for 2012
Check this box if your institution has changed its method of reporting (payments received or amounts billed).
You have changed your method if the method you are using for 2012 is different than the method you used for
2011.

 Notes

· This selection is disabled if the prior year database, 2011DATA, is not found. Although Account Ability
attempts to locate the prior year database automatically, you can always locate it yourself from the Help
menu using selection Locate Prior Year Database (2011).

· Rolling forward to 2012 will not alter your 2011 returns.
· If you make a mistake and need to roll forward again, use the Kill This File selection on the Tools menu to

first delete any existing returns.
· If you used the 2011 version of Account Ability to begin entering 2012 returns, do not initialize for a new

calendar year.
· Account Ability does not roll forward prior year returns automatically since many users prefer not to do so.

That is, they issue new returns each year (e.g. 1099-S, W2G, 1099-C, etc.) for each of their existing clients.
That is why Account Ability leaves the roll-forward option up to the user.

· If you have many clients and desire to roll-forward all of their returns at one time, think about what you are
trying to do for a moment. Since you will have to return to each client's returns in order to edit, add, delete,
print, and possibly file them electronically, why not roll them forward as you work on the client for the first
time this year?
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6.5.5 Import Another Client's Returns

 File  Import  Another Client's Returns

To import another client's returns,

· Open the tax form to be used
· From the File menu, select Import  Another Client's Returns

Select the client to be used from the client list and click OK. All of the selected client's returns, except VOIDS,
will be appended to the existing client's returns.

 Notes

· When importing Information Returns, this selection is disabled for Correction Clients.
· This feature has some useful applications, which are listed in the online FAQ and TIPS Knowledge Base.

Search the TIPS Knowledge Base
Search Frequently Asked Questions

6.5.6 Exporting Returns

 File  Export

The Export Options dialog exports recipient returns to comma delimited text files compatible with Microsoft
Excel® and most mail merge applications. Only the fields you select are exported, in the order you specify.

To open the Export Options dialog 

· You must be in browse mode.
· From the File menu, select Export.

The Export Options dialog will be displayed,

Export Options Dialog (for Form 1098)

The Available Fields List contains all fields (specific to the selected tax form) that can be exported; The
Selected Fields List contains all fields that will be exported. Fields can be moved between lists either by
double-clicking or by using the selection icons, 

 Moves the selected field to available.
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 Moves all selected fields to available.

 Moves the available field to selected.

 Moves all available fields to selected.

Selected fields can be ordered using the arrow icons,

 Moves the selected field up one spot.

 Moves the selected field down one spot.

After selecting and ordering the fields to be exported, click the Begin button. You will be prompted to select a
file name to contain the export.

 Notes

· If the Include descriptive header record indicator is checked, the first record of the resultant export file
will be a comma separated list of the selected field names.

· The Client ID and Form ID are automatically appended to each record exported.
· Returns marked VOID are not exported unless Include Voids is checked.
· By default, the export file is saved in a sub-folder of Account Ability named EXPORT.

6.6 Reports

6.6.1 Control Report

 File  Control Report

A Control Report contains all of the information entered for the active information return or annual wage
report.

To print (or preview) a Control Report,

· Click  on the recipient toolbar, or
· Select Control Report from the File menu, or
· Depress CTRL+P

You will have the option to either preview or print this report.

 Note

· The Order By menu determines how this report is sorted.

6.6.2 Register Listing

 File  Register Listing

A Register Listing contains only general demographics information.

To print (or preview) a Register Listing,

· Select Register Listing from the File menu, or
· Depress CTRL+R keys on your keyboard.

You will have the option to either preview or print this report.

 Note

· The Order By menu determines how this report is sorted.
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6.6.3 Missing TIN Register

 File  Missing TIN Register

The Missing TIN Register contains all recipients whose TIN has not been specified.

To print (or preview) the Missing TIN Register,

· Select Missing TIN Register from the File menu, or
· Depress CTRL+T keys on your keyboard.

You will have the option to either preview or print this report.

 Note

· The Order By menu determines how this report is sorted.

6.6.4 TIN Matching Error Register

 File  TIN Matching Error Register

The TIN Matching Error Register contains all recipients whose TIN does not match IRS name/TIN database.
This register is updated every time you post a BULKTIN Response report . 

To print (or preview) the TIN Matching Error Register,

· Select TIN Matching Error Register from the File menu, or
· Depress CTRL+ALT+T keys on your keyboard.

You will have the option to either preview or print this report.

 Note

· The Order By menu determines how this report is sorted.

6.6.5 State & Local Wage Report

 File  State & Local Wage Report

The State and Local Wage Report is specific to Forms W2 and W2c. This report provides a detailed listing of
state and local wages and withholding. To print (or preview) this report,

· Select State & Local Wage Report from the File menu, or
· Depress CTRL+S

You will have the option to either preview or print this report.

 Note

· The option to suppress details is specific to Form W2.

79



Working with Tax Forms 65

© 2012 IDMS, All rights reserved.

6.7 Security

6.7.1 Setting Passwords

 Security  Set Password

To assign a password to a client's returns, select Set Password from the Security menu. The Enter
Password Dialog, shown below, will be displayed.

Enter Password Dialog

After entering and verifying the password, click OK. If successful, the following dialog will be displayed.

 Notes

· Passwords are case sensitive.
· If you forget your password, contact technical support  for assistance.

6.7.2 Clearing Passwords

 Security  Clear Password

To erase a previously stored password, select Clear Password from the Security menu. You will have to
know the client's master password , if one was set. Otherwise, you will be prompted to confirm your
intentions,
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For example, assume you have set the master password for client IDMS. Any user requesting to clear the
password for any of the returns belonging to IDMS would have to first get past the dialog

That is, the user would have to know the master password  in order to continue.

6.7.3 Locking/Unlocking Forms

After final submission to IRS, forms can be locked for review only.

Locking Forms

Unlocked forms display the open lock icon ( ).
Click the icon to lock the form.

If a master password  has been set, you will be prompted to enter it.
Otherwise, the form is locked immediately.

Unlocking Forms

Locked forms display the closed lock icon ( ).
Click the icon to unlock the form.

If a master password  has been set, you will be prompted to enter it.
Otherwise, the form is unlocked immediately.

6.8 Printing Forms

6.8.1 Print Options

 File  Print Forms
 File  Print Forms for Selected Record

Account Ability prints recipient returns on laser, inkjet, and generic dot matrix printers. If you have a PDF
writer installed on your computer and your printer preferences  are configured for GDI, printed output can
also be saved to portable document (PDF) files. Unlike most PDF writers, Account Ability offers a free PDF
writer, IDMSPDF, capable of writing each recipient's return to a distinct PDF file. IDMSPDF can be downloaded
from the Account Ability website, www.idmsinc.com.

The printed and summary indicators (1096, W-3, W-3C), displayed at the top of each tax form, determine
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whether or not the recipient's return should be printed or included in the summary transmittal, respectively.
These indicators are defined below.

· Printed: If this indicator is checked, the recipient's return is considered already printed and is not printed
again. After printing all recipients, it is suggested that you set all of the printed indicators in order to avoid
duplicate printing.

· 1096: Account Ability automatically totals each file of Information Returns when preparing summary
transmittal 1096. If checked, the recipient's return is included in the total; Otherwise, it is excluded.

· W-3: Account Ability automatically totals each file of W2s when preparing summary transmittal W3. If
checked, the recipient's return is included in the total; Otherwise, it is excluded.

· W-3C: Account Ability automatically totals each file of W2Cs when preparing summary transmittal W3C. If
checked, the recipient's return is included in the total; Otherwise, it is excluded.

The Tools menu contains selections for global manipulation of these indicators.

To print forms for all returns,

· Click  on the recipient toolbar, or
· Select Print Forms from the File menu, or
· Depress CTRL+F

To print forms for the active recipient only, 

· Select Print Forms for Selected Record  from the File menu, or
· Depress CTRL+ALT+F

Depending upon how you configured your printer preferences , one of three dialogs will be displayed,

· PCL Print Options
· Dot Matrix Print Options
· GDI Print Options

 Notes

· You can only print forms from browse  mode.
· Returns marked VOID are not printed.
· For information on how to reprint one or more tax forms, see the Tips Knowledge Base.
· See the section Printing to PDF Files  for instructions on printing to distinct PDF files.

6.8.2 Options Dialogs

6.8.2.1 PCL Print Options

Target Printer Group
This group indicates the PCL printer to be used. The AUTO OFF feature will appear flashing if, and only if, the
Automatic Release of Laser Forms indicator is not set (see Printer Preferences ).

PCL Target Printer Group

Designated Forms Group
This group displays a list of forms specific to the tax form on which you are working. For illustrative purposes,
those specific to Form W2 are shown below. Notice that some forms are displayed in red, others in black.
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Designated Forms for Form W2

Preprinted Forms
Forms displayed in red require a preprinted form. Account Ability prepares preprinted forms by filling in the
boxes. As shown in the illustration above, PCL printer configurations require preprinted forms when printing
Copy A of Form W2 and Summary W3. The Account Ability Forms Division (see below) carries a complete line
of preprinted laser forms and companion envelopes.

 Notes

· The number pair appearing in blue indicates the row and column laser offsets  to be used.
· When printing on preprinted W-2 forms other than Copy A, treat them as if they are Copy A. Account Ability

will not know the difference.
· Account Ability does not support preprinted forms W-2C, W-3C (CORRECTIONS). These forms, when printed

on ordinary copy paper by Account Ability, have been approved by the Social Security Administration. You
will find a link to an approval notice on our website, www.idmsinc.com. 

· The Fed Copy A indicator, when displayed, must be used to distinguish between preprinted Copy A and
non-Copy A forms. The Fed Copy A indicator generally appears when printing Information Returns.

Blank Generic Forms
Forms displayed in black require ordinary copy paper or blank perforated forms. Account Ability prepares
these forms by drawing the form and filling in the boxes simultaneously. Although ordinary copy paper can be
used, blank perforated paper is suggested. The Account Ability Forms Division (see below) carries a complete
line of blank perforated laser forms and companion envelopes.

INSTRUCTIONS Indicator
When checked, forms are drawn one recipient per page followed by Instructions. This option is not available on
forms with a massive amount of instructions (e.g. W-2, 1099-R). If instructions are desired, purchase forms
with instructions preprinted on the back. The Account Ability Forms Division (see below) carries a complete line
of blank perforated laser forms with backer instructions and companion envelopes.

PREPRINTED Indicator for 4-UP Forms W-2
When checked, a preprinted 4-UP form is assumed. In the illustration above, a preprinted 4-UP W2 is
assumed. The Account Ability Forms Division (see below) carries a complete line of preprinted laser forms. In
particular, part numbers L4UP and L4BL are designed specifically for 4-UP forms W-2.

Summary (1096, W-3, W-3C)
Check this box if you want to print the designated summary transmittal. Only those returns whose summary
indicator is checked will be included. The Account Ability Forms Division (see below) carries a complete line of
preprinted laser transmittals. See part numbers L1096 (L1096500) and LW3 (LW3500). Transmittal W-3C is
always drawn on blank paper.

Mark as Printed
If checked, Account Ability automatically sets the printed indicator on each return printed.

Truncate Social Security Numbers
If checked, social security numbers are truncated (masked) pursuant to IRS Notice 2011-38. Only paper payee
statements for Information Returns (1098, 1099, 3921, 3922, 5498, W2G) are eligible for the program. The
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first five digits of the social security number will be replaced with an X. Thus, according to the notice, the
sample Social Security number 123-45-6789 would be replaced with XXX-XX-6789.

 Notes

· Truncating does not apply to Copy A returns.
· Truncating does not apply to Employer Identification Numbers (EINs).
· Truncating does not apply to forms W-2 and W-2C. Social security numbers are blanked out instead.

Account Ability Forms Division
The Account Ability Forms Division carries a complete line of laser forms and companion envelopes. For a list
of available forms and envelopes, click the Order Forms panel displayed on the status bar  or call
1-888-IDMSINC (436-7462).

Printing Forms
Place a check mark in front of each form to print and click the Print button at the bottom of the PCL Print
Options dialog.
 

 Notes

· VOIDS are not printed.
· PCL Print Options are displayed if, and only if, you are using the PCL printer configuration.

6.8.2.2 Dot Matrix Print Options

Target Printer Group
This group indicates the dot matrix printer to be used (see Printer Preferences ).

Dot Matrix Target Printer Group

Designated Forms Group
This group displays the form on which you are working and its summary transmittal. For illustrative purposes,
a 2-Wide Form W2 with a column offset of 3 is shown (see Printer Preferences ). The Account Ability Forms
Division (see below) carries a complete line of continuous forms and companion envelopes.

Dot Matrix Form W2

Alignment Indicator
Check this box if you need assistance aligning forms prior to printing. Each requested alignment will print a
single alignment form rather than a single page. Consequently, you should always do enough alignments to
ensure printing begins at the top of a new page.

Mark as Printed
If checked, Account Ability automatically sets the printed indicator on each return printed. 
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Account Ability Forms Division
The Account Ability Forms Division carries a complete line of continuous forms and companion envelopes. For a
list of available forms and envelopes, click the Order Forms panel displayed on the status bar  or call
1-888-IDMSINC (436-7462).

Printing Forms
Place a check mark in front of the form to print and click the Print button at the bottom of the Dot Matrix
Print Options dialog. If an alignment is requested, a single alignment page will be printed.
 

 Notes

· VOIDS are not printed.
· Ensure that your printer is configured for an HMI of 10 char/inch and a VMI of 6 lines/inch.
· Continuous forms must be printed using the Dot Matrix Configuration.
· Dot Matrix Print Options are displayed if, and only if, you are using the Dot Matrix printer configuration.

6.8.2.3 GDI Print Options

Target Printer Group
This group indicates the GDI printer to be used. The NO CLIPPING feature appears flashing if, and only if,
the Adjust Output When Clipped indicator is set. If batch printing is enabled, the batch page size is
displayed along with the Time Delay Control; Otherwise, a NOT BATCHED message is displayed. For more
information on clipping and batch printing, see Printer Preferences . 

GDI Target Printer Group

 Notes

· If you are using Account Ability's free PDF Writer, IDMSPDF, refer to the section Printing to PDF Files  for
instructions on How to Print to Distinct PDF Files.

· IDMSPDF can be downloaded from the Account Ability website, www.idmsinc.com.

Designated Forms Group
This group displays a list of forms specific to the tax form on which you are working. For illustrative purposes,
those specific to Form W2 are shown below. Notice that some forms are displayed in red, others in black.

Designated Forms for Form W2

Preprinted Forms
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Forms displayed in red require a preprinted form. Account Ability prepares preprinted forms by filling in the
boxes. As shown in the illustration above, preprinted forms are assumed when printing Copy A of Form W2
and Summary W3. The Account Ability Forms Division (see below) carries a complete line of preprinted laser
forms and companion envelopes.

 Notes

· The number pair appearing in blue indicates the row and column GDI offsets  to be used.
· Account Ability does not support preprinted forms W-2C (CORRECTIONS).
· The GDI configuration does not support preprinted 4-UP forms (use the PCL configuration instead).
· The Fed Copy A indicator, when displayed, must be used to distinguish between preprinted Copy A and

non-Copy A forms.

Blank Generic Forms
Forms displayed in black require ordinary copy paper or blank perforated forms. Account Ability prepares
these forms by drawing the form and filling in the boxes simultaneously. Although ordinary copy paper can be
used, blank perforated paper is suggested. The Account Ability Forms Division (see below) carries a complete
line of blank perforated laser forms and companion envelopes.

INSTRUCTIONS Indicator
When checked, forms are drawn one recipient per page followed by Instructions. The Account Ability Forms
Division (see below) carries a complete line of blank perforated laser forms with or without backer instructions.

Pressure Seal Indicator
When checked, a pressure seal form is assumed. The Account Ability Forms Division (see below) carries a
complete line of pressure seal forms and hardware.

 Note

· When printing Form 1099-LTC on pressure seal forms, you will be prompted to specify the addressee — the
Policyholder or the Insured.

SSA Approved Indicator
If checked, Copy A returns are drawn in black and white on ordinary copy paper. Otherwise, preprinted red
scannable Copy A returns are required. Social Security Administration will accept black and white Annual Wage
Reports prepared by Account Ability. Since IRS does not accept computer drawn Copy A Information Returns,
the SSA Approved indicator is only available for forms Annual Wage Reports.

Summary (1096, W3, W3C)
Check this box if you want to print the designated summary transmittal. The Account Ability Forms Division
(see below) carries a complete line of preprinted laser transmittals. See part numbers L1096 and LW3.
Transmittal W3C is always drawn on blank paper.

Info (Information) Copy Indicator
If this indicator is checked when requesting Form 1096 an Information Copy of Form 1096 is drawn in black
and white on ordinary copy paper. Otherwise, a preprinted form is required. The Information Copy is generally
for the filer's use and should not be filed with IRS. IRS only accepts Form 1096 on preprinted red scannable
forms. The Account Ability Forms Division (see below) carries preprinted Form 1096 in standard packs (L1096)
and bulk packs (L1096500).

Mark as Printed
If checked, Account Ability automatically sets the printed indicator on each return printed. 

Truncate Social Security Numbers
If checked, social security numbers are truncated (masked) pursuant to IRS Notice 2011-38. Only paper payee
statements for Information Returns (1098, 1099, 3921, 3922, 5498, W2G) are eligible for the program. The
first five digits of the social security number will be replaced with an X. Thus, according to the notice, the
sample Social Security number 123-45-6789 would be replaced with XXX-XX-6789.

 Notes

· Truncating does not apply to Copy A returns.
· Truncating does not apply to Employer Identification Numbers (EINs).
· Truncating does not apply to forms W-2 and W-2C. Social security numbers are blanked out instead.
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Account Ability Forms Division
The Account Ability Forms Division carries a complete line of laser forms and companion envelopes. For a list
of available forms and envelopes, click the Order Forms panel displayed on the status bar  or call
1-888-IDMSINC (436-7462).

Printing Forms
Place a check mark in front of each form to print and click the Print button at the bottom of the GDI Print
Options dialog. If you are using the free IDMSPDF writer, the next section describes how to print recipient's
returns to distinct PDF files.

 Notes

· VOIDS are not printed.
· GDI Print Options are displayed if, and only if, you are using the Windows GDI printer configuration.

6.8.3 Printing to PDF Files

If you have a PDF writer installed on your computer and your printer preferences  are configured for GDI,
printed output can be saved to a PDF file. In general, recipient returns are saved to a single PDF file. If you
are using the free IDMSPDF writer, recipient returns can also be written to distinct PDF files.

 To install the free IDMSPDF writer, follow the (case sensitive) link
http://www.idmsinc.com/download/idmspdf/AccountAbilityPDFWriter.exe

How to Print to Distinct PDF Files
If you are using the IDMSPDF writer, the following guide must be followed in order to print the specified forms
to distinct PDF files. If you do not follow this guide, all output will be written to a single PDF file. 

· 1098 — Select Copy B; Select INSTRUCTIONS.
· 1098-C — Select Copy C; Select INSTRUCTIONS.
· 1098-E — Select Copy B; Select INSTRUCTIONS.
· 1098-T — Select Copy B; Select INSTRUCTIONS.
· 1099-A — Select Copy B; Select INSTRUCTIONS.
· 1099-B — Select Copy B; Select INSTRUCTIONS.
· 1099-C — Select Copy B; Select INSTRUCTIONS.
· 1099-CAP — Select Copy B; Select INSTRUCTIONS.
· 1099-DIV — Select Copy B; Select INSTRUCTIONS.
· 1099-G — Select Copy B; Select INSTRUCTIONS.
· 1099-H — Select Copy B; Select INSTRUCTIONS.
· 1099-INT — Select Copy B; Select INSTRUCTIONS.
· 1099-K — Select Copy B; Select INSTRUCTIONS.
· 1099-LTC — Select Copy B; Select INSTRUCTIONS.
· 1099-MISC — Select Copy B; Select INSTRUCTIONS.
· 1099-OID — Select Copy B; Select INSTRUCTIONS.
· 1099-PATR — Select Copy B; Select INSTRUCTIONS.
· 1099-Q — Select Copy B; Select INSTRUCTIONS.
· 1099-R — Select 4-UP (Copies B-C-2-2).
· 1099-S — Select Copy B; Select INSTRUCTIONS.
· 1099-SA — Select Copy B; Select INSTRUCTIONS.
· 3921 — Select Aggregate Forms 3921 or Copy B with INSTRUCTIONS.
· 3922 — Select Aggregate Forms 3922 or Copy B with INSTRUCTIONS.
· 5498 — Select Copy B; Select INSTRUCTIONS.
· 5498-ESA — Select Copy B; Select INSTRUCTIONS.
· 5498-SA — Select Copy B; Select INSTRUCTIONS.
· W-2G — Select Copy B-C-2 Combination.
· W-2 — Select 4-UP (Copies B-C-2-2).
· W-2C — Select Copy C.

 Notes

· If you customized  Form 1099-MISC to suppress instructions, select Copy B; Select Copy 2.
· Aggregate forms 3921 are written to files named 3921-EMPLOYEE NAME-SYSTEM ID.pdf
· Aggregate forms 3921 are always secured by the employee's social security number.
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· Aggregate forms 3922 are written to files named 3922-EMPLOYEE NAME-SYSTEM ID.pdf
· Aggregate forms 3922 are always secured by the employee's social security number.

When the proper combination has been selected, Account Ability displays the following message

Copies can be written to distinct PDFs

Click the Print button to display the PDF Output Options  dialog.

6.8.4 PDF Output Options

When printing to distinct PDF files, Account Ability needs to know how to name each recipient's PDF file and
whether or not to consolidate all of a specific recipient's returns to the same PDF. This is the purpose of the
PDF Output Options dialog,

PDF Output Options

Select a File Naming Convention
The file naming convention informs Account Ability of how to name each recipient's PDF file. Files can be
named by Taxpayer identification number (TIN), Recipient account number, or Employee control number. If a
naming convention is disabled, it is not supported by the selected form.

 Note

· If a naming convention fails, the recipient's return is appended to the file UNKNOWN.pdf

Write all of a recipient's returns to a single PDF
There may be occasion when a recipient has more than one return recorded. For example, if an employee
worked in more than 2 reporting states there would be at least two W2s on file since each W2 can
accommodate at most 2 reporting states. If this box is checked, all returns for the same recipient are written
to the same PDF file. Otherwise, only the last return on file for each recipient is written to the PDF file.

Write the entire file to a single PDF
If this box is checked, all returns are written to a single PDF rather than distinct PDFs. Generally, you would
want to leave this box unchecked.

 Note

· This option supersedes all other options.

Selecting a destination folder
After selecting your options, click the OK button to continue. You will then be prompted for the destination
folder. A default folder will be suggested.
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6.9 Specific Tasks

6.9.1 1098 Apportionment

 File  Apportion

If you prepare 1098 returns for cooperatives, Account Ability can compute each payer's share of the total
mortage interest received, amortization, real estate taxes, and capital reserve fund entered on the 1098 setup
page  of the client master. 

The 1098 user interface contains fields for

Period Occupied
Enter the period of occupancy for the payer during the 2012 calendar year.

Shares
Enter the total number of shares allocated to the apartment.

Percentage of Maintenance Paid
Enter the payer's percentage of the total maintenance paid for 2012. Generally this will be 100%. However, if
multiple payers share the apartment, a separate 1098 reflecting each payer's period of occupancy and
percentage of maintenance paid must be entered.

After completing the above for each payer, select Apportion from the File menu of Form 1098 and confirm.

Confirm Apportionment

 Notes

· You cannot apportion prior year 1098s.
· Apportionment is not available for correction clients.
· Always verify the results using the Totals selection on the File menu of Form 1098. These totals should

agree with the information entered on the 1098 Setup Page  of the client master.
· You can apportion as often as needed until the totals are exact.

6.9.2 1098-T Instructions

 File  Student Instructions

If your printer is configured as a GDI printer (see Printers  on the Preferences  menu), the File menu of
Form 1098-T includes the selection

Student Instructions

These additional instructions are automatically appended to IRS Instructions for Student when printing
Student's Copy B of Form 1098-T with instructions.
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 Note

· Additional instructions do not print on pressure seal forms.

6.9.3 1099-MISC Customization

 File  Customize

If your printer is configured as a GDI printer (see Printers  on the Preferences  menu), the File menu of
Form 1099-MISC includes the selection

 Customize

Customization includes the option to Suppress Instructions when printing Form 1099-MISC with
instructions. If instructions are suppressed, Account Ability prints Recipient Copy 2 in place of the
instructions when printing 1-UP Recipient Copy B and Pressure Seal Forms.

 Note

· Customization is client specific.

6.9.4 1099-R Instructions

 File  Print Instructions

If your printer is configured as a PCL printer (see Printers  on the Preferences  menu), the File menu of
Form 1099-R includes the selection

Print Instructions

Instructions for Form 1099-R are included in PDF format. Users desiring to print recipient copies on blank copy
paper without backer instructions can use this selection to optionally print a single page of instructions to be
mailed to each recipient.

6.9.5 W-2 Compute FICA

 File  Compute FICA

If the Compute FICA indicator is checked on the W2 Setup  page of a client's master record, the Compute
FICA button, 

is enabled on that client's Form W2. If enabled, Account Ability can compute Social Security Wages, Social
Security Tax, Medicare Wages, and Medicare Tax based upon the Gross Wages, Social Security Tips, and
Deferred Compensation you enter on each employee's Form W2.

To compute an employee's FICA, complete the applicable boxes on an employee's W2. Then,

· Click the Compute FICA button, or
· Depress the F6 key on your keyboard, or
· Select Compute FICA from the File menu.

 Notes

· FICA computations can be changed by the user.
· Does not apply to Railroad and MQGE employment.
· The Tools menu contains a selection to Compute FICA for All Employees.
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6.9.6 Third-Party Sick Pay Reporting

In order to report third-party sick pay, you must complete the client's Third-Party Sick Pay Information
group. This group can be found on the W2 Setup  page of the client's master record. 

 
Next, prepare a W2 pursuant to instructions found in Publication 15A making sure to set the 3rd-Party
indicator. Finally, either print or electronically file the return.

7 IRS TIN Matching

 Module  TIN Matching

The Internal Revenue Service’s Taxpayer Identification Number (TIN) Matching Program was established for
payers of Form 1099 income subject to the backup withholding provisions of section 3406(a)(1)(A) and (B) of
the Internal Revenue Code. Prior to filing an information return, a Program participant may check the TIN
furnished by the payee against the name/TIN combination contained in the Internal Revenue Service database
maintained for the Program.

The IRS Office of Electronic Tax Administration offers two TIN Matching options:

Interactive TIN Matching - This process accepts up to 25 input name/TIN combination requests online.
Results are returned to the user in real time.

Bulk TIN Matching - This process accepts electronic transmittal files containing up to 100,000 name/TIN
combinations for matching.

The Interactive and Bulk TIN Matching Programs are established under the authority of Revenue Procedure
2003-9. Revenue Procedure 2003-9 expands the IRS authority provided under Revenue Procedure 97-31, to
allow the on-line matching of taxpayer identifying information as provided by payers of income reported on
Forms 1099-B, DIV, INT, MISC, OID and PATR.

IRS e-Services is a suite of web-based products that will allow tax professionals and payers to conduct
business with the IRS electronically. IRS e-Services include Interactive TIN Matching and Bulk TIN Matching.
Only approved IRS business partners are eligible to participate in e-Services, so you will have to register.

 Note

· If you are planning to use Account Ability's optional TIN Matching outsourcing service, you do not have to
register for e-Services.

Account Ability creates BULKTIN transmittals pursuant to IRS Pub. 2108A. A single transmittal can contain
name/TIN combinations for the entire family of information returns. Transmittal files are ultimately submitted
to IRS e-Services or outsourced to Account Ability's optional TIN Matching service. In either case, the results
are generally returned to you within 48 hours in the form of a response file, which Account Ability uses to print
Forms W-9 and/or W-9S.

 Notes

· Transmittal files that contain duplicate TINs run the risk of being locked out of IRS e-Services for 96 hours.
Consequently, Account Ability automatically filters duplicate TINs from each transmittal. TINs that have been
filtered are automatically included in subsequent transmittals, provided you post the results of each
response file you receive. Posting is discussed in the topic Response File Processing .

· Recipients who have not supplied a TIN are termed missing TIN recipients. You should make every effort to
get a missing TIN recipient's taxpayer identification, else run the risk of an IRS penalty. To this end, Account
Ability creates a Missing TIN Response File, which can be used to print W-9s for missing TIN recipients. For
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details, see the topic How to Create a Missing TIN Response File .

 Related Topics

· IRS e-Services Registration
· How to Create a BULKTIN Transmittal File
· Submitting and Renaming Transmittals
· Response File Processing
· How to Create a Missing TIN Response File

7.1 Registration - IRS e-Services

 Module  TIN Matching  IRS e-Services Login/Registration

IRS e-Services is a suite of web-based products that will allow tax professionals and payers to conduct
business with the IRS electronically. IRS e-Services include Interactive TIN Matching and Bulk TIN Matching.
Only approved IRS business partners are eligible to participate in e-Services, so you will have to register.

From the Module menu,

· Select TIN Matching
· Select IRS e-Services Login/Registration

This will launch the e-services - Online Tools for Tax Professionals website.

Follow the link to Registration Services.

 Note

· If you are planning to use Account Ability's optional TIN Matching outsourcing service, you do not have to
register for e-Services. For pricing, see the Order link at www.idmsinc.com. 

7.2 How to Create a BULKTIN Transmittal

 Module  TIN Matching  Create a BULKTIN Transmittal

Bulk TIN Matching requests are always made via a BULKTIN transmittal file compliant with IRS Pub. 2108A.
BULKTIN transmittals are ultimately submitted to IRS e-Services or Account Ability's optional TIN Matching
Service. Results are generally returned within 48 hours.

From the Module menu,

· Select TIN Matching
· Select Create a BULKTIN Transmittal

BULKTIN transmittal files can be created for specific clients or all clients, as seen below.

If a Specific Client ID is requested, a transmittal named BULKTIN_Client ID.txt, containing only the
requested client's recipients, is created. Otherwise, a transmittal named BULKTIN.txt, containing recipients
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for all clients is created.

 Notes

· The Specific Client ID always defaults to the selected client (See the Active Client Panel of the Status Bar
).

· If the Active Client Panel displays NO CLIENT, the Specific Client ID defaults to the client who is
highlighted on the Client Management  window.

· In order to generate a transmittal for all clients, erase the Specific Client ID field.
· If desired, you can override the Specific Client ID by typing in another Client ID.

 In the illustration above, a transmittal named BULKTIN_IDMS.txt will be created. This transmittal will
contain only those recipients of information returns for client IDMS who require testing. 

Transmittal files contain only those recipients of information returns whose name/TIN combination is queued
as ready for testing (see the TIN Status Panel in The Status Bar  section of The User Interface).

 Note

· In an effort to avoid a possible 96 hour lockout by IRS e-Services, only unique TINs are written to each
transmittal file you create. Duplicates not tested are automatically tested in subsequent transmittals.

7.3 Submitting and Renaming Transmittals

BULKTIN transmittals are submitted to IRS e-Services or Account Ability's optional TIN Matching Service.

 Submitting to IRS e-Services

 Module  TIN Matching  IRS e-Services Login/Registration

From the Module menu,

· Select TIN Matching
· Select IRS e-Services Login/Registration
· Login with your username and password
· Select your organization
· Select TIN Matching from the Services Menu
· Select Bulk TIN Session
· Locate the BULKTIN transmittal you created
· Click the Upload button
· Copy the session tracking number to the clipboard or jot it down
· Proceed to Renaming a BULKTIN Transmittal below.

 Submitting to Account Ability's TIN Matching Service

 Module  Outsourcing Services  TIN Matching Service

From the Module menu,

· Select Outsourcing Services
· Select TIN Matching Service
· Locate the BULKTIN transmittal file to be processed
· Your transmittal will be encrypted and attached to an email
· Enter your TIN Matching Order Number
· Send the email.

Your encrypted transmittal file will be emailed to Account Ability's TIN Matching Service. An email containing
the session tracking number will be sent to you within 24 hours.

 Renaming a BULKTIN Transmittal

Each transmittal you submit is assigned a session tracking number. Always rename your transmittal to the
session tracking number using the following instructions.

 Module  TIN Matching  Rename a BULKTIN Transmittal
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From the Module menu,

· Select TIN Matching
· Select Rename a BULKTIN Transmittal
· Locate the BULKTIN transmittal to be renamed
· Click Open
· Enter the session tracking number
· Click OK

 Notes

· TIN Matching results are generally returned to you within 48 hours in a response file.
· You will receive an email either from IRS e-Services or Account Ability's TIN Matching Service once your

response file is ready.
· The topic on Response File Processing  explains how to pick up and process your response file.

7.4 Response File Processing

 Module  TIN Matching  Open a BULKTIN / Missing TIN Response File

The TIN Matching Program provides a numerical response code (0-8) for each matching request you make.

 Response Codes

· 0 - Name/TIN combination matches IRS records 
· 1 - Missing TIN or TIN not 9-digit numeric 
· 2 - TIN not currently issued
· 3 - Name/TIN combination does NOT match IRS records
· 4 - Invalid request
· 5 - Duplicate request
· 6 - Matched on SSN, when the TIN type is unknown, and a matching TIN and name control is found only on

the NAP DM1 database
· 7 - Matched on EIN, when the TIN type is unknown, and a matching TIN and name control is found only on

the EIN N/C database
· 8 - Matched on SSN and EIN, when the TIN type is unknown, and a matching TIN and name control is found

on both the NAP DM1 and the EIN N/C databases

The Interactive TIN Matching Program  returns response codes in real time. The Bulk TIN Matching Program
 returns response codes via a results file.

 Notes

· If you submitted a BULKTIN transmittal directly to IRS e-Services, the response file will be sent to a secure
mailbox at e-Services and you will be notified via an email with a subject line similar to "TIN Bulk Mail
tracking number is tracking number". You will have 30 days to access and download the results.

· If you submitted a BULKTIN transmittal to Account Ability's TIN Matching Service, the response file will be
encrypted and sent to you via email.

· Missing TIN Response files are ready for processing immediately.
· Due to privacy issues, IRS will not divulge an entity’s name or TIN.

 Opening a Response File

From the Module menu,

· Select TIN Matching
· Select Open a BULKTIN/Missing TIN Response File
· Select a response file... Select BULKTIN Results or Missing TINs from the Files of type drop down list
· Locate the Response file
· Click Open

Account Ability will verify and display the results contained within the response file you select.
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 Notes

· BULKTIN Test Results Only - If there are many '0' responses (matches IRS records) you could choose to
suppress them from the display by checking the Suppress IRS Matches indicator.

To print a Response File Processing Report, click the Print button.

To print W-9/W-9S forms, click the Print W-9 button. W-9s can be printed for the selected recipient only or
any combination of response codes. As each W-9/W-9S form is printed, the date printed is automatically
recorded on each recipient's return. W-9/W-9S forms have been designed to fit window envelope DW19W
when folded on the designated 'fold' lines.

 Notes

· W-9s do not print for response code '0' (matches IRS records).
· To print a W-9 for a specific recipient, select the recipient before clicking the Print W-9 button.
· The user interface for information returns contains a W-9 button that will display the date printed.
· Envelope DW19W is available from The Account Ability Forms Division.
· W-9S forms are only printed for recipients of Form 1098-E, 1098-T.

Posting Results. BULKTIN response files should always be posted to Account Ability's database. Posting
ensures that a recipient's name/TIN combination is not tested again unless a change has been made to his
name or TIN. You cannot post results for Missing TIN Response files.

7.5 How to Create a Missing TIN Response File

 Module  TIN Matching  Create a Missing TIN Response File

What is a Missing TIN Response File?
A Missing TIN Response File is similar to an IRS BULKTIN response file in theory, however, it is created by
Account Ability, not by IRS e-Services. Its sole purpose is to enable filers to track and print W-9s for missing
TIN recipients. Unlike BULKTIN transmittals, Missing TIN Response Files are not submitted to IRS e-Services.
Instead, they are processed immediately by Account Ability's Response File Processing  module.

From the Module menu,

· Select TIN Matching
· Select Create a Missing TIN Response File

Missing TIN Response Files can be created for specific clients or all clients, as seen below.

If a Specific Client ID is requested, a response file named MISSING_TIN_Client ID.txt, containing only
the requested client's missing TIN recipients, is created. Otherwise, a response file named MISSING_TIN.txt,
containing missing TIN recipients for all clients is created. In either case, the resulting response file can be
processed immediately using the Response File Processing  module.

 In the illustration above, a response file named MISSING_TIN_IDMS.txt will be created. This response
file will contain all missing TIN recipients for client IDMS.
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8 Electronic Reporting

Any corporation, partnership, employer, estate, and/or trust, who is required to file 250 or more information
returns or annual wage reports for any calendar year, must file electronically or risk possible penalties.
Information returns are uploaded to the IRS FIRE System  in standard ASCII coded transmittal files that
comply with IRS Pub. 1220; Annual wage reports are uploaded to SSA Business Services Online (BSO)  in
standard ASCII coded transmittal files that comply with SSA EFW2 (for forms W2) and/or SSA EFW2C (for
forms W2C).

Account Ability Creates Your Transmittal Files
Account Ability's electronic reporting system appends each filer's database of information returns and/or
annual wage reports to 2012 compliant transmittal files. Information returns are always appended to file
specification IRSTAX; Annual wage reports are always appended to file specification W2REPORT.

· IRSTAX: A single IRSTAX transmittal can contain any combination of information returns for any number of
filers. By default, IRSTAX is automatically created in the folder IRS, which is located within Account Ability's
installation folder. IRSTAX transmittals are ultimately filed with The IRS FIRE System, either directly or
via Account Ability's EFILE Service.

· W2REPORT (W2): A single W2REPORT transmittal can contain W2s for any number of employers. By
default, W2REPORT is automatically created in the folder SSA_W2, which is located within Account Ability's
installation folder. W2REPORT transmittals are ultimately filed with The Social Security Administration's
Business Services Online (BSO), either directly or via Account Ability's EFILE Service.

· W2REPORT (W2C): A single W2REPORT transmittal can contain W2 CORRECTIONS for any number of
employers. By default, W2REPORT is automatically created in the folder SSA_W2C, which is located within
Account Ability's installation folder. W2REPORT transmittals are ultimately filed with The Social Security
Administration's Business Services Online (BSO), either directly or via Account Ability's EFILE
Service.

 Transmittal files are not transmitted to IRS or SSA automatically. It is your responsibility to upload each
transmittal file to the appropriate reporting authority or Account Ability's EFILE Service. In the latter case,
IDMS Account Ability will submit your transmittal file and notify you of the results via email. See the section
on Submitting and Renaming Transmittals  for instructions.

 Notes

· Transmittal files are automatically created.
· Transmittal files are appended until renamed or deleted.
· W2REPORT (W2) transmittals should be verified using SSA AccuWage.
· W2REPORT (W2C) transmittals should be verified using SSA AccuW2C.
· IRSTAX transmittals can be viewed using the selection Prepare IRS Transmittal 4804 on the Module

menu. Although IRS no longer requires Form 4804, many users still use Form 4804 for their own internal
records.

· If necessary, IRSTAX and W2REPORT transmittals can be deleted and recreated from scratch. This is
discussed in the sections that follow.

8.1 Creating and Appending Transmittals

 File  Electronic Reporting

Account Ability includes three Electronic Reporting Options dialogs designed for the purpose of creating,
appending and maintaining electronic transmittal files. Options dialogs comply with IRS Pub. 1220, SSA EFW2
and SSA EFW2C specifications for reporting year 2012.

To open an Electronic Reporting Options dialog,

· Click  on the recipient toolbar, or
· Select Electronic Reporting from the File menu, or
· Depress CTRL+E

The options dialog you see depends on the active tax form.
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Information Returns
Annual Wage Reports (W2)
Annual Wage Reports (W2C)

 Notes

· The Efile Indicator appearing at the top of a tax form specifies whether or not the return will be written to
a transmittal file. If checked, the return is written, otherwise, it is not. The Tools menu includes selections
for managing the Efile indicator on a global scale.

· VOIDS are never reported.

8.2 Information Returns

In addition to appending information returns to the IRSTAX transmittal file, the Electronic Reporting
Options dialog for information returns provides functionality to Edit Transmitter and Correspondence
information, specify a new destination folder for the IRSTAX transmittal file, create Test files and exclude
specific states and/or foreign entities.

Electronic Reporting Options for Information Returns

· Either of the Edit buttons will launch the Transmitter  information dialog.
· Use the select folder button  if you want to change the destination folder for the IRSTAX transmittal file.
· Use the explore button  if you want to explore the selected folder possibly to rename or delete the existing

IRSTAX transmittal file.
· The Year displays the reporting year of the IRSTAX transmittal, if any. Otherwise, it displays the reporting

year to be used from the client's master record. Reporting years other than 2012 are displayed in red. 
· In order to create a test file for IRS, check the Test File indicator.
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· Use the States to Exclude check list if you need to exclude specific reporting states from this reporting
session. In the illustration above, reporting states Montana and North Carolina will be excluded.

· Use the Exclude foreign entities check box if you need to exclude foreign recipients.
· The Type of File group designates the type of returns to be appended. Correction returns must be

appended in two steps - First the Correction (G) transactions, next the CORR(C) transactions.

In order to append the IRSTAX file,

· Click the OK button.
· If an IRSTAX transmittal file does not exist, it will be created.
· If an IRSTAX transmittal already exists, you will have the option to append it.

Continue in this manner until you have appended all information returns to be reported. Your completed
IRSTAX transmittal file will then be ready for submission to The IRS FIRE System or Account Ability's EFILE
Service.

8.3 Annual Wage Reports - W2

In addition to appending W2s to the W2REPORT transmittal file, the Electronic Reporting Options dialog
provides the functionality to Edit Submitter and Correspondence information, specify a new destination folder
for the W2REPORT transmittal file and exclude specific states and/or foreign entities.

 This dialog also offers SPECIFIC STATE WAGE REPORTING. Many states have adopted the EFW2
specification for electronic reporting. If yours is among the list, you can use this dialog to prepare an annual
wage report that can be transmitted directly to your state electronically. The next section  discusses specific
state reporting in more detail.

Electronic Reporting Options for Annual Wage Reports - W2

· Either of the Edit buttons will launch the Submitter  information dialog.
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· Use the select folder button  if you want to change the destination folder for the W2REPORT transmittal
file.

· Use the explore button  if you want to explore the selected folder possibly to rename or delete the existing
W2REPORT transmittal file.

· Use the States to Exclude check list if you need to exclude specific reporting states from this reporting
session. In the illustration above, reporting states Illinois, Indiana, and Kansas will be excluded.

· Use the Exclude foreign entities check box if you need to exclude foreign employees.
· If you are resubmitting previously reported returns, complete the Resubmittal Information group. You

should only resubmit returns when advised to do so.

In order to append the W2REPORT file,

· Click the OK button.
· If a W2REPORT transmittal file does not exist, it will be created.
· If a W2REPORT transmittal already exists, you will have the option to append it.

Continue in this manner until you have appended all W2s to be reported. Your completed W2REPORT file will
then be ready for submission to The Social Security Administration's Business Services Online (BSO) or
Account Ability's EFILE Service.

8.4 State Wage Reporting - W2

Many states have adopted the EFW2 (formerly MMREF-1) specification for electronic reporting. If your state is
among the list, the Electronic Reporting Options dialog can prepare an annual wage report that you can
submit to your state's Dept. of Revenue. It is essential that each reporting state's State ID is properly
recorded in the client's State ID  table. Refer to your state's Dept. of Revenue procedures for proper
formatting of State ID numbers. For your convenience, Dept. of Revenue links are available on
www.idmsinc.com (see Resources).

In order to create an annual wage report for a specific state, right-click directly on the state in the States to
Exclude check list. From the popup menu, select "XX" State Reporting, where XX is the desired state. In the
illustration below, specific state reporting is desired for the state of Maryland ("MD").

Specific State Reporting (Maryland)

Account Ability will check (exclude) all states in the list, with the exception of "XX". Click the OK button to
prepare the desired transmittal. Unlike federal reports, which are named W2REPORT by default, state wage
reports are named W2REPORT_CLIENTID.XX, where CLIENTID is the selected client's Client ID, and XX is
the reporting state. If the file W2REPORT_CLIENTID.XX already exists, it will be recreated. Refer to the
selected state's Dept. of Revenue procedures for proper delivery of this file.

Specific State Reporting Parameters
Some states require specific information to be reported, which is not available on Form W-2. Account Ability
includes some optional parameters that you can specify in order to fulfill these requirements. These optional
parameters can be entered on any line in box 14.

Kansas
KPER - Employee contribution to KPERS, KP & F and judges (e.g. KPER 12345.67) 

Kentucky
KRED - Kentucky Rural Economic Development Assistance (e.g. KRED 12345.67) 
KJDA - Kentucky Jobs Development Act (e.g. KJDA 12345.67) 
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KIRA - Kentucky Industrial Revitalization Authority (e.g. KIRA 12345.67) 
KIDA - Kentucky Industrial Revitalization Authority (e.g. KIDA 12345.67) 

Maine
MPER - Maine Public Employees Retirement System contribution (e.g. MPER 12345.67)

Maryland
WHAL - Number of exemptions claimed on Form W-4 (e.g. WHAL 3)
Account Ability includes an interface to required Form MW508.

New Jersey
PP# - Private Disability Plan No. (e.g. PP# Plan ID) 
UI/HC/WF - Combined UI, Health Care, Workforce (e.g. UI/HC/WF 12345.67) 
DI - Disability Insurance Withheld (e.g. DI 12345.67) 

 Notes

· If the employer has a private Family Leave Insurance plan approved by the New Jersey Dept. of Labor,
enter the plan ID (FLI PPI #) as the State ID Number for State Code 99 on the employer's State ID
Page .

· Family Leave Insurance Withheld must be entered in the State Income Tax field on Form W2 for State
Code 99.

New York
SUIWG - SUI Wages for Quarter 4 (e.g. SUIWG 1234.56) 

Oregon
DE - Date First Employed (e.g. DE 12/10/2004) 
DS - Date of Separation (e.g. DS 03/14/2010)

 Notes

· State wage report files cannot be validated using AccuWage.
· State wage report files cannot be appended since many states demand one employer per transmittal.
· Account Ability's EFILE Service cannot submit state wage reporting files. You will need to contact the state's

Dept. of Revenue for instructions.

8.5 Annual Wage Reports - W2C

In addition to appending W2 CORRECTIONS (W2C) to the W2REPORT transmittal file, the Electronic Reporting
Options dialog provides the functionality to Edit Submitter and Correspondence information, specify a new
destination folder for the W2REPORT transmittal file and exclude specific states and/or foreign entities.
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Electronic Reporting Options for Annual Wage Reports - W2C

· Either of the Edit buttons will launch the Submitter  information dialog.
· Use the select folder button  if you want to change the destination folder for the W2REPORT transmittal

file.
· Use the explore button  if you want to explore the selected folder possibly to rename or delete the existing

W2REPORT transmittal file.
· Use the States to Exclude check list if you need to exclude specific reporting states from this reporting

session.
· Use the Exclude foreign entities check box if you need to exclude foreign employees. In the illustration

above, foreign employees will be excluded.
· If you are resubmitting previously reported returns, complete the Resubmittal Information group. You

should only resubmit returns when advised to do so.

In order to append the W2REPORT file,

· Click the OK button.
· If a W2REPORT transmittal file does not exist, it will be created.
· If a W2REPORT transmittal already exists, you will have the option to append it.

Continue in this manner until you have appended all W2Cs to be reported. Your completed W2REPORT file will
then be ready for submission to The Social Security Administration's Business Services Online (BSO) or
Account Ability's EFILE Service.

8.6 Submitting and Renaming Transmittals

Submitting to Account Ability's EFILE Service
If you ordered Account Ability's EFILE Service, select the appropriate service to be used from the 
Outsourcing Services selection on the Module menu. Your transmittal file will be zipped, encrypted and
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attached to an email destined for Account Ability's EFILE dept. You must ensure that your email software
allows encrypted zip file attachments. 

Upon receipt of your transmittal, Account Ability's EFILE dept. will send you an acknowledgement:

Account Ability's EFILE Dept. has received your email. Please allow 48 hours for your transmittal file to be
submitted to the appropriate reporting agency (IRS FIRE, SSA BSO). After your transmittal file has been
submitted, a confirmation will be sent to you via email. This confirmation will contain further instructions you
must follow for renaming your TRANSMITTAL file.

Once your transmittal file has been submitted, you will receive a confirmation email. This confirmation will
contain instructions for renaming your transmittal file. In an effort to synchronize each of your transmittal files
with those received by Account Ability's EFILE Service, always rename your transmittal file as per these
instructions.

If you did not order Account Ability's EFILE Service, you will have to submit each of your transmittals yourself. 
Annual Wage Reports (W2REPORT) are submitted via SSA Business Services Online (SSA BSO);
Information Returns (IRSTAX) are submitted via The IRS FIRE System.

 Submitting and Renaming a W2REPORT Transmittal
The SSA Business Services Online selection on the Module menu should be used to upload W2REPORT
transmittal files to SSA BSO. Prior to accessing SSA BSO, Account Ability copies the path to W2REPORT to the
Windows Clipboard.

When prompted for the file to upload,

· Click the Browse button
· Paste the path to the File name field
· Click the Open button
· Locate the W2REPORT transmittal
· Upload the W2REPORT transmittal.

 Note

· If the paste function fails to work, copy the path to W2REPORT to the clipboard again by selecting Copy a
Transmittal's Path from the Module menu or Integrated Browser .

 Rename Your W2REPORT Transmittal File

 Module  Rename a W2REPORT (W2) File
 Module  Rename a W2REPORT (W2C) File

The Social Security Administration's Business Services Online (BSO) assigns each file you upload a 6 character 
Wage File Identifier (WFID). In an effort to synchronize the files you transmit with those received by SSA
BSO, always rename your W2REPORT file to the WFID. The Module menu contains a selection for renaming
your W2REPORT transmittal file.

 Renaming each transmittal file minimizes the risk of duplicate filing.

Submitting and Renaming an IRSTAX Transmittal
The IRS FIRE System selection on the Module menu should be used to upload IRSTAX transmittal files. Prior
to accessing The IRS FIRE System, Account Ability copies the path to IRSTAX to the Windows Clipboard.

When prompted for the file to upload,

· Click the Browse button
· Paste the path to the File name field
· Click the Open button
· Upload the IRSTAX transmittal.

 Note

· If the paste function fails to work, copy the path to IRSTAX to the clipboard again by selecting Copy a
Transmittal's Path from the Module menu or Integrated Browser .
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 Rename Your IRSTAX Transmittal File

 Module  Rename an IRSTAX File

The IRS FIRE System renames each Original, Correction, Replacement, and TEST file it receives to ORIG.
TCCNO.xxxx, CORR.TCCNO.xxxx, REPL.TCCNO.xxxx, and TEST.TCCNO.xxxx, respectively, where xxxx is a
numeric counter ranging between 0001 and 9999. The confirmation page displayed by IRS FIRE clearly
contains this information. In an effort to synchronize the files you transmit with those received by IRS FIRE, 
always rename your IRSTAX file to the file name assigned by IRS FIRE. The Module menu contains a selection
for renaming your IRSTAX transmittal file.

 Renaming each transmittal file minimizes the risk of duplicate filing.

9 The FileCabinet System

The Account Ability FileCabinet™ system is analogous to a virtual file cabinet consisting of an unlimited
number of electronic drawers (eDrawers), each belonging to a specific client/filer and capable of holding an
unlimited number of electronic returns (eStatements). Information returns and annual wage reports printed to
the FileCabinet™ Printer are automatically converted to encrypted eStatements before being electronically
delivered (eDelivered) to a filer’s eDrawer.

Account Ability's FileCabinet™ is analogous to a virtual file cabinet

The Account Ability FileCabinet™ system (AAFC) consists of the following components,

· FileCabinet™ Printer Software - Install this printer on your computer just as you would install any other
printer. 

· One eDrawer - Each filer will require his own eDrawer. If you need to order additional eDrawers, order
item # AAFCD on our order page (www.idmsinc.com/Order.php)

· 1000 eStatements - This will allow you to eDeliver a maximum of 1000 eStatements to any combination
of eDrawers in your FileCabinet™. If you need to order additional eStatements, order item # AAFCS on our
order page (www.idmsinc.com/Order.php)

· One User License - If you need to install the FileCabinet™ Printer software on additional computers,
order item # AAFCU on our order page (www.idmsinc.com/Order.php). Each AAFCU adds one additional
user to your existing license. 

· Three Years of Hosting - The Account Ability FileCabinet™ is hosted on the web for a minimum of
three years at www.myPDFTaxForms.com

The Account Ability FileCabinet™ web storage and eDelivery system is housed in a secure SAS70 Level II
data center. Each PDF eStatement is stored in encrypted format, meaning that only the recipient can open the
file by typing in their taxpayer ID.

9.1 Printing to The FileCabinet

The Account Ability FileCabinet™ harnesses the industrial strength forms processing power of Account
Ability to seamlessly create and eDeliver your eStatements. Simply print your returns to the Account Ability
FileCabinet™ Printer and watch as your returns are instantly converted to encrypted PDFs and uploaded to
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the Account Ability FileCabinet™ Outbox for processing.

Account Ability FileCabinet™ Outbox

Only the following copies can be eDelivered: 

· 1098 — Select Copy B or Pressure Seal.
· 1098-E — Select Copy B or Pressure Seal.
· 1098-T — Select Copy B or Pressure Seal.
· 1099-A — Select Copy B or Pressure Seal.
· 1099-B — Select Copy B or Pressure Seal.
· 1099-C — Select Copy B or Pressure Seal.
· 1099-CAP — Select Copy B or Pressure Seal.
· 1099-DIV — Select Copy B or Pressure Seal.
· 1099-G — Select Copy B or Pressure Seal.
· 1099-H — Select Copy B or Pressure Seal.
· 1099-INT — Select Copy B or Pressure Seal.
· 1099-K — Select Copy B or Pressure Seal.
· 1099-LTC — Select Copy B or Pressure Seal.
· 1099-MISC — Select Copy B or Pressure Seal.
· 1099-OID — Select Copy B or Pressure Seal.
· 1099-PATR — Select Copy B or Pressure Seal.
· 1099-Q — Select Copy B or Pressure Seal.
· 1099-R — Select 4-UP (Copies B-C-2-2).
· 1099-S — Select Copy B or Pressure Seal.
· 1099-SA — Select Copy B or Pressure Seal.
· 3921 — Select Copy B or Pressure Seal.
· 3922 — Select Copy B or Pressure Seal.
· 5498 — Select Copy B or Pressure Seal.
· 5498-ESA — Select Copy B or Pressure Seal.
· 5498-SA — Select Copy B or Pressure Seal.
· W-2 — Select 4-UP (Copies B-C-2-2).
· W-2C — Select Copy B, Copy C, or Copy 2.

If the Auto-send mode is turned on, eStatements are automatically eDelivered from the outbox to each filer’s
eDrawer in the FileCabinet™. Otherwise, the option to review or delete eStatements prior to eDelivery can be
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found on the File menu.

 Notes

· The FileCabinet™ Printer requires the GDI Configuration.
· Double-click the Auto-send panel to toggle Auto-send on/off.
· To administer your FileCabinet™, select MyPDFTaxForms.com on the menu.
· Form 1098-C may not be furnished electronically, as per IRS.
· Form W-2G may not be furnished electronically, as per IRS.

10 Correction Processing

10.1 Correcting Information Returns

If you filed an Information Return with the IRS and later discover you made an error on it, you must

· Correct it as soon as possible.
· Furnish statements to recipients showing the correction.
· File the correction with the IRS. 

 The steps required to correct an error depend upon the type of error.

 If you discover an error in reporting the payer (not recipient) name and/or TIN

Write a letter to IRS/IRB containing the following information:

· The name and address of the payer
· Type of error (including the incorrect payer name/TIN that was reported)
· Tax year
· Payer TIN
· Transmitter Control Code (TCC), if applicable
· Type of return
· Number of payees
· Filing method (paper, electronic)
· Was Federal income tax withheld?

Send the letter to

Internal Revenue Service
Information Returns Branch
230 Murall Drive, Mail Stop 4360
Kearneysville, WV 25430

IRS will contact you with further instructions.

 If you discover duplicate reporting or that a large percentage of incorrect information has been
filed.

· Contact the Information Reporting Customer Service Site at 1-866-455-7438 for further instructions.

 If you discover an Error Type 1

Also referred to as a 1-Transaction error, Error Type 1 includes

· Incorrect money amounts
· Incorrect distribution code(s)
· Incorrect check boxes
· A return was filed when one should not have been filed.

1-Transaction errors require only one return to make the correction. Account Ability uses the CORR(G) check
box to indicate a 1-Transaction correction.

 If you discover an Error Type 2
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Also referred to as a 2-Transaction error, Error Type 2 includes

· No payee TIN (SSN, EIN, QI-EIN, ITIN) 
· Incorrect payee TIN
· Incorrect payee name
· Incorrect payee address
· Wrong type of return was filed.

2-Transaction errors require two returns to make the correction, an IDENTIFYING return and a
CORRECTING return. Account Ability uses the CORR(G) and CORR(C) check boxes to indicate the
IDENTIFYING and CORRECTING returns, respectively. The IDENTIFYING transaction is simply the original
return with the CORR(G) indicator checked and all dollar amounts set to ZERO. When IRS receives the
IDENTIFYING and CORRECTING returns, the original is matched against the IDENTIFYING return and replaced
with the CORRECTING return.

 Correcting Returns with Account Ability

Account Ability facilitates the correction process by maintaining each filer's corrected returns under a distinct
Client ID. When the Corrected Returns Only indicator, located on the General page of the client's master, is
checked, the client is regarded as a correction client and all of the client's Information Returns are regarded
as correction returns. The CORR(G) and CORR(C) check boxes will be enabled if, and only if, the client is a
correction client.

1) Create a Correction Client

· Select Client (Filer) Management from the Module menu.
· Locate the client whose returns are to be corrected.
· Select Copy from the Client Task Bar or context menu.
· Reply Yes when asked if you are creating a correction client,

· Enter a Client ID to be used for the correction client.
· Click OK.
· The Client ID should be displayed in green.

2) Open the Returns to be Corrected

· Double-click the correction client's Client ID.
· Open the Information Return to be corrected.

3) Enter your Corrections

· Select New from the File menu.
· Check the CORR(G) check box.
· Determine if you will require a 1-Transaction or 2-Transaction correction.

· Click the Locator icon  displayed directly after the TIN Type field in order to locate the return to be
corrected. This step can be skipped if you are keying in correction returns from scratch.

· After locating the return, click either the 1-Transaction button or 2-Transaction button.
· If 1-Transaction is clicked, the original return is displayed with the CORR(G) indicator checked. Simply enter

and save your corrections.
· If 2-Transaction is clicked, the IDENTIFYING transaction is automatically created. Next, a CORRECTING

transaction is created but not posted. Enter and save your changes on the CORRECTING transaction.
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After all corrections have been entered, print and mail all recipient copies, even the IDENTIFYING returns. If
you plan to file with IRS on paper, print Copy A for IRS and Form 1096. If you plan to file electronically, you
must append the CORR(G) and CORR(C) transactions to the IRSTAX file in two steps - first the CORR(G)
transactions, next the CORR(C) transactions. The resultant IRSTAX file should be transmitted to The IRS FIRE
System as a Correction file.

 Notes

· When printed, the CORRECTION box at the top of each correction return is checked for CORR(G) returns
only.

· If you are creating a file of CORR(C) transactions only, skip the second step in (3) above.
· Correction returns can be keyed in directly (that is, the originals need not be recorded).
· All of the above steps do not apply to Annual Wage Reports.
· The Tools menu contains selections for manipulating the CORR(G) and CORR(C) indicators on a global

scale.
· The Tips Knowledge Base contains detailed instructions on how to import correction returns from a text file.
· For more information on correcting returns, select User Manuals & IRS Instructions  IRS General

Instructions from the Help menu.

10.2 Correcting Annual Wage Reports

You correct Annual Wage Reports using Form W-2C. Form W-2C must be used to correct both W-2s and
W-2Cs. In order to open Form W-2C, 
 

 Select the Client

· Select Client (Filer) Management from the Module menu.
· Locate the client to be used.
· Double-click the client, or
· Click the Select button, or
· Choose Select Client on the context menu.

If successful, the selected Client ID is displayed in the Active Client Panel of the status bar  and you are
prompted for the tax form to open. Open form W-2C from the menu of available forms.

 Note

· Although W-2Cs can be keyed in from scratch, having the original W-2s on file greatly facilitates the task.

11 Backup & Restore Utility

11.1 Backup Utility

 Module Menu  Backup/Restore

The Backup Utility saves your entire 2012 database to the destination you specify. Backups are written to a
compressed file referred to as an archive.

To display the Backup Utility,

· Close all open tax forms.
· Select Backup/Restore from the Module menu.

Backup Title
Account Ability generates a default title for the backup. Although it is not suggested, you can alter the backup
title.

Destination
The destination, which specifies where to write the archive, consists of a local, or network, drive and folder.
The format button is enabled if, and only if, the destination drive is a floppy drive.

12
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To begin the backup, click the Backup button.

 Notes

· It is suggested that you backup the entire 2012 database regularly.
· In order to backup a specific return for a specific client, use the Backup selection from the File menu of the

return to be backed up.
· If the Remind Me to Backup on Exit preference is set (see Desktop Preferences), you will be reminded to

backup your current year's database prior to exiting Account Ability provided that (a) no other users are
logged on to Account Ability and (b) a successful backup was not completed during the current session.

· The Backup/Restore Utility will not be available while other users are logged on to Account Ability.

11.2 Restore Utility

 Module Menu  Backup/Restore

Use the Restore Utility to restore archives created by the Backup Utility.

To display the Restore Utility,

· Close all open tax forms.
· Select Backup/Restore from the Module menu.

Click on the Restore page.

· Select the source drive and folder containing the archive to be restored.
· Select the archive to be restored from the list of Available archives.
· Click on the Verify button in order to verify the archive.
· If successful, specify the Destination drive to be used.
· Click the Restore button.

If successful, the archive is restored to its original folder on the destination drive you specified.

 Notes

· To delete an archive from the list of Available archives, click once on the archive and depress the Delete
key.

· The Backup/Restore Utility will not be available while other users are logged into Account Ability.

12 IRS FIRE and SSA BSO

12.1 The IRS FIRE System

What is The IRS FIRE System?
The IRS FIRE System ("FIRE") is dedicated exclusively to the filing of Forms 1042-S, 1097-BTC, 1098, 1099,
3921, 3922, 5498, 8027, 8935 and W2G. All electronic filing of Information Returns are received at IRS/IRB
via FIRE (Filing Information Returns Electronically). FIRE is designed to support the electronic filing of
Information Returns only.

 Notes

· Account Ability Tax Form Preparation Software does not include Forms 1042-S, 8027, or 8935.
· IDMS is currently working on a 1042-S addition to the Account Ability product line.
· The future of Form 8027 is under consideration by IDMS
· The future of Form 8935 is under consideration by IDMS

Electronic Filing Approval Procedure
Filers must obtain, or already have, a Transmitter Control Code (TCC) assigned prior to submitting their files
electronically. In order to obtain a TCC you must file Form 4419 (you can print Form 4419 from the Help
menu). Once a TCC is obtained, electronic filers assign their own passwords and do not need prior or special
approval.
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The TCC you receive from the IRS must be recorded in the Transmitter Record of each IRSTAX file
submitted to IRS. Once you receive your TCC, enter it on the Transmitter  page of the
Transmitter/Submitter Information dialog found on the Module menu. Account Ability automatically
includes your TCC when creating the IRSTAX file. The TCC you receive can be used indefinitely.

Who can use The IRS FIRE System?
Anyone with access to the Internet can use IRS FIRE, however, a one-time registration process is required.

Is there a charge to use The IRS FIRE System?
No, except for charges from your Internet service provider.

Submitting Test Files
· Filers are not required to submit a test file; however, the submission of a test file is encouraged for all new

electronic filers to test hardware and software connectivity. If filers wish to submit an electronic test file for
Tax Year 2012 (returns to be filed in 2013), it must be submitted to IRS/IRB no earlier than November 1,
2012, and no later than February 15, 2013.

· If a filer encounters problems while transmitting the electronic test file, contact IRS/IRB for assistance.
· Filers can verify the status of their transmitted test data within 1-2 workdays after their transmission is

received by IRS/IRB.
· A test file is required from filers who want approval for the Combined Federal/State Filing Program.

 Note

· Testing for tax year 2012 begins on November 1, 2012 and concludes on February 15, 2013.

Electronic Submissions Guidelines
· Electronically filed information may be submitted to IRS/IRB 24 hours a day, 7 days a week.
· If a file was submitted timely and is BAD, the filer will have up to 60 days from the day the file was

transmitted or 4 replacement attempts within that 60 day period, whichever comes first, to transmit an
acceptable file. If an acceptable file is not received within 60 days or within 4 replacement attempts, then
the payer could be subject to late filing penalties. This only applies to files originally sent electronically.

· Filers are advised not to resubmit an entire file if records were omitted from the original transmission. This
will result in duplicate filing. A new file should be sent consisting of the records that had not previously been
submitted.

Data Compression Guidelines
· Data compression is encouraged when submitting Information Returns electronically.
· Acceptable compression packages include WinZip and PKZip.
· UNIX COMPRESS may be acceptable; however, a test file is recommended to verify compatibility.
· IRS/IRB cannot accept self-extracting zip files or compressed files containing multiple files.

IRS File Naming Conventions
· Files submitted electronically can be named anything the end user desires since each file received

electronically is assigned a unique filename by FIRE.
· The filename assigned by FIRE consists of a submission type [TEST, ORIG (original), CORR (correction),

and REPL (replacement)], the filer's TCC and a four digit sequence number. FIRE increments the sequence
number with each file submission type received electronically (e.g. ORIG.TCCNO.0001, CORR.TCCNO.0001,
REPL.TCCNO.0001, REPL.TCCNO.0002).

Accessing The FIRE System (http://fire.irs.gov)
Select IRS FIRE System from the Module menu. First time users will be required create an account, set up a
user id, password, and PIN. These instructions are clearly stated on the FIRE System's web page.

IRS FIRE Technical Assistance
· Toll-free at 866-455-7438 or outside the U.S. at 304-263-8700, Mon-Fri, 8:30 AM to 4:30 PM EST.
· Telecommunication Device for the Deaf (TDD) at 304-267-3367
· Via email at mccirp@irs.gov
· Via fax toll-free at 877-477-0572 or outside the U.S. at 304-264-5602.

25

http://www.winzip.com/
http://fire.irs.gov
mailto:mccirp@irs.gov


IRS FIRE and SSA BSO 95

© 2012 IDMS, All rights reserved.

12.2 SSA Business Services Online (BSO)

What is SSA Business Services Online (SSA BSO)?
SSA BSO is a suite of business services that allows employers to conduct business with the Social Security
Administration (SSA). Electronic file upload, a feature of the BSO, allows you to transmit EFW2 and EFW2C
compliant files of Annual Wage Reports to SSA over the Internet.

Who can use SSA BSO?
Anyone with access to the Internet can use SSA BSO, however, a one-time registration process is required. 

Is there a charge to use SSA BSO?
No, except for charges from your Internet service provider.

Do you have to register to use SSA BSO?
Yes. In order to use SSA BSO you must obtain a User Identification Number and password from SSA. You
can obtain a User Id by selecting the Registration link found on the SSA BSO website. For questions relating
to BSO registration, call 1-800-772-6270, Monday-Friday, 7:00 AM to 7:00 PM EST.

How do you use your User Id? 
The User Id you receive from the SSA must be recorded in the Submitter Record of each W2REPORT file
submitted to SSA. Once you receive your User Id, enter it on the Submitter  page of the
Transmitter/Submitter Information dialog found on the Module menu. Account Ability automatically
includes your User Id when creating the W2REPORT file.

Accessing SSA BSO
Once you have received your User Id and password you are ready to access SSA BSO. Select SSA Business
Services Online from the Module menu in order to visit the BSO website.

Electronic Submissions Guidelines
· Electronically files may be submitted all year.
· Initial files received after March 31, 2013 are considered "late" by SSA.

Data Compression Guidelines
· Data compression is encouraged when submitting Annual Wage Reports electronically.
· Acceptable compression packages include WinZip and PKZip.
· Do not compress more than one data file together.

BSO Technical Assistance
Technical assistance can be reached at 888-772-2970, Monday through Friday, between 8:30 AM and 4:00 PM
EST.

13 Technical Support

Integrated Data Management Systems, Inc. (IDMS)
560 Broadhollow Road
Suite 109
Melville, NY  11747
631-249-7744
 
Toll Free Support
Monday-Friday, 9:30 AM-6:30 PM EST

· 800-582-5831
· 888-IDMSINC (888-436-7462)
 
E-Mail Support (support@idmsinc.com)

· Use the E-Mail Technical Support selection on the Help menu.
 
IDMS Website

27

http://www.winzip.com/


Tax Form Preparation for 201296

© 2012 IDMS, All rights reserved.

· Home Page: www.idmsinc.com
· Support: www.idmsinc.com/Support.php
· FAQ: www.idmsinc.com/ListFaqs.php
· Tips: www.idmsinc.com/ListTips.php
· Forms Division: www.accountabilitytaxforms.com

 Notes

· Free unlimited technical support is available to all licensed users of Account Ability. You will be required to
supply your Account Ability serial number, which can be found using the selection About Account Ability
on the Help menu.

· IDMS also includes free remote Help Desk Support. This level of support enables an Account Ability
support technician to connect directly to your computer via a secure socket layer (SSL) internet connection.
As you will be able to work interactively with the technician, this is clearly the most effective means of
technical support.

14 Appendix A - File Schema

14.1 Client Master File

 Client Master File Schema
Sample File = Schema\2012\Clients.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 

"Client ID"
"Name line 1"
"Name line 2"
"Street address 1"
"Street address 2"
"City"
"State"
"Zip code"
"Corporate name line 1" ¹
"Corporate name line 2"
"Corporate street address 1"
"Corporate street address 2"
"Corporate city"
"Corporate state"
"Corporate Zip code"
"Report to IRS indicator" ² ³
"Combined Federal/State indicator" ³
"Final return indicator" ³
"Name control"
"TIN Type"
"Taxpayer ID"
"Employer Type"
"Kind of Employer"
"Routing & Transit number"
"Telephone number (XXX-XXX-XXXX)"
"Main contact"
"Fax number (XXX-XXX-XXXX)"
"E-mail address"
"Establishment number"
"Other EIN used this year"
"State #1 (eg. NY, NJ, ..., or null)"
"State #1 identification number"
"State #2 (eg. NY, NJ, ..., or null)"
"State #2 identification number"
"State #3 (eg. NY, NJ, ..., or null)"
"State #3 identification number"
...
...

http://www.idmsinc.com
http://www.idmsinc.com/Support.php
http://www.idmsinc.com/ListFaqs.php
http://www.idmsinc.com/ListTips.php
http://www.accountabilitytaxforms.com
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...
"State #49 (eg. NY, NJ, ..., or null)"
"State #49 identification number"
"State #50 (eg. NY, NJ, ..., or null)"
"State #50 identification number"

CRLF

¹ This is the entity that owns the taxpayer identification number.
² Indicates whether or not to transmit Corporate information to the IRS.
³ "X" if applicable, otherwise, enter a null string ""

14.2 1098 Import File Schema

 1098 File Schema
Sample File = Schema\2012\T98.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"Apartment number" (4 character maximum)
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"Occupancy date (from)" ²
"Occupancy date (to)" ²
Payer shares ²
Payer percentage of maintenance paid ²
"Description line 1"
"Description line 2"
"Description line 3"
"Description line 4"
Mortgage interest received from payer
Points paid on purchase of principal residence
Refund of overpaid interest
Real estate taxes
Amortization
Capital reserve fund
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
 
¹ "X" if applicable, otherwise, enter a null string ""
² Applies only to cooperatives.
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.3 1098-C Import File Schema

 1098-C File Schema
Sample File = Schema\2012\T98C.txt

String fields are displayed within quotations



Tax Form Preparation for 201298

© 2012 IDMS, All rights reserved.

CRLF=Carriage Return Line Feed (Hex 0D0A) 

"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Date of contribution" ²
"Year"
"Make"
"Model"
"Vehicle or other identification number"
"Box 4a - Transaction indicator" ¹
"Box 4b - Date of sale" ²
Box 4c - Gross proceeds from sale
"Box 5a - Transfer after improvements indicator" ¹
"Box 5b - Transfer below FMV indicator" ¹
"Box 5c - Description of improvements"
"Box 6a - Goods or services indicator" ¹
Box 6b - Value of goods and services
"Box 6c - Intangible religious benefits indicator" ¹
"Box 6c - Description of goods and services"
"Box 7 - Deduction $500 or less indicator" ¹
"Do not print indicator" ¹
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.4 1098-E Import File Schema

 1098-E File Schema
Sample File = Schema\2012\T98E.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 

"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
Student loan interest received by lender
"Box 2 (loan origination fees indicator)" ¹
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
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¹ "X" if applicable, otherwise, enter a null string ""

14.5 1098-T Import File Schema

 1098-T File Schema
Sample File = Schema\2012\T98T.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Service Provider/Account Number"
Box 1 - Payments received ²
Box 2 - Amounts billed ²
"Box 3 - Reporting method indicator" ¹
Box 4 - Prior year adjustments ³
Box 5 - Scholarships or grants
Box 6 - Adjustments to scholarships or grants ³
"Box 7 - Academic period indicator" ¹
"Box 8 - Half-time student indicator" ¹
"Box 9 - Graduate student indicator" ¹
Box 10 - Insurance contracts reimbursements/refunds
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Report either box 1 or box 2, but not both.
³ Adjustments are assumed to be negative.

14.6 1099-A Import File Schema

 1099-A File Schema
Sample File = Schema\2012\T99A.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
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"Name control"
"Account number"
"Date of lender's acquisition or knowledge of abandonment" ²
"Personal liability indicator" ¹
"Description of property line 1"
"Description of property line 2"
Balance of principal outstanding
FMV of property
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
 
¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.7 1099-B Import File Schema

 1099-B File Schema
Sample File = Schema\2012\T99B.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"2nd TIN Notice indicator" ¹
"CUSIP number"
"Date of sale" (if applicable, otherwise, enter a null string "") ³ 
"Date of acquisition" (if applicable, otherwise, enter a null string "") ³ 
"Short-term gain or loss indicator" ¹
"Long-term gain or loss indicator" ¹
"Stock or other symbol"
Quantity sold (no decimals)
Stocks, bonds, etc.
"Gross proceeds indicator" ¹
"Gross proceeds less commissions indicator" ¹
"Loss not allowed indicator" ¹
Cost or other basis
Federal income tax withheld
Wash sale loss disallowed
"Noncovered security - Basis not reported to IRS indicator" ¹
"Noncovered security - Basis reported to IRS indicator" ¹
Bartering
"Description"
Profit or loss realized in 2012 ²
Unrealized profit or loss on open contracts - 12/31/2011 ²
Unrealized profit or loss on open contracts - 12/31/2012 ²
Aggregate profit or loss ²
"Reporting state"
State tax withheld
"Do not print indicator" ¹
"E-Mail address"
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 "Client ID"
CRLF
 
¹ "X" if applicable, otherwise, enter a null string "" 
² Losses must be entered as negative numbers, e.g., -123456.78
³ Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.8 1099-C Import File Schema

 1099-C File Schema
Sample File = Schema\2012\T99C.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"Date of identifiable event" ²
Amount of debt discharged
Interest
"Description of debt line 1"
"Description of debt line 2"
"Description of debt line 3"
"Personally liable indicator" ¹
"Identifiable event code"
FMV of property
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.9 1099-CAP Import File Schema

 1099-CAP File Schema
Sample File = Schema\2012\T99CAP.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
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"Taxpayer ID" 
"Name control"
"Account number"
"Date of sale or exchange" ²
Aggregate amount received
Number of shares exchanged
"Classes of stock exchanged"
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.10 1099-DIV Import File Schema

 1099-DIV File Schema
Sample File = Schema\2012\T99DIV.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"CFSP Reporting State" 
"2nd TIN Notice indicator" ¹
Total ordinary dividends
Qualified dividends
Total capital gain distributions
Unrecaptured Section 1250 gain
Section 1202 gain
Collectibles (28%) gain
Nondividend distributions
Federal income tax withheld
Investment expenses
Foreign tax paid
"Foreign country or U.S. possession"
Cash liquidation distributions
Noncash liquidation distributions
Exempt-interest dividends
Specified private activity bond interest dividends
"Reporting state"
State tax withheld
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
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14.11 1099-G Import File Schema

 1099-G File Schema
Sample File = Schema\2012\T99G.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
"CFSP Reporting State" 
Unemployment compensation
State or local income tax refunds, credits, or offsets
Tax year for which refund, credit, or offset was issued ²
Federal income tax withheld
ATAA/RTAA payments
Taxable grants
Agriculture payments
"Trade or business income indicator" ³
Market gain
"Reporting state" (eg. NY, NJ, ..., or null)
State income tax withheld
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string "" 
² Enter the tax year as a 4-digit year. The tax year must reflect the year that the payment was made, not the
tax year of the Form 1099-G.
³ If the state or local income tax refund, credit, or offset is attributable to income tax that applies exclusively
to income from a trade or business, enter an "X" here. Otherwise, for general tax refunds, leave this field
blank ("")

14.12 1099-H Import File Schema

 1099-H File Schema
Sample File = Schema\2012\T99H.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
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"Taxpayer ID"
"Name control"
Amount of HCTC advance payments
No. of months for which HCTC payments received ²
January payments
February payments
March payments
April payments
May payments
June payments
July payments
August payments
September payments
October payments
November payments
December payments
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string "" 
² Enter as a 1-digit or 2-digit number (not to exceed 12)

14.13 1099-INT Import File Schema

 1099-INT File Schema
Sample File = Schema\2012\T99INT.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 

"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"CFSP Reporting State" 
"2nd TIN Notice indicator" ¹
Interest income
Early withdrawal penalty
Interest on US Savings Bonds and Treasury obligations
Federal income tax withheld
Investment expenses
Foreign tax paid
"Foreign country or U.S. possession"
Tax-exempt interest
Specified private activity bond interest
"Tax-exempt bond CUSIP number"
"Reporting state"
State tax withheld
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
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¹ "X" if applicable, otherwise, enter a null string "" 

14.14 1099-K Import File Schema

 1099-K File Schema
Sample File = Schema\2012\T99K.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 

"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"CFSP Reporting State" 
"Payment settlement entity (PSE) name" ²
"Payment settlement entity (PSE) phone (XXX-XXX-XXXX)" ²
Merchant category code
Number of purchase transactions
"Payment card transactions indicator" ¹
"Third party network transactions indicator" ¹
Gross amount of payments
January payments
February payments
March payments
April payments
May payments
June payments
July payments
August payments
September payments
October payments
November payments
December payments
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² If the filer is a payment settlement entity, enter a null string ""

14.15 1099-LTC Import File Schema

 1099-LTC File Schema
Sample File = Schema\2012\T99LTC.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Policyholder's name line 1"
"Policyholder's name line 2"
"Policyholder's street address line 1"
"Policyholder's street address line 2"

http://www.irs.gov/irb/2004-31_IRB/ar17.html
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"Policyholder's city"
"Policyholder's state"
"Policyholder's Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Policyholder's foreign city, province, postal code, etc."
"Policyholder's TIN Type"
"Policyholder's taxpayer ID"
"Policyholder's name control"
"Account number"
Gross long-term care benefits paid
Accelerated death benefits paid
Type of payment (1 = Per diem, 2 = Reimbursed)
"Qualified contract indicator" ¹
"Insured's social security number" (9 digits, no dashes)
"Insured's name line 1"
"Insured's name line 2"
"Insured's street address line 1"
"Insured's street address line 2"
"Insured's city"
"Insured's state"
"Insured's Zip code"
"Insured's foreign city, province, postal code, etc." ²
Status of illness (1 = Chronically ill, 2 = Terminally ill)
"Date certified" ³
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
 
¹ "X" if applicable, otherwise, enter a null string "" 
² Requires the foreign address indicator to be set to "X" above.
³ Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.16 1099-MISC Import File Schema

 1099-MISC File Schema
Sample File = Schema\2012\T99MISC.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 

"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹ 
"Foreign city, province, postal code, etc."
"TIN Type "
"Taxpayer ID" 
"Name control"
"Account number"
"CFSP Reporting State" 
"Direct sales indicator" ¹
"2nd TIN Notice indicator" ¹
Rents
Royalties
Other income
Federal income tax withheld
Fishing boat proceeds
Medical and health care
Nonemployee compensation
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Substitute payments
Crop insurance proceeds
Excessive golden parachute payments
Gross proceeds paid to an attorney
Section 409A deferrals
Section 409A income
"State #1" (eg. NY, NJ, ..., or null)
State #1 income
State #1 income tax withheld
"State #2" (eg. NY, NJ, ..., or null)
State #2 income
State #2 income tax withheld
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""

14.17 1099-OID Import File Schema

 1099-OID File Schema
Sample File = Schema\2012\T99OID.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"CFSP Reporting State" 
"Description line 1" ² 
"Description line 2" ²
"2nd TIN Notice indicator" ("X" if applicable, otherwise, enter "")
Original issue discount for 2012
Other periodic interest
Early withdrawal penalty
Federal income tax withheld
Original issue discount on U.S. Treasury obligations
Investment expenses
"Reporting state" (eg. NY, NJ, ..., or null)
State income tax withheld
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² CUSIP, issuer, coupon rate, year of maturity, etc.

14.18 1099-PATR Import File Schema

 1099-PATR File Schema
Sample File = Schema\2012\T99PATR.txt
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String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
"CFSP Reporting State" 
"2nd TIN Notice indicator" ¹
Patronage dividends
Nonpatronage distributions
Per-unit retain allocations
Federal income tax withheld
Redemption of nonqualified notices and retain allocations
Domestic production activities deduction
Investment credit
Work opportunity credit
Patron's AMT adjustment
Box 10 amount
"Box 10 type"
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""

14.19 1099-Q Import File Schema

 1099-Q File Schema
Sample File = Schema\2012\T99Q.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
Box 1 - Gross distribution
Box 2 - Earnings
Box 3 - Basis
"Box 4 - Trustee-to-trustee transfer indicator" ¹
"Box 5 - Private indicator" ¹
"Box 5 - State indicator" ¹
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"Box 5 - Coverdell ESA indicator" ¹
"Box 6 - Recipient is NOT the designated beneficiary indicator" ¹
FMV of the Coverdell ESA as of 12/31/2012
Distribution code
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string "" 

14.20 1099-R Import File Schema

 1099-R File Schema
Sample File = Schema\2012\T99R.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
"CFSP Reporting State" 
"IRA/SEP/SIMPLE indicator" ¹
"Distribution code(s)"
"Taxable amount not determined" ¹
"Total distribution indicator" ¹
Gross distribution
Taxable amount
Capital gain included in the taxable amount above
Federal income tax withheld
Employee contributions or insurance premiums
Net unrealized appreciation in employer's securities
Other amount
Other % ²
Your percentage of total distribution ²
Total employee contributions
Amount allocable to IRR within 5 years
"First year of designated Roth contribution" ³
"State #1"
State #1 tax withheld
State #1 distribution
Locality #1 tax withheld
Locality #1 distribution
"Name of Locality #1"
"State #2"
State #2 tax withheld
State #2 distribution
Locality #2 tax withheld
Locality #2 distribution
"Name of Locality #2"
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
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CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Enter as a whole number between 0 and 100
³ Enter as a 4-digit year or leave null ""

14.21 1099-S Import File Schema

 1099-S File Schema
Sample File = Schema\2012\T99S.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
"Closing date" ²
"Property or services indicator" ¹
"Description of property line 1"
"Description of property line 2"
"Description of property line 3"
"Description of property line 4"
Gross proceeds
Buyer's part of real estate tax
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
 
¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.22 1099-SA Import File Schema

 1099-SA File Schema
Sample File = Schema\2012\T99SA.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
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"Name control"
"Account number"
Gross distribution
Earnings on excess contributions
Distribution code
FMV on date of death
"HSA indicator" ¹
"Archer MSA indicator" ¹
"MA MSA indicator" ¹
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""

14.23 3921 Import File Schema

 3921 File Schema
Sample File = Schema\2012\T3921.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"Date option granted" ²
"Date option exercised" ²
Exercise price per share
FMV per share on exercise date
Number of shares transferred
"Other information line 1"
"Other information line 2"
"Other information line 3"
"Other information line 4"
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
 
¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.24 3922 Import File Schema

 3922 File Schema
Sample File = Schema\2012\T3922.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
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"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID" 
"Name control"
"Account number"
"Date option granted" ²
"Date option exercised" ²
FMV per share on grant date
FMV per share on exercise date
Exercise price per share
Number of shares transferred
"Date legal title transferred" ²
Exercise price per share determined
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF
 
¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.25 5498 Import File Schema

 5498 File Schema
Sample File = Schema\2012\T5498.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
"CFSP Reporting State" 
Box 1 - IRA contributions
Box 2 - Rollover contributions
Box 3 - Roth IRA conversion amount
Box 4 - Recharacterized contributions
Box 5 - FMV of account
Box 6 - Life insurance cost included in box 1
"IRA Indicator" ¹
"SEP Indicator" ¹
"SIMPLE Indicator" ¹
"Roth IRA Indicator" ¹
Box 8 - SEP contributions
Box 9 - SIMPLE contributions
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Box 10 - Roth IRA contributions
"Box 11 - RMD Indicator for 2013" ¹
"Box 12a - RMD date" ²
Box 12b - RMD amount
Box 13a - Postponed contribution
"Box 13b - Year"
"Box 13c - Code"
Box 14a - Repayments
"Box 14b - Code"
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).

14.26 5498-ESA Import File Schema

 5498-ESA File Schema
Sample File = Schema\2012\T5498ESA.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
Box 1 - Coverdell ESA contributions
Box 2 - Rollover contributions
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

14.27 5498-SA Import File Schema

 5498-SA File Schema
Sample File = Schema\2012\T5498SA.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"USPS Delivery Point"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
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"TIN Type"
"Taxpayer ID"
"Name control"
"Account number"
Box 1 - Employee or self-employed person's Archer MSA contributions
Box 2 - Total contributions made in 2012
Box 3 - Total HSA or Archer MSA contributions made in 2013 for 2012
Box 4 - Rollover contributions
Box 5 - FMV of HSA, Archer MSA, or MA MSA
"Health Savings Account (HSA) indicator" ¹
"Archer MSA indicator" ¹
"Medicare Advantage (MA) MSA indicator" ¹
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""

14.28 W-2 Import File Schema

 W-2 File Schema
Sample File = Schema\2012\W2.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"File number"
"First name"
"Middle initial"
"Last name"
"Suffix"
"Full name"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"Zip code extension"
"USPS Delivery Point"
"Foreign address indicator" ¹ 
"Foreign state or province"
"Foreign postal code"
"Foreign country code (2 characters)"
"Applied For SSN indicator" ¹ 
"Social security number (enter as 9 digits)"
Wages, tips, other compensation
Federal income tax withheld
Social security wages
Social security tax withheld
Medicare wages and tips
Medicare tax withheld
Social security tips
Allocated tips
Dependent care benefits
Nonqualified plans
"Box 12a code"
Box 12a amount 
"Box 12b code"
Box 12b amount 
"Box 12c code"
Box 12c amount 
"Box 12d code"
Box 12d amount 
"Statutory employee indicator" ¹ 
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"Retirement plan indicator" ¹
"Third-party sick pay indicator" ¹
"Box 14 (Other) line 1"
"Box 14 (Other) line 2"
"Box 14 (Other) line 3"
"State 1" ²
State 1 wages
State 1 tax withheld
Locality 1 wages
Locality 1 tax withheld
"Name of Locality 1"
"Local 1 Type"
"State 2" ²
State 2 wages
State 2 tax withheld
Locality 2 wages
Locality 2 tax withheld
"Name of Locality 2"
"Local 2 Type"
"Do not print indicator" ¹
"E-Mail address"
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Two character FIPS code, e.g. NY, NJ, ..., or a null string ""

14.29 W-2C Import File Schema

 W-2C File Schema
Sample File = Schema\2012\W2C.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 

Year corrected (enter as a 4 digit year, e.g., 2012)
"First name"
"First name (previously reported)"
"Middle initial"
"Middle initial (previously reported)"
"Last name"
"Last name (previously reported)"
"Suffix"
"Street address line 1"
"Street address line 2"
"City"
"State"
"Zip code"
"Zip code extension"
"Foreign address indicator" ¹ 
"Foreign state or province"
"Foreign postal code"
"Country code (2 characters)"
"Correct SSN" (enter as 9 consecutive digits)
"Incorrect SSN" (if applicable, otherwise, enter "")
"Previously reported statutory employee indicator" ¹
"Previously reported retirement plan indicator" ¹
"Previously reported third-party sick pay indicator" ¹
Previously reported wages, tips, other compensation
Previously reported federal income tax withheld
Previously reported social security wages
Previously reported social security tax withheld
Previously reported Medicare wages and tips
Previously reported Medicare tax withheld
Previously reported social security tips
Previously reported allocated tips
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Previously reported advanced EIC payments
Previously reported dependent care benefits
Previously reported nonqualified plans
"Previously reported Box 12a code"
Previously reported Box 12a amount
"Previously reported Box 12b code"
Previously reported Box 12b amount
"Previously reported Box 12c code"
Previously reported Box 12c amount
"Previously reported Box 12d code"
Previously reported Box 12d amount
"Previously reported Box 14 (Other) line #1"
"Previously reported Box 14 (Other) line #2"
"Previously reported Box 14 (Other) line #3"
"Previously reported State #1 (NY, NJ,...)"
"Previously reported State #1 ID number"
Previously reported State #1 wages, tips, etc.
Previously reported State #1 income tax
"Previously reported Local #1 name"
Previously reported Local #1 wages, tips, etc.
Previously reported Local #1 income tax
"Previously reported State #2 (NY, NJ,...)"
"Previously reported State #2 ID number"
Previously reported State #2 wages, tips, etc.
Previously reported State #2 income tax
"Previously reported Local #2 name"
Previously reported Local #2 wages, tips, etc.
Previously reported Local #2 income tax
"Corrected reported statutory employee indicator" ¹
"Corrected reported retirement plan indicator" ¹
"Corrected reported third-party sick pay indicator" ¹
Corrected reported wages, tips, other compensation
Corrected reported federal income tax withheld
Corrected reported social security wages
Corrected reported social security tax withheld
Corrected reported Medicare wages and tips
Corrected reported Medicare tax withheld
Corrected reported social security tips
Corrected reported allocated tips
Corrected reported advanced EIC payments
Corrected reported dependent care benefits
Corrected reported nonqualified plans
"Corrected reported Box 12a code"
Corrected reported Box 12a amount
"Corrected reported Box 12b code"
Corrected reported Box 12b amount
"Corrected reported Box 12c code"
Corrected reported Box 12c amount
"Corrected reported Box 12d code"
Corrected reported Box 12d amount
"Corrected reported Box 14 (Other) line #1"
"Corrected reported Box 14 (Other) line #2"
"Corrected reported Box 14 (Other) line #3"
"Corrected reported State #1 (NY, NJ,...)"
"Corrected reported State #1 ID number"
Corrected reported State #1 wages, tips, etc.
Corrected reported State #1 income tax
"Corrected reported Local #1 name"
Corrected reported Local #1 wages, tips, etc.
Corrected reported Local #1 income tax
"Corrected reported State #2 (NY, NJ,...)"
"Corrected reported State #2 ID number"
Corrected reported State #2 wages, tips, etc.
Corrected reported State #2 income tax
"Corrected reported Local #2 name"
Corrected reported Local #2 wages, tips, etc.
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Corrected reported Local #2 income tax
CRLF

¹ "X" if applicable, otherwise, enter a null string ""

14.30 W-2G Import File Schema

 W-2G File Schema
Sample File = Schema\2012\W2G.txt

String fields are displayed within quotations
CRLF=Carriage Return Line Feed (Hex 0D0A) 
 
"Name line 1"
"Name line 2"
"Street address"
"City"
"State"
"Zip code"
"Foreign address indicator" ¹
"Foreign city, province, postal code, etc."
"TIN Type"
"Taxpayer ID"
"Name control"
"Transaction Number"
Gross winnings
Federal income tax withheld
"Type of wager code"
Amount of wager
"Date won" ²
"Race"
Winnings from identical wagers
"Cashier"
"Window"
"First ID"
"Second ID"
"Reporting state (eg. NY, NJ, ...)"
State income tax withheld
"Do not print indicator" ¹
"Client ID"
CRLF

¹ "X" if applicable, otherwise, enter a null string ""
² Use format MMDDYYYY or MMDDYY (21st century is assumed).
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